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CHAPTER 1

First Seps After Upgrading to Panel 1

This chapter is intended for hosting service customers who previously used Parallels
Plesk Panel version 9 and earlier. It describes the most important changes in the Panel
and addresses possible issues that the users might encounter after their accounts and
sites are moved to Parallels Plesk Panel 11 during the Panel upgrade.

The most important concepts you should know

A Domain is replaced by subscription.

The concept of a domain has been replaced with a concept of a subscription - a
hosting unit able to run multiple sites (domains and subdomains) over given
resources and services. Multi-domain hosting within one subscription is limited to
one IP address. Customers who need to host sites on different IP addresses are
advised to obtain additional subscriptions.

A Resources of a client are now resources of a subscription.

Customers no longer need to redistribute their resources across domains or
subscription: Each subscription is allocated a fixed set of resources according to a
hosting plan.

A SSL certificates are typically shared among all domains of a subscription.

All sites in a subscription typically share the same SSL certificate. Customers who
want to protect all sites in a subscription should consider purchasing a multi-domain
(a wildcard) SSL certificate. It is also possible to have per-domain certificates in
case Panel supports SNI.

Peculiarities of SiteBuilder upgrade

A Panel 11 ships with Presence Builder (former SiteBuilder), but you can use
SiteBuilder 4.5 as well.

Parallels Presence Builder is a Panel component that allows fast and efficient
creation of websites. When Plesk with SiteBuilder is upgraded to Parallels Plesk
Panel 11, the SiteBuilder component is not actually upgraded. Instead, the new
Presence Builder is installed on the server, and SiteBuilder 4.5 remains operable;
however, operations on websites created in SiteBuilder 4.5 are limited to editing
and publishing.

A Transfer of websites from SiteBuilder 4.5 to Presence Builder is supported, with
limitations.

Presence Builder allows websites created in SiteBuilder 4.5 to be imported.
However, this feature has certain limitations: some elements may be missing or
corrupted in the imported website. We advise you to compare it with the original
version and add the missing content manually.

See the section Importing Sites from SiteBuilder @b page 158) for more details on
importing SiteBuilder 4.5 sites to Presence Builder.
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Changes in storing secure content

A httpdocs is the only allowed directory for storing web content accessed over secure
SSL.

The option to use a separate directory for storing web content that should be
accessed over secure SSL connections is no longer available. All web content is
now stored in a single directory - httpdocs

The httpsdocs  directory may remain in the webspace after upgrading to Parallels
Plesk Panel 11, however, we recommend that you place all content in the
httpdocs  directory when uploading files to the webspace over FTP.

If you used the option to keep SSL-protected and all other content in separate
directories, and had APS-packaged applications installed in the httpsdocs
directory of a website, then after upgrade, the Panel will switch on the compatibility
mode for that site. This will make the apps previously installed into httpsdocs
directory accessible to the Internet users, but the apps will not be manageable
through the Panel, and you will not be able to install new apps to the httpsdocs
directory.

In such a case, if you have the necessary technical skills, you can do the following:

1. Back up all content from the httpsdocs  directory and save it to another
location. Do not move the files to httpdocs  yet.

2. Back up databases used by applications installed in httpsdocs  directory. You
can do this with the help of the mysqgldump utility.

3. Remove applications from the httpsdocs  directory.

4. Switch off the compatibility mode through the Panel (at Websites & Domainab >
domain nanje

5. Reinstall the required applications.
6. Upload the data you backed up on the step 1 to the ht tpdocs directory.

7. Restore the applications' databases by importing them to the MySQL database
server.

If you are an inexperienced user, we recommend that you leave the previously
installed applications and uploaded content in the httpsdocs  directory, and host
new applications on other websites. If you need to install apps on the site operating
in compatibility mode, you can install them to the httpdocs  (http://) location on
that site.
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CHAPTER 2

Quick Start with Paralldtanel

According to the latest studies, the Internet has become the most popular source of
information in the world, leaving far behind all traditional media such as TV or newspapers.
Nowadays, the first thing people do when trying to find services is to searching for them on
the web. Thus, a proper web presence is vital for every business. There are a number of
ways you can present your company on the Web. A web presence may be as simple as a
contacts page, or as complex as a large company website with access to an ERP system. In
both cases, you should perform the same steps to get your business online.

Before proceeding any further, you will need to take the following two essential steps:

A Purchase a customer account from a hosting provider.
Your customer account provides access to the services that are vital for a web presence -
Internet connectivity, disk space to store your website content, and so on. For more
information about customer accounts in Panel, refer to the chapter Customer Account
Administratia (on page 33).

A Register a domain name.
This is the name people will use to access your site from their browsers. For example,
www.example.com .

These two elements - an account for web hosting management and a domain name make up
your website.

In this chapter, we will explain how to create your first website, fill it with content, create
mailboxes for users of the site, and, finally, view the site visits statistics.

Advanced Hosting Features

Once you are comfortable with basic Panel capabilities, try out some advanced hosting
features: Expand website functionality by installing web applications (on page 103), secure
your sites with SSL certificates (on page 113), employ databases (on page 232), and much
more.

Note: Hosting providers can turn off some of the advanced features to make your Control
Panel look simple and user friendly. We have used the (Advancedprefix to designate the
sections about features that may be turned off. If you require one of the advanced options,
contact your hosting provider.

In this chapter:

Set Up Your FirSt WeEDSITE .......uii e 9
Set UpP Mail ACCOUNES .....cceieeeiiiie et e e e e e e eeaaaannas 13
ViIEeW Site VISIt STALISTICS ....uuiieeeeiieeiiiiie e 32
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Set Up Your First Website

Now that you have a customer account and a domain name, the first thing you will want to do
is create a website. The information about the possible ways to do it is provided in the
section 1. Create Your Sifen page 9)

When your site is ready, you may want to take a look at the result in your browser. Learn
how to do it in the section 2. Preview your Sifen page 12).

Next in this section:

I O ST (I o T U Y| (TP 9
P o NV T A o U Y (<Y 12

1. Create Your Site

There are three general ways to create a website:

A Employ a web design studio to create a site for you, and then you will just maintain its
content.

A Create a site by yourself using Presence Builder - the powerful tool that allows you to
create professional-looking websites in a few mouse clicks. Learn more in the section
Presence Buildépn page 10).

A Create your website in a third-party Content Management System - an editor that allows
you to easily create and edit website content such as pages, scripts, applications, and so
on. To learn more about creating sites in third-party content management systems, see
the section Content Management Systeg(ms page 10).

If you have purchased a ready-made site or created it by yourself, you should upload the site
content to your account to make the site visible on the web. There are two ways to upload
content:

A Using FTP. Learn more in the section Uploading Content Using FBiR page 12).

A Using an integrated File Manager. Learn more in the section Uploading ContemtithFile
Managefon page 12).

Next in this section:

PresenCe BUIAET ..o 10
Content Management SYSEEMIS ... ..oouuu i e e e 10
UpIoading CONENT ......oooiiiiiiiie e 11
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Presence Builder

Presence Builder is a tool that enables users with no knowledge of HTML markup or graphic
design skills to create professional-looking sites. This tool provides a simple visual editor and
a huge set of templates for different websites. The editor allows you to create web pages,
add content of different types (text, images, video, scripts), and edit website settings such as
website name, keywords, icons, and so on.

To create websites in Presence Builder, ensure that your hosting subscription includes this
option. If it does not, choose another way or upgrade your subscription.

To create a website with Presence Builder:
Go to the Websites & Domairtab and click your domain name.
Click the link Launch PresemcBuilder

Select a topic that best suits your website.

Aw NP oo

Edit the website:

a. Structure: add more pages, remove the predefined pages that you do
not need.

b. Content: change the predefined content to your own, add text,
images, videos, scripts, and other required elements.

c. Design: change the layout and color scheme.
5. Publish the website.

Find more information about creating websites with Presence Builder in the section Building
Websites with Presence Builder

Content Management Systems

Content Management Systems (or CMS) are applications that provide a graphical user
interface for adding and editing website content: pages, scripts, files, multimedia content, and
S0 on.

Before you can create a website in a third-party CMS, you should install the CMS on your
hosting account. Note that you can install the CMS only if your hosting subscription allows it.

U To create a website using a CMS:
1. Go to the Applicationgab.

2. Find the CMS you need in the list of available applications, and install it as
described in the section Usng Website Applications (on pdds.

3. Create your website in the CMS. For information about creating websites
with your CMS, refer to the relevant documentation.
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Uploading Content

If you already have a website created by yourself or a web design studio, just upload the
website files and folders to your provider's server. You can do this in one of the following
ways:

A Using FTP. This way is better when several people manage a website's content because
it does not require access to your customer account. You can just create FTP users for
them. Learn more about this method in the section Uploading Content Using Hbia page
12).

A Using Control Panel File Manager. This way is more convenient since it uses the Control
Panel GUI and provides a set of useful features, for example, a visual HTML editor and a
file permissions manager. Find more information on the features of File Manager in the
section Uploading Content with File Mandgarpage 12).

Next in this section:

Uploading Content USING FTP.......oouiii e 12
Uploading Content with File Manager ... 12
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Uploading Content Using FTP

0
1.

3.

To publish a website using FTP:

Connect to your webspace on the server with an FTP client program, using
your FTP account username and password.

You can change your username and password in the Panel at the Websites & Domaitnab
> Web Hosting Access

The FTP address should be ftp://your-domain-name.com, where your-domain-name.com
is your site's Internet address.

Enable the passive mode if you are behind a firewall.

Upload the files and directories of your site to the httpdocs directory. If you
use CGI scripts, place them in the cgi - bin directory.

Close your FTP session.

You can also set up additional FTP accounts if you need to collaborate on website content
with other users. For more information, see the section Adding FTP Accoun{en page 209).

Uploading Content wikk IManager

To upload a website from your computer to Panel server with File Manager, open the Files
tab of Control Panel and drag the website folder to the central area of this tab. You can also
upload your website as a compressed ZIP file and then extract the contents using the
archiver integrated in File Manager.

With File Manager, you can also do the following:

A
A
A
A

Edit HTML files in the visual editor.
Preview website pages.

Edit files in the text editor.

Manage the files' access permissions.

Learn more about uploading and editing website files and folders with File Manager in the
section Managing Website Contéon page 95).
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2. Preview Your Site

After you uploaded website files to the webspace, you can check how your site will look in a
web browser, even before the information about the new site has spread in the Domain
Name System.

U To preview a site:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscriptiormenu at the top of the screen.

2. Go the Websites & Domainab.

3. Click Previewbelow the domain name of the website that you want to preview.
You site will open in a new browser window.

Note: The contents of password-protected directories might be inaccessible in the Preview
mode.

Sometimes, you may need to show your site to someone when your domain name is not
registered yet. There are several ways to do it without giving a person access to your
customer account. Learn more in the section Previewing Websit¢en page 102).

Set Up Mail Accounts

Once your website is ready, you can start creating mail accounts. You can choose, for
example, to create mail accounts for all users within your organization. Note that the number
and size of mailboxes is limited by your hosting plan.

Next in this section:

1. Create Mail ACCOUNT .. ... ettt e e e e eaanas 14
2. ACCESS YOUI MAUIDOX ... e 15
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1. Crate Mail Account

U To create anmail address:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Click the Mailtab.
3. Click Create Enail Address

4. Type the left part of the e-mail address before the @ sign, and, if you have
several domain names on your account, select the domain name under
which the e-mail address will be created.

5. Leave the Mailboxcheckbox selected.

Clearing this checkbox makes sense only if you want to use this address as a malil
forwarder, which will forward all incoming mail to another address.

6. Specify the mailbox size or use the default size defined by the provider's
policy or your service plan.

7. Specify a password consisting of five or more Latin characters.
8. Click OK
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2. Access Your Mailbox

There are two ways to access a mailbox for sending and receiving e-mail messages:

A Set up and use an e-mail client program on your computer. Typically, in such programs
you should specify the following settings:

A

A
A

A

A

Usernameln this field, specify your full e-mail address. For example,
johndoe@example.com.

PasswordMost likely, the password to your e-mail account.

Mail server protocorl his property defines whether you want to keep copies of
messages on the server or not. To keep the copies on the server, select the IMAP
option. If you do not want to keep them on the server, select POP3Selecting IMAP will
also allow you to train the SpamAssassin spam filter on e-mail messages you receive,
if SpamAssassin is enabled on the server.

Incoming mail servéPOP3/IMAP). Type your domain name. For example,
example.com. The POP3 port is 110. The IMAP port is 143.

Outgoing mail servéBMTP). Type your domain name. For example, example.com.
The SMTP port is 25. This server requires authentication.

To get detailed instructions on configuring popular e-mail clients to work with your
mailbox, see subsections of this section.

A Use a web browser to connect to the webmail interface.

Note: If you cannot access your mailbox following the instructions in this section, this might
be caused by mail server settings. Contact your hosting provider to resolve the issue.

Next in this section:

Access from Webmall...........ooooiiiiii e, 15
Access from Microsoft Office OUHIOOK............oouviiiiiiiiiiiic e, 16
Access from Microsoft OUtIOOK EXPress .......coouviviiiiiiieiiceeieee e 20
Access from Mozilla Thunderbird ..o 24
Access from APPIE Mall ........ooooeiiiiiiii e 27

Access from Webmail

U To access your mailbox through webmail, do any of the following:

A

In a Web browser, visit the URL webmail.example.com |, where example.com is the
Internet address of your website. When prompted, specify your full e-mail address as the
username (for example, mail@example.com ), and specify the password that you use
for logging in to the Panel.

When logged in to the Panel, click the Mailtab, and in the list of e-mail addresses, click
an icon kw corresponding to the e-mail address you need.
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Access from Microsoft Office Outlook

To set up Microsoft Office Outlook 2010:
Open Microsoft Office Outlook.
Go to File > Info > Add Account

w N e

Select the checkbox Manually configure server settings or additional server. types
Click Next

T

Auto Account Setup
Connect to other server types,

() E-mail Account

faur Mame:

Example: Ellen Adams
E-reail Address

Example: eller (DeaThEs 0, Con
Password

Rebvype Password:

Tvpe the passward your Internet service provider has given you
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4. Select the Internet Emailoption and click Next

oo I =

Choose Service

[ Microsoft Exchange or compatible service

Connect and acoess e-mail messages, calendar, contacts, faxes and voice mail messages.
() Text Messaging (SM5)

Connect to a mobile messaging service,
() Dther

Connect to a server type shown below.,

Fax Mai Transport

| <ok || next> | [ conce
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5. Specify the following:

A

A
A

> > > >

A

Your hame.
Your e-mail address.

Account typelf you want to keep copies of messages on the server, select the IMAP
option. If you do not want to keep any messages on the server, select the POP3
option. Selecting IMAP will also allow you to train the SpamAssassin spam filter on e-
mail messages you receive, if SpamAssassin is enabled on the server.

Incoming mail server. Type your domain name. For example, example.com.
Qutgoing mail server (SMTPYype your domain name. For example, example.com.
User NameSpecify your full e-mail address. Example: johndoe@example.com.

PasswordMost likely, this password coincides with the password you use for logging
in to Panel.

Requie logon using Secure Password Authentication (§#Je this option cleared.

i I
Add New Account ﬁ

1

Internet E-mail Settings

User Information Test Account Settings

Your Name: Johr Doe After filing cut the information on this soreen, we
recommend you test your acoount by dicking the button

E-mail Address: mal@example.com below. (Requires netwark connection)

Server Information

Il . lIﬁt.ﬁ.ﬂtﬂLﬂtEetﬁngs... ]
fcoount Type: POP3 =
[ncoming mail server: ——— [#] Test Account Settings by dicking the Next button

Dutgoing mail server (SMTP): | axample. com
Legon Information

User Name: mail Rexample.com

Password: JEp—

|| Regure logon using Secure Password Authentication (SPA)

Each of these settings are required to get your e-mall account working.

Deliver new messages to:

@ New Outionk Data Fie
("} Existing Outiock Data Fle

[# Remember passwond

| More Settings ...

| <Back || Next> | | cancel
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6. Click More Settingsopen the Outgoing Serveiab and check My outgoing server
(SMTP) requires authentication

-
Internet E-mail Settings u
Outgoing Server | Connection | Advanced

[¥]#My outgeing server (SMTF) requires authentication;

(@ Use same settings as my incoming mail server

General

i) Log on using

Iser Mame:

Password;

Remember passward
Reguire Secure Password Authentication (SPA)

i) Log on to incoming mail server before sending mail

[ Ok ] [ Cancel

7. Click Next
8. Click Finish
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Access from Microsoft Outlook Express

The instructions provided in this section were verified against Microsoft Outlook Express 6.
They might not work with earlier or later versions of Microsoft Outlook Express.

To set up Microsoft Outlook Express:
Open Microsoft Outlook Express.
Go to Tools> Accounts

Click the Addbutton and select the Mailitem.

P woN P o

Enter your name as you want it to appear in any messages you send, and
click Next

Internet Connection Wizard ﬁl

Your Name

‘When you send e-mail. ywour name will appear in the From field of the outgoing message.
Type wour name as you would like itto appear.

Di=play name: John Dae

For example: John Smith

< Back et » Cancel
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5. Type your e-mail address, and click Next

Internet Connection Wizard

Internet E-mail Address

maili®example.com
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6. Specify the following settings:

A Protocol of your incoming mail server.

If you want to keep copies of messages on the server, select the IMAPoption. If you
do not want to keep any messages on the server, select the POP3option. Selecting
IMAP will also allow you to train the SpamAssassin spam filter on e-mail messages
you receive, if SpamAssassin is enabled on the server.

A Incoming mail server. Specify your website's Internet address.
A Outgoing mail server. Specify your website's Internet address.

Internet Connection Wizard ﬁl

E-mail Server Names

by incoming mail server is a IPOP3 ll SErEr.

Incaming mail (FOF3, IMAF ar HTTF) server:

example.com

An SMTF serveris the server that is used for your outgoing e-mail.

Qutgoing mail (SMMTF) server;

example.com

< Back et » Cancel
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7. Click Next
8. Specify the following:

A Your account name. Type your e-mail address in the Account naméox.

A Your password. Most likely, this password coincides with the password you use for
logging in to the Panel.

A Remember passwocdtheckbox. Leave it selected if you do not want to be prompted to
enter password each time your e-mail program connects to the mail server to check
for new mail, and click Next

Internet Connection Wizard ﬁl

Internet Mail Logon

Twpe the account name and password vour Interet service provider has given wou,

Account narme: Imail@example.cnm

Bassword: qunn

[v Remember password

[fwour Internet service provider requires you to use Secure Password Authentication (2FA] o
access your mail account, selectthe 'Log On Using Secure Fassword Authentication (SFA)
check box.

[~ Log an using Secure Password Authentication (SPA)

< Back et » Cancel

9. To complete setting up your e-mail program, click Finish
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Access from MozillBhunderbird

The instructions provided in this section were verified against Mozilla Thunderbird 12. They
might not work with earlier or later versions of Mozilla Thunderbird.

To set up Mozilla Thunderbird:
Open Mozilla Thunderbird.

Go to Tools> Account 8ttings> Account Actions Add Mail Account.

w N e

Specify the following:
A Your name, as you want it to appear in any messages you send.

A Your e-mail address and password.

r .
Mail Account Setup ﬁ

Your name:  John Doe Your name, as shown to others

Ermail address:  email@example.cam

Password: sssss

[¥] Remember password

Cancel | | Continue
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4. Click Continue

5. If Thunderbird fails to find the settings automatically, specify the following:

A Account type. If you want to keep copies of messages on the server, select the IMAP
option. If you do not want to keep any messages on the server, select the POP3
option. Selecting IMAP will also allow you to train the SpamAssassin spam filter on e-
mail messages you receive, if SpamAssassin is enabled on the server.

)

Your pame:  John Doe Your name, as shown to others

Email address:  email@example.cam

Password: esesss

Remember password Start aver
pa

Thunderbird failed to find the settings for your email account.

Username:  email@eample.com

Incoming:  example.com

Qutgoing: | example.com

Manual Setup...
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6. Click Create Account

If you set up a mail account manually, please use the following typical combinations of
connection security and authentication method settings. If the settings do not work for you,
ask your hosting provider about the correct combination.

On Linux:
A Connection securitBTARTTLS
A Authentication metho&ncrypted password

On Windows, IMAP:
A Connection securitijNone
A Authentication metho&ncrypted password

On Windows, POP3:
A Connection securitiNone
A Authentication metho&®assword, transmitted insecurely

Other parameters that you may need when configuring your account manually:

A POP3 port: 110
IMAP port: 143
SMTP port: 25
UsernameYour full e-mail address. For example: johndoe@example.com.

Incoming server addre$BOP3/IMAP). Specify your website's Internet address. Example:
example.com

Outgoing serveaddress Specify your website's Internet address. Example: example.com

> > > >

>
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Access from Apple Mail

The instructions provided in this section were verified against Apple Mail 3.6 (Leopard). They
might not work with earlier or later versions of Apple Mail.

U Toset up Apple Mail:

1. Run Apple Mail.

If you run it for the first time and do not have any mail accounts configured in it, skip the
next step: Apple Mail will take you directly to creating one.

2. Open the Adding Mail Account wizard:

a. Click Mail> Preferences....

b. Select the Accountstab.

c. Click the + button at the bottom left corner.
3. Enter the account information:

A Your full name
A Your full e-mail address
A The password you use to log in to the Panel.

Add Account

You'll be guided through the necessary steps to set up
an additional mail account.

To get started, fill out the following information:

Full Name: John Doe

Email Address: johnd@example.com

Password: | ssssas

@ " Go Back f Continue j
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4. Click Continue

5. Fill in the following incoming mail server information:
A Account Typeselect whether you want to use IMAP or POP protocol.

We recommend selecting IMAP if you use SpamAssassin as a spam filtering solution:
IMAP account is a requirement for SpamAssassin learning which messages are spam
and which are not.

A Incoming Mail Serveype in the name of domain which serves your mail (which follows
the @ sign in your e-mail address).

A User Nameenter your full e-mail address.
A Passwordleave it auto-completed (Apple Mail takes it from the previous step).

Incoming Mail Server

Account Type: f & IMAP I-H

Description: |{optional)

Incoming Mail Server: |example.com

User Mame: johnd@example.com

Password: I------ I

@ ( GoBack ) ( Continue )
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6. Click Continue
7. (Optional) Specify the incoming mail security options:
a. Select the Use Secure Sockets Layer (S31gckbox.

b. Select the authentication method.

Keep the default method if you are not sure which to select.

Apple Mail displays this setup screen only if a mail server bundled with Panel supports
SSL for the selected account type (POP or IMAP).

Incoming Mail Security
E Use Secure Sockets Layer (SSL)

Authentication: |' Password l-ﬂ

® ( Go Back ) E Continue )
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8. Click Continue

9. Fill in the following outgoing mail server information:

A Outgoing Mail Servdype in the name of domain which serves your mail (which follows
the @ sign in your e-mail address).

Use only this serveselected.

Use Authenticatn: selected.

User Nameenter your full e-mail address.

Passwordleave it auto-completed (Apple Mail takes it from the previous step).

> > > >

Outgoing Mail Server

Description: |{optional}

Cutgoing Mail Server: |examp|e.cnm H

E Use only this server

E Use Authentication

User Name: johnd@example.com

Password: ssssss

@ (Coma ) (oo




Quick Start with PardiePanel 31

10.Click Continue
Apple Mail displays overall description of the mail account that is going to be created.
11.Select the Take account onlineheckbox and click Create

Account Summary

Account Description: johnd@example.com
Full Name: John Doe

Email Address: johnd@example.com

User Name: johnd@example.com

Incoming Mail Server: example.com
S5L: off

Outgoing Mail Server: example.com
SSL: off

™ Take account online

@ ( GoBack ) ( Create )
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View Site Visit Statistics

Finally, when your site works fine and search engines return it in search results, it is the best
time to evaluate site efficiency by viewing the visits statistics.

U To find out how many people visited a site, from what countries, and what
pages of the site they viewed:
1. If you are subscribed to several hosting packages and have access to

several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Go to the Websites &omaingab and click the domain name for which you
want to view the statictics

3. Click Web Statistics
The site visitor statistics will show in a new browser window.

4. To view statistics for web pages viewed from the SSL-secured area of your
site, select SSL Web Statisti¢s the menu.

5. To view statistics for files downloaded over the file transfer protocol (FTP),
select FTP Statistica1 the menu.

Alternately, you can view the visits statistics for a site by visiting the following URL:
https://your-domain.com/plesk-stat/webstat. When prompted for username and password,
specify your FTP account username and password.

You have successfully completed the quick start part of the guide. Feel free to read about
other features that are available to you in the Control Panel.



CHAPTER 3

Customer Account Adnsination

As described in the section Quick Start with Parallels Pawal page 8), the first step in
establishing your company's web presence is signing up to the services provided by a
hosting company (hosting provider). After you subscribe to a hosting plan, a customer
account in Panel is created to enable you to log in to Panel and use the hosting
services and resources like mailboxes, disk space, and bandwidth.

Customer Account and Multiple Subscriptions

Panel allows you to subscribe to as many hosting plans as you need. For example, if
you do not want your main site to share hosting resources with a company's branch
site you can subscribe to another hosting plan under the same customer account. In

other words, a customer account is a personalized access to all your subscriptions (see
the picture below).

Customer Account

Subscription 1 Subscription 2
www.company.tld www. branch.tld
IP:192.0.2.12 IP:192.0.2.13

10 GB disk space 5 GB disk space e

10 mailboxes 20 mailboxes
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Another reason for using multiple subscriptions is that subscription is limited to only
one IPv4 and one IPv6 address. Thus, all domains within a subscription share the
same IP address (v4 or v6). If you need to host sites on different IP addresses, you
should additionally order the same plan for as many IP addresses as you need. This
can be useful, for example, if you want to secure connections to each of your sites with
a separate SSL certificate. For information on how to purchase an additional
subscription, refer to the section Ordering More Resourc@s page 48).

If you have multiple subscriptions under a single customer account, you can easily
switch among them from the Accounttab. To be more specific, the Accounttab provides
access to operations that apply to all your subscriptions. All other tabs (like Mail Users
or Domains & Websiteare, on the contrary, subscription-wide. This means that to
change mail settings on a particular subscription, you should first switch to it before
clicking Mail

System Users

For each hosting subscription, Panel creates a system user - a user account in the
Panel server operating system. Customers obtain their system users' access
credentials from their service providers and use these credentials for connecting to the
server through FTP, SSH, and so on. In addition, all operations with files and
directories in Panel are performed on behalf of system users. For example, when a
customer adds a new file in File Manager, the subscription's system user becomes the
owner of the file.

Adding Resources to a Subscription

Purchasing a new subscription for extending hosting resources is not always
necessary. You can always improve just one of your subscriptions. For example, add
extra disk space or SSL support. This can be done by switching to another hosting plan
or by purchasing hosting plan add-ons. Learn more in the section Ordering More
Resourcegon page 48).

Managing Customer Account

In Panel, you can perform a number of administrative operations on your customer
account:

A Change an account password and personal information. Learn more in the section
Changing Your Password and Contact Inform@tiopage 36).

A View the list of services and resources provided by subscription on the Accounttab.
For detailed information about all subscription features, refer to the section Viewning
Subscription Summaftgn page 37).

A Make payments to renew your subscription. Learn more in the section Managing
Account Balance and Invoiqes page 44).

A View statistics on your account: For example, disk space or traffic usage. Learn
more in the section Viewing Statisticéon page 50).
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Allowing Other Users to Access Your Account

If the number of hosting maintenance operations is too large to be handled by one

person, you can delegate some of them to other people. For this purpose, you can

create auxiliary user accounts grouped by means of user roles. For example, you can
create a group that is allowed to only upload content to websites. Users in this group

will not be able to perform any operations except for managing website content. For

more information about auxiliary users, refer to the section (Advanced) Managing Auxiliary
User Account$on page 52).

In this chapter:

Changing Your Password and Contact Information ................ccccevvviiiiiiienniennn, 36
Viewing SubSCrPLioN SUMMATY .......coooieieieeee e 37
Managing Account Balance and INVOICES ............coovvviiiiiiiiiiiiiiiiiiiiiieeeeeeeeee 44
Ordering More RESOUICES .......ccuuuuieiiieeeeieeeiie e e e e e et s e e e e e e e e eeataa e e e e eaaeenenes 48
VIEWING SEALISHICS ...t e e e e 50

(Advanced) Managing Auxiliary USer ACCOUNTS ..........ccuvuuiiiieeeeriiiiiiiiinseeeeeeeenaees 52
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Changing Your Password and Contact
Informatio

U To change your password for access to the Control Panel:
1. Click a link with your name at the top of the screen.

2. Type a new password, and click OK

U To change a username or password that you use for connecting to your
subscription over FTP or SSH:

1. Click the Websites & Domairtab.
2. Click Web Hosting Access

w

Type the new username or password, and click OK

To change your contact information:
Click a link with your name at the top of the screen.
Click the Contact Detailsab.

w N e

Update your contact information and click OK
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Viewing Subscription Summary

When you subscribe to hosting services, a user account is created in the Panel to allow you
to manage your websites and mailboxes on your own.

You can view the following information about your account:

A Current subscriptions to service plans.

You can be subscribed to a number of service plans at once, and, therefore, can have
several subscriptions associated with your account. If a billing system is connected to the
Panel, then you can also purchase additional subscriptions, upgrade or downgrade them,
and pay your invoices.

Allocated and consumed resources.

Hosting features available for your websites.

Operations you can perform in your Panel.

Account balance, unpaid invoices, and monthly fee for your hosting package.

> Py > >

To view the information about your account and your current subscriptions:

Click the Accounttab.
A list of your current subscriptions is shown.

=

2. If the billing system is integrated with the Panel, then the following
information is shown:

A Account creditdélance This is how much money is available in your billing account.

A Due invoices balanc&his is how much money you owe to your provider. Here, you can
pay all invoices at once by clicking Pay All Outstanding Invoices pay one of invoices
by clicking a Pay Nowink in the list titled Latest Outstanding Invoiceou can also view
all invoices by clicking the link Show all invoice®r print an invoice by clicking an
invoice number and then clicking Print

A Latest tedo items This shows reminders from the system about the actions you need to
take.

A List of all your subscriptions. You can use links in the list to perform the following
operations:

A View subscription properties by clicking a link with subscription name.

A Select a subscription that you want to manage through the Control Panel by
clicking the corresponding link Switch to Subscription

A Order an SSL certificate for a site by clicking Request SSL Certificafhis operation
is described in the section Ordering SSL Certificates

A View properties of already ordered SSL certificates by clicking Show Certificate Info

A View or change domain information, contact information, and DNS settings
specified at a registrar's site, by clicking Show Domain Inf@ hese operations are
described in the section Registras DNS Settings in Parfeh page 74).

3. To view detailed information about resource allotments, available hosting
options, and permissions for operations, click a subscription's name.
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4. Do any of the following:
A To view a list of allocated and consumed resources, click the Resourcesab.

A To view a list of hosting features available for your account, click the Hosting Options
tab.

A To view a list of operations that you can perform in your Hosting Panel, click the
Permissiongab.

Next inthis section:

Allocated and ConsSUMEd RESOUICES.........cciivviiiiiiiii et
Hosting Features Available for Your Websites..........cccccoceeeiiiiiiiiiieiiiiiee e,
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Allocated and Consumed Resources

If you are subscribed to a number of service plans at once, then you have several
subscriptions. For each subscription, the following types of allocated resources are listed in
the Panel at the Accounttab > subscription name > Resourcegab:

A

>

Disk spaceThis is the total amount of disk space allocated to your account with
subscription. This amount includes all data related to your websites, e-mail accounts,
applications, backups, and log files.

Traffic This is the total amount of data in megabytes that can be transferred monthly from
all your websites.

DomainsThis is the number of websites that can have separate second-level domain
names, such as, for example, example.com.

For information about setting up websites, refer to the sections Set Up Your First Website
(on page 9) and Adding Domainén page 61).

SubdomainsThis is the number of additional websites that can have third-level domain
names, such as, for example, news.example.com.

For information about setting up subdomains, refer to the section Adding Subdomain®n
page 63).

Domain aliased his is the number of additional domain names that can be set up to point
to one of your sites. For example, example.fr and example.de can both point to
example.com.

For information about setting up domain aliases, refer to the section Adding Domain Aliases
(on page 65).

MailboxesThis is the number of mailboxes that can be created under all your websites.
For information about creating mailboxes, refer to the chapter Mail(on page 213).

Mailbox sizeThis is the amount of disk space that can be occupied by a mailbox.

Total mailboxes quotahis is the total amount of disk space that can be used by all
mailboxes under all your domains. This option is available only on Windows-based
customer accounts.

Mailing lists This is the total number of mailing lists that can be set up under all your
websites. Note that there are mailing lists and mail groups, which serve the same
purpose, but are slightly different in functionality. Mailing lists support archiving and pre-
moderation of messages, while mail groups can only be used for sending one message to
a number of recipients at once.

For information about setting up and using mailing lists, refer to the section Using Mailing
Lists (on page 224).

Additional FTP accountbhis is the number of FTP accounts that can be set up for
accessing the webspace, in addition to the main FTP account that was created when your
subscription was activated.

For information about setting up FTP accounts, refer to the sections Changing FTP Access
Credentialgon page 208) and Adding FTP Accounfen page 209).

DatabasegLinux). This is the number of databases that can be hosted for all your
websites. Databases are a standard means of organizing data storage that allows
dynamic websites, web applications, and their users to store, search, and retrieve
information.

For information about working with databases, refer to the chapter (Advanced) Using
Databasegon page 232).
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MySQL databasesd Microsoft SQL Server databaé&$ndows). This is the maximum
number of MySQL and Microsoft SQL Server databases respectively that can be created
on the Panel database servers and used by the subscription's websites.

MySQL databases quatad Microsoft SQL databasggota(Windows). This is the maximum
amount of disk space (in megabytes) that the subscription's MySQL and Microsoft SQL
Server databases respectively can occupy.

Java applicationsT his is the number of Java applications packaged in WAR format that
you can install on your sites.

Sites published with Presence Buildés is the number of sites that you can create and
publish using Presence Builder, if Presence Builder option is included in your hosting
package.

Mobile sites his is the total number of websites that you can host with the UNITY Mobile
online service, which optimizes sites for viewing on mobile devices.

Web uses. This is the number of user accounts that you can create for hosting web pages
for other users under your domains.

FrontPage account$his is the number of Microsoft FrontPage user accounts that you can
create for collaboration on site content using FrontPage. This option is available only for
Windows-based customer accounts.

Shared SSL link3his is the number of websites that you can secure with an SSL
certificate shared by your provider. This option is available only for Windows-based
customer accounts.

ODBC DSN connectiofiis is the number of connections to external databases that you
can create for web applications running on your customer account. This option is
available only for Windows-based customer accounts.

ColdFusion DSN connectiofi$is is the number of connections to external databases that
you can create for web applications written in Adobe ColdFusion, which are running on
your customer account. This option is available only for Windows-based customer
accounts.



Customer Account Administration 41

Hosting Features Alable for Your Websites

Depending on your service plan, the following hosting features may be available for your
websites (listed at the Accounttab > subscription name > Hosting Optiongab):

A SSL supportThis allows you to secure connections to websites with SSL encryption.

For information about securing sites with SSL, refer to the section Securing Connections
with SSL Certificatgsn page 113).

A Web statisticsThis allows you to view website visits statistics presented in diagrams and
charts.

For information about viewing website visits statistics, refer to the section Viewing Statistics
(on page 50).

A Custom error documentghis allows you to create custom HTML pages and configure web
server to show them instead of typical error messages, such as 404 Not Found

For information about setting up custom error documents, refer to the section Setting Up
Custom Error Pagéen page 123).

A Support for programming and scripting languagesh as PHP, CGI, Perl, Python, Microsoft
ASP, ASP.NET, Adobe ColdFusion, SSI.

A Microsoft FrontPage suppartd Microsoft FrontPage over SSL suppiitese allow you to use
Microsoft FrontPage to create and edit website content. These options are available only
for Windows-based customer accounts.

A Remote Microsoft FrontPage authofiindows). This allows you to use Microsoft
FrontPage to create and edit website content directly on the server. This option is
available only for Windows-based customer accounts.

A Dadlicated IIS application pg@Vindows). This provides isolation and improved stability for
web applications working on sites.

A Additional write/modify permissidigindows). This option allows the web applications to
use a file-based database (like Jet) located in the root of httpdocs  folder.

A Allow web users to use scriptis allows scripting at web pages available at URLs like
http://example.com/~<username>/<webpage>, where <username> refers to a web user.
Web users are individuals who do not need their own domain names. This service is
popular with educational institutions that host non-commercial personal pages of their
students and staff.

The following is a list of permissions for operations that you can perform in your Panel
(shown at the Accounttab > subscription name > Permissiongab):

A DNS zone managemeMinage resource records in the DNS zones of websites. DNS
stands for Domain Name System. It is a service that enables web browsers to locate
websites by domain names.

For information about configuring DNS settings for your websites, refer to the section
(Advanced) Configuring DNS for a DoKaairpage 68).

A Hosting settings managemelianage web hosting settings, such as custom web server
settings or support for scripting languages.
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PHP safe mode managemadihiis option is available only for Linux-based customer
accounts. It allows you to switch PHP safe mode on or off for websites. Safe mode is a
security restriction that does not allow scripts written in PHP to perform potentially
dangerous operations on the server. You might need to switch off the safe mode for PHP
if you use some web applications written in PHP and if they do not function properly.

Management of access to the server overa8iManagement of access te #erver over Remote
Desktop Securely upload web content to the server through Secure Shell (Linux) or a
Remote Desktop connection (Windows).

Anonymous FTP managemedt up a folder on the server which should be accessible to
the Internet users over FTP protocol. This folder can have an address like, for example,
ftp://downloads.example.com. This feature is called anonymous FTP because the users
will not need to specify a username and password to browse, download, or upload files.

For information about setting up FTP folder with unrestricted access, refer to the section
Setting Up Anonymous FTP Acc@sspage 211).

Scheduler managemefichedule execution of programs or scripts in the server's operating
system.

For information about scheduling tasks, refer to the chapter Scheduling Task@®n page
225).

Spam filter managemefet custom settings for protection from unsolicited commercial e-
mail, also known as spam.

For information about setting up spam filtering, refer to the section Protecting Mailboxes
from Spam.

Antivirus managemerget custom settings for protection from viruses and other malicious
software that spreads itself through e-mail.

For information about setting up virus protection, refer to the section Protecting Mailboxes
from Viruses.

Data backup and restoration using the server repoditegythe backup and restore functions
of the Panel to back up and restore websites, mail accounts, settings, and keep your
backup files on the server.

For information about backing up and restoring data, refer to the chapter (Advanced) Back
Up and Restore Ddan page 237).

Data backup and restoration using a personal FTP repdsiterthe backup and restore
functions of the Panel to back up and restore websites, mail accounts, settings, and save
your backup files to an FTP folder on another server.

For information about backing up and restoring data, refer to the chapter (Advanced) Back
Up and Restore Ddan page 237).

Web statistics manageme8et custom preferences for visitor statistics reports.

For information about configuring and viewing website visitor statistics, refer to the
section Viewing Statisticéon page 50).

Log rotation mnagementSet custom preferences for recycling (rotation) of web server
logs. Web server records information about connections to your sites and errors occurred
on attempts to retrieve missing files. You can use these log files for website debugging
purposes.

For information about working with web server access logs, refer to the section Log Files
(on page 51).

Access to Application Catalogew and install applications on websites. For information
about applications, refer to the section Employing Website Applicatigasm page 103).
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A

Setup of potentially insecure web scripting options that override provider'S'pdiejlows you
to override the hosting security policy, if it is applied by the provider.

Domaircreation Set up and manage new websites.

For information about setting up websites, refer to the sections Set Up Your First Website
(on page 9) and Adding Domainén page 61).

Subdomains manageme8et up and manage new websites with addresses like
forum.example.com.

For information about setting up subdomains, refer to the section Adding Subdomain®n
page 63).

Domain aliases managemesegt up and manage additional domain names for a site.

For information about setting up domain aliases, refer to the chapter Adding Domain Aliases
(on page 65).

Additional FTP accounts managem®at up and manage additional FTP accounts. To
enable collaboration on website content, you can set up FTP accounts for other users
and specify which directories of the site should be accessible to them.

For information about setting up FTP accounts, refer to the section Adding FTP Accounts
(on page 209).

Java applicédns managemeninstall and manage Java applications distributed in WAR
archives and obtained separately from third-party vendors or application developers.

For information about installing Java applications, refer to the section Installing Java
Applications.

Mailing lists manageme®et up and manage mailing lists.

For information about setting up and using mailing lists, refer to the section Using Mailing
Lists (on page 224).

Hosting performance settings managemsantit the bandwidth and number of connections to
websites.

For information about restricting bandwidth usage for sites, refer to the section Limiting
Bandwidth and Number of Connections to Welgsitgzage 130).

IIS application pool managemesdt custom preferences for 1S application pool (available
only on Windows-based customer accounts).

For information about setting up 11S application pool, refer to the section Setting Up 1S
Application Pool (Window®n page 149).

Additional write/modify permissions managenieeit additional write/modify permissions for
websites that use file-based databases (available only on Windows-based customer
accounts).

Shared SSL managemeé®é¢cure connections to your sites with SSL protection by using an
SSL certificate shared by your provider.

For more information, refer to the section Using Shared SSL Certificates (Windovspage
117).

Hard disk quota assignmeAdjust hard quotas on disk space if that is supported by your
customer account.

Database server selecti@elect a database server for creating databases, if multiple
database servers are available.
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Managing Account Balance and Invoices

The operations described below are available if your Control Panel is integrated with
Parallels Parallels Customer and Business Manager.

U To view your account balance and pay for hosting services:
1. Click the Accounttab.

2. The following information is shown:

A
A

Account credit balance. This is how much money is available in your account.

(Optional) Usage charge. If your subscription allows consuming hosting resources
over the plan limit, this number shows how much money you should pay for these
resources in addition to your subscription price. To view the detailed information about
how much resources you used over limits, click the link See detailbelow the charge
amount. To learn how the system calculates usage charges, see the section
Calculating Usage Chardes page 46).

Due invoices balance. This is how much money you owe to your provider. Here, you
can pay all invoices at once by clicking Pay All Outstanding Invoices pay one of
invoices by clicking a Pay Nowink in the list titled Latest Outstanding Invoices

Latest to-do items. This shows reminders from the system about actions you need to
take.

(Optional) Affiliate programs. Your provider may let you earn money for promoting
their plans. To start earning, you should join their affiliate programs. Here you can find
the link to join affiliate programs or the info about your money you earn if you already
joined the programs. To learn how to get profit from affiliate programs, see the section
Earning Money by Promoting a Provider's Rtanpage 46).

List of all your subscriptions. You can use links in the list to perform the following
operations:

A To view subscription properties, click a link with subscription name.

A To select a subscription that you want to manage through the Control Panel, click
the corresponding link Switch to 8bscription

A To order an SSL certificate for a site, click Order a CertificatEor more information
about this operation, see the section Ordering SSL Certificates

A To view properties of already ordered SSL certificates, click Show Certificate Info

A To view or change domain information, contact information, and DNS settings
specified at a registrar's site, click Show Domain Inféor more information about
these operations, see the section Registrar's DNS Settings in Pgpelpage 74).
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U To choose a payment method that you would like to use for paying for
services:

1. Go to the Accounttab > Billing Accounts

A record about the payment method that you used for purchasing the services for the first
time is shown.

2. Do any of the following:

A To view or change settings for a billing account, click the corresponding link in the
Billing account nameplumn, specify the information about your bank card or account,
and select the subscriptions that should be paid by it. Click OK

A To add a new billing account, click Add New Billing Accoyrstelect the payment method,
and click Next Then choose the account owner (you or an auxiliary user that will be
able to use this account), specify the required information about your bank card or
account, and select the subscriptions for which you will pay with it. Click OK

A To remove a billing account, click the corresponding Removdink.

Next in this section:

Calculating USage Charges..........uuuuuuuuuuuiiiiiiiiiiiiiiiiiiiiiseiiiieiebeeeseeeeeeeeeeenenneneenne 46
Earning Money by Promoting a Provider's Plans...........ccccooooeeiiiiiiiiiiiniceeecceeen, 46
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Calculating Usage Charges

If the pay-as-you-go web hosting is allowed for a plan, Business Manager calculates usage
charges - total costs of hosting resources overage - for the plan's subscribers basing on
resource usage statistics that Business Manager collects from the connected Panels on a
daily basis. No matter what billing mode and billing cycles you use, this happen on the first
day of each month: The system finds the average daily overage of each resource except
traffic and multiplies it by the month length and the monthly usage price of this resource.

Traffic

The traffic usage charge is calculated in the following way: Business Manager counts the
total traffic overage for a month and multiplies it by the monthly traffic usage price. For
example, if subscribers download 10 GB of files during a month while the plan limit is 5 GB,
then the traffic overage is 5 GB. Assuming that the traffic usage price is $1 for a 1 GB, such
subscribers will pay (10 GB - 5 GB) * $1 = $5 traffic usage fee.

Other Resources

For calculation usage charges for other resources, Business Manager uses the average daily
usage values. For example, if a customer uses 500 MB of disk space over the subscription
guota for 15 days and then uses extra 700 MB for other 15 days, the average overage will be
(500 * 15 + 700 * 15)/30 = 600 MB. If the disk space usage price is $1 for 1 GB, then the
customer will pay $0.6 for disk space overage this month.

Calculating Usagéh Adens

If a customer purchases additional resources in the middle of a month, then the system
subtracts the resource amount provided by the add-on from the daily resource usage of each
day starting from the add-on purchasing day.

For example, if a customer uses 500 MB of disk space over the plan limit for a whole month
and purchases the add-on that provides an additional 1 GB of disk space on the 7™ day of
the month, then the usage charge will include the payment for only 7 days of 500 MB of disk
space overage.

Earning Money by Promoting a Provider's Plans

Panel lets you earn money for promoting your provider's service plans. Particularly, you can
get a certain commission for each subscription ordered in the provider's online stores by
people who signed up using your referral link.
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Participants of affiliate programs (affiliates) distribute links to their provider's online stores.
Each link is unique, so the system defines who brought a new customer and adds the
commission to the link owner's affiliate balance. This commission is defined by the terms of
the affiliate program and may vary depending on an online store. The commission consists of
two different elements:

A Initial rate - a percentage that the affiliate earns from the price of each order placed using
the affiliate's link.

A Recurrent rate - a percentage that the affiliate earns from each invoice issued for
subscriptions that were ordered using the affiliate's link.

Affiliates can use money they earn only after the provider pays out the money to them.
Depending on the affiliate program conditions, the provider can pay out the commission
either to the affiliate's account credit balance or transfer the money outside the system, for
example, by check or cash. Normally, the provider pays out affiliates' commissions when
they exceed the affiliate program's payment threshold. When the threshold is exceeded,
affiliates can request the provider to pay out the commission by using the button in the
Control Panel. Alternatively, affiliates can delay payments in order to earn a larger amount.

Becoming an Affiliate

To start earning money, click the link Become an Affiliaten the Accounttab. Once became an
affiliate, you will get the access to the list of the provider's affiliate programs and your affiliate
links. To see the programs list and your links, click the Affiliate Programbst on the Account
tab.

Tracking Your Earnings

To see your current affiliate balance, go to the Accounttab and find the balance in the Affiliate
Programgyroup. If you want to see detailed information about your earnings, click the link
Revenue from Referrals

To request a payout after exceeding a payment threshold, go to the Affiliate Programpage,
select the programs and click Request Payout

Note: If none of your affiliate balances exceed the corresponding thresholds, you will not see
the Request Payoludutton.

Example

For example, your provider offers you an affiliate program with 10% commission rate and
$20 payment threshold. You share your affiliate link with your friends, and three of them
subscribe to a web hosting plan which costs $50. The total commission that you get to your
affiliate balance is $50 * 3 * 10% = $15. This amount is less than the program's payment
threshold, so to receive credits, you should bring more customers to the online store with
your link. When you do this and your balance exceeds the payment threshold which is $20,
the provider will add this balance to your credits. When you receive them, you can use them
to pay for your subscriptions or subscribe to new services in the provider's online stores.
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Participating in Multiple Programs

Your hosting provider may have multiple online stores with different currencies. If the
provider offers affiliate programs for stores with different currencies, you will receive separate
commissions in the corresponding currencies. For example, if you distribute links to stores
with USD and EUR currencies, your affiliate balance contains two separate affiliate balances,
one for each currency. Your provider pays out the commissions separately as well. For
example, your affiliate balance is USD 50 and EUR 40 and the payment thresholds of the
corresponding programs are USD 40 and EUR 45, your provider will pay out USD 50 to your
credits and your affiliate balances will be USD 0 and EUR 40.

Ordering More Resources

The operations described below are available if your Control Panel is integrated with a billing
system.

U To add more resources to your subscription or upgrade to another service
plan:

1. Click the Accounttab.

2. In the list of subscriptions, locate the subscription that you want to upgrade
to another service plan, and click a link with the currently used plan's name.

3. Click Upgrade

If there is no Upgraddink, then it means that you cannot upgrade to another hosting plan
from your Control Panel, and you need to contact your provider.

4. Do any of the following:

A To add resources to your subscription without upgrading to another plan, select the
options you would like to add and click Adjust Adebns.

A To upgrade to another service plan, click Order Upgrade

U To reduce the amounts of resources or downgrade to another service plan:
1. Click the Accountab.

2. In the list of subscriptions, locate the subscription that you want to
downgrade to another service plan, and click a link with the currently used
plan's name.

3. Click Downgrade

If there is no Downgraddink, then it means that you cannot downgrade to another hosting
plan from your Control Panel, and you need to contact your provider.
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. Do any of the following:

A To reduce the amounts of allocated resources without downgrading to another plan,
select the options you would like to reduce and click Adjust Adebns

A To downgrade to another service plan, click Order Downgrade

To subscribe to a hosting plan in addition to your main plan:
. Go to the Accounttab and click the Add Subscriptiotink.

. Select the hosting plan to which you want to subscribe, and click Buy Now
Follow the instructions on the screen to complete the order.
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Viewing Statistics

U To view the reports on disk space and trafagei®y your account:

1. If you have several subscriptions associated with your account, in the
Subscriptiormenu at the top of the screen, select the required subscription.

2. Click the Statisticstab.
The following information is presented in charts:

A

Disk space used by the following files and directories in the subscription:
Websites
Mail accounts

> >

>\

Databases
Logs
Backups

> > >

Chroot directories

Configuration files

> >

Anonymous FTP directory
Traffic used by FTP, web, and mail services during the current month.

FTPfield shows the information about the total size of files transferred to and from the
webspace over the file transfer protocol.

HTTHield shows the information about the total amount of data transferred from all of
your websites over HTTP protocol, that is, retrieved by web browsers.

POP3/IMAReld shows the total amount of data received by all mail accounts under
your domains.

SMTHield shows the total amount of data sent by all mail accounts under your
domains.

3. Do any of the following:

A

A

A

To view a report on the amount of data transferred to and from your sites over FTP,
click FTP Statistics

To view a report on the amount of data transferred to and from your FTP directory,
which is accessed without authorization, click Anonymous FTP statistics

To view a report on the amount of traffic used by services during a certain month, click
Data Transfer Statisticand select the required month from the menu.

Next in this section:

[ To I 1[PPI 51
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Log Files

All connections to the web server and requests for files that were not found on the server are
registered in log files. These log files are analyzed by the statistics programs running on the
server, which then present graphical reports on demand. You may want to download these
log files to your computer for processing by third-party statistics programs, or view their
contents for web server debugging purposes.

U To prevent these log files from growing too large, you should enable automatic
cleanup and recycling of loé:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairiab > Logs> Log Raation

3. Click Switch Onlf you see only the Switch Ofbutton there, this means that log
recycling is already switched on.

4. Specify when to recycle log files and how many copies of each log file to
store on the server. Also specify whether they should be compressed and
sent to an e-mail address after processing.

5. Click OK

U To view the contents of a log file or download it to your computer:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairtab > Logs A list of log files opens.

3. Do any of the following:

A To view all entries in a log file, click the log file name. If you want to view only a few
last lines from the log file, type the number of lines into the input box under the Settings
group, and then click the log file name.

A To download a file to your computer, click the corresponding icon .
A To remove a processed log file from the server, select the corresponding checkbox

and click RemoveConfirm removal and click OK
U To download log files to your computer via FTP:
1. Connect to the Panel server via FTP.

2. Go to the /var/www/vhosts  /<domain_name>/logs directory and copy
the log files to you computer.
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(Advanced) Managing Auxiliary User
Accounts

If you want to allow other users to access the Panel for managing websites and installed
applications, or to use e-mail services under your domains, then you need to create user
accounts for them.

Auxiliary Users and User Roles

Auxiliary user accounts are created based on user roles. The roles include privileges to

access certain areas of the Panel and perform operations in the Panel. There are several
predefined user roles, namely: Accountant, Application User, Owner, and Webmaster. You

can review and modify the Accountant, Application User, and Webmaster roles to suit your
needs, or you can create your own custom roles. For more information on user roles and

user account creation, refer to the sections User Rolegon page 53) and Auxiliary User Accounts
(on pagesh) correspondingly.

After auxiliary user accounts are created, the users will be able to log in to their accounts in
Panel and use shortcuts in their Panels to access their mailboxes and work with applications.
In addition, you can extend the list of links available to your auxiliary users with your custom
links. These can be links to corporate resources, sites on the web, and so on. Learn more in
Custom Linkgon page 57).

Auxiliary Users and Multiple Subscriptions

Since Panel 10.4, if your customer account includes more than one subscription, you can
allow auxiliary users to access only a specified subscription. If the Access to subscriptions
property of a user account is set to a certain subscription, the user will always log in to this
subscription and will not be able to switch to other subscriptions.

Next in this sdmn:

USBE RIS ..o e et 53
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User Roles

U To create a user role:

1. Go to the Userstab > User Rolesab > Create User Role

2. Specify the following:

A User role name

A Access to Panel serviceSrant the required permissions for operations to the user:

A

> > > >

>

> >

A

A
A
A
A

Manage users and rolesdd, modify, and remove user accounts and roles. Note that
even if this permission is not granted to a user, the user will be able to browse
contact information of other users after logging in to the Panel.

Create and manage sit&et up, modify, remove domain names and subdomains,
host websites and change web hosting settings.

Configure log rotatiotManage settings for recycling of web server access and error
log files. View, download, and remove log files.

Configure anonymous FTP servi8et up a directory accessible to all Internet users
over FTP without authorization.

Create and manage scheduled taSk&iedule execution of scripts or programs on
your customer account.

Configure spam filteBet up spam protection for mailboxes.
Configure antivirusSet up virus protection for mailboxes.

Create and manage datsés Add, modify, and remove databases stored on your
customer account.

Configure and perform data backup and restor&amk up and restore data related to
your customer account, websites, and mailboxes under your domains.

View statisticsView reports on disk space and traffic usage by your websites, and
website visits.

Install and manage applicatiohsstall applications on websites and manage them.
Design sites in Presence Buildéreate websites using Presence Builder.

Upload and manage filédanage files and directories located in the webspace by
using the Panel's file manager.

Create and manage additional FTP accoBataip additional FTP accounts for other
users.

Manage DNS settinddanage DNS settings for domains.
Install and manage Java bggtions Install on websites third-party Java applications.
Create and manage mail accou@tgate, modify, and remove e-mail accounts.

Create and manage mailing li€lseate, modify, and remove mailing lists.

A Access to appsSelect the applications that the user should be able to access and use.
All web applications installed on the server are listed in this area.

For more information about installing applications and providing access to users, refer
to the section Granting Auxiliary Users Access pp#\(on page 106).
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A Access to the billing operatior@rant these permissions if you want users of this role to
view and pay invoices for your subscriptions.

3. Click OK

To modify user role properties:
Go to the Userstab > User Rolesab.

Click a link with the role name that you want to change.

w N e

Change the role properties as required and click OK

To remove a user role:

c:

1. Go to the Userstab > User Rolesab.

2. Select a checkbox corresponding to the role you want to remove and click
RemoveNote that it is impossible to remove the Ownerrole and other roles
that are assigned to one or more users.

3. Click Yesto confirm the removal.
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Auxiliary User Accounts

U To create a user account:
1. Go to the Userstab > Create User Account

2. Specify the following:
A Contact name

A E-mail addressThe e-mail address will be used as a user name for logging in to Panel,
unless you specify another name in the Usernaméox.

A To create a new e-mail address for the user, select the option Create an-mail
address under yowaccount

type the desired left part of the address which goes before the @ sign, and, if you
have a number of domains on your account, select the domain name under which
the e-mail address should be created.

A To associate with this user account an external e-mail address, select the option
Use an externatraail addressand specify an existing external e-mail address.

A User roleSelect the required user role from the menu.

A Access to subscriptiondllow a user to access only a specified subscription. The All
value grants them access to all subscriptions within your customer account.

A UsernameThe user name for access to Panel.
A PasswordThe password for access to Panel.

3. Leave the User is activeheckbox selected. Otherwise, the user will not be
able to access the Panel and use applications on your customer account.

4. Click OK

5. Now, if you want to add contact information for the user, click a link with the
user's name, and then click the Contact Detailtab, and specify the user's
contact information.

6. Click OK

Now you can notify the user about creation of his or her account and ability to access Panel.
Provide the user with the address to open in his or her browser, the username (which is the
user's e-mail address), and the password that you specified in the account settings.

To change user account properties:
Click the Userstab.

Click a link with the user's name.

w N e

Make the required changes and click OK
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To suspend or activate a user account:
Click the Userstab.

Click a link with the user's name.

w N R

Do any of the following:

A To suspend a user account, clear the User is activeheckbox. The user will no longer
be able to log in to the Panel and access applications.

A To activate a user account, select the User is activeheckbox.
4. Click OK

U To remove a user accdun
1. Click the Userstab.

2. Select a checkbox corresponding to the user account you want to remove,
and click RemoveNote that you cannot remove your own account.

3. Click Yesto confirm the removal.
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Custom Links

You can add custom hyperlinks to the Panel and make them visible for your users. The links
may lead to web resources, such as your corporate site, or to a web application that can
process online requests and accept additional information about the users who click these
links.

You can specify what information about users should be passed:

A Subscription ID.

A Primary domain name associated with a subscription.

A FTP account username and password.

A Customer's account ID, name, e-mail, and company name.

You can place the links in the following locations of the Control Panel, and decide who
should be able to see them:

A On the Websites & Domaiqsge in the Control Panel, visible only to you. This is achieved
by selecting the Customer's Home pagetion in the link properties.

A On the Websites & Domaiqsge in the Control Panel, visible to you and your users who
are allowed to log in to the Control Panel. This is achieved by selecting the Common
accessoption in the link properties.

A On the Websites & Domaitab in the Control Panel, visible to you and your users who are
allowed to log in to the Control Panel. This is achieved by selecting the Websites & Domains
page of Subscriptiamption in the link properties.

U To add a custom hyperlink to the Control Panel:
1. Go to the Accounttab > Additional Serviceand click AddLink to Service
2. Specify the following settings:

A Type the text that will show on your button in the Button labebox.
A Choose the location for your button.

A Specify the priority of the button. Your custom buttons will be arranged in the Panel in
accordance with the priority you define: the lower the number, the higher the priority.
Buttons are placed in the left-to-right order.

A To use an image for a button background, type the path to its location or click Browse
to browse for the desired file. It is recommended that you use a 16x16 pixels GIF or
JPEG image for a button to be placed in the navigation pane, and 32x32 pixels GIF or
JPEG image for buttons placed in the main frame or desktop.

A Type the hyperlink of your choice to be attached to the button into the URLbox.

A Using the checkboxes, specify whether you want the customer information and other
data to be transferred within the URL. These data can be used for processing by
external web applications.

A In the Tooltip texinput field, type in the help tip that will be displayed when the users
place the mouse pointer over the button.
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A Select the Open URL in Parallels Pactgckbox if you want the destination URL to be
opened in the main frame of the Panel, otherwise, leave this checkbox cleared to
open the URL in a separate browser window or tab.

A If you want to make this button visible only to you, select the Show to me onlgheckbox.

3. Click Finishto complete creation.

U To remove a hyperlink button from the Panel:
1. Go to the Accounttab > Additional Services

2. Select a checkbox corresponding to the link that you want to remove and
click Remove



CHAPTER 4

Websites and Domains

As described in the chapter Quick Start with Parallels Pafwai page 8), creating your web
presence always starts with purchasing a domain name. The domain name (or simply,
domain) is the name people use to access your site from their browsers, for example,
www.example.com . The domain registration is carried out by authorized companies -
domain name registrars. Hosting providers often carry out this function. For detailed
information about how to manage domains in Panel, refer to the section Domains and
DNS(on page 60).

However, a domain is not a website. To make it accessible from the web and fill it with
content, you should subscribe to hosting services (obtain a customer account). That is
to supplement your domain with Internet connectivity, some disk space to store your
content, mail services, and so on. Thus, a website is a domain with provided hosting
services.

Panel provides a full range of operations in regard to domains and websites:

A Adding and removing domains, subdomains, and aliases.

A Managing the content of your websites.

A Installing various web apps.

A Securing connections to your websites and much more.

This chapter provides detailed information on all the possible operations on websites

and domains in Panel. Note that some of these operations may be unavailable
according to your hosting plan.

In this chater:
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Domains and DNS

As described above, a domain name is the hame that people type in their browsers to
access your website.

A domain name is hierarchical and can consist of a number of parts called labels:

A The label furthest to the right is called the top-level domain. For example, com is
the top-level domain of www.example.com . The number of top-level domains is
limited and all of them are managed by separate international authorities.

A The second-level domain is the label that we mainly use to imply the purpose of our
website. In www.example.com it is the example part. The combination of the
second-level and top-level domain names specifies the exact location of your
website.

A Each label to the left is a subdomain of the domain to the right. For example, www
is the subdomain of example.com . Subdomains can be convenient when you want
to isolate some content from the main site, e.g. you can organize your personal
blog on myblog.example.com . For information on how to add subdomains in
Panel, refer to the section Adding Subdomain®n page 63).

If you want to host more than one website under your subscription, you can register
more domains and add them to your subscription. Registering new domains may be
available to you in the Control Panel if your hosting provider allows this. For information
on how to purchase and add domains in Panel, refer to the section Adding Domaingn
page 61).

In fact, domain names exist only for convenience; the real communication between
browser and web servers uses IP addresses - the numerical host identifiers. For

example, the real address of www.example.com may be 192.0.2.12 (IPv4). To resolve
domain names into IP addresses, web hosts use DNS technology. For more details

about how DNS is implemented in Panel, refer to the section (Advanced) Configuring DNS
for a Domaifjon page 68).

DNS allows several domains to be resolved into one IP address. Such additional
names are called domain aliases. This is convenient when you have purchased several
domains that you want to point to the same website. For information on how to add
aliases to existing domains, refer to the section Adding Domain Alias¢sn page 65).

Next in this section:
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Adding Domains

If your hosting package includes more than one domain hame (website), then you can
easily add new domains to the server. Before you start adding a new domain that will
use a second-level domain name, like example.com, be sure to register this domain
name. If your hosting provider provides the domain hame registration service, you can
do this from the Control Panel as described below. Otherwise, you should register your
domain name with another domain name registration authority.

You can set up the following types of site configurations through Panel:

A Website addressed by a secésnkl domain nam&he following services are available
for websites:

A
A
A

A
A

A unique Internet address (domain name), like example.com.
Additional domain names (domain aliases).

Subdomains - divisions of a site accessible by easy-to-remember addresses
that are added to the main site, like mail.example.com.

Separate FTP accounts for collaboration on the site content. For every FTP
account, you can specify which directories can be accessed.

Creating content using Presence Builder.

Simplified deployment of applications, such as content management systems,
photo galleries, shopping carts, blogging platforms, and many more.

Secure data exchange implemented by SSL protocol. This requires that a site
be hosted on a dedicated IP address, which is not shared among other users
and sites.

Mailboxes and mailing lists.

Viewing statistics on site visits.

A Website or a division of a website addressedHiyddevel domain name (subdomairis
is usually a division of an existing site. It has an Internet address comprising of
three parts separated by dots. The following services are available for subdomains:

A

> > > >y >

Separate document root from the main site. Document root is a directory on the
server where web pages of a site are stored.

Access over FTP for content management.

Creating content using Presence Builder.

Simplified deployment of applications.

Secure data exchange implemented by SSL protocol.
Viewing statistics on site visits.
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Adding More Domains

U To host a new website with a seclavél domain name:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscriptiormenu at the top of the screen.

2. Click the Websites & Domainab, click Add New Domaand follow on-
screen instructions.

Note: If you select the recommended option, you should connect the DNS settings
related and your domain name with the domain name at the registrar's side. To
achieve this, enter the Panel name server IP address into the respective NS record
of the registrar. The instruction on how to obtain the IP is as follows: go to Websites
& Domaing <domain name>DNS Settinggind the NS record, and then find the A
record corresponding to the NS record value.

For example, if your NS record is

example.com. NS ns.example.com,

find the A record with ns.example.com, for example,

ns.example.com. A 192.0.2.12

The resulting value, 192.0.2.12, is the Panel name server IP you need.

3. Click OK
The new domain name is now shown in the list at the bottom of the screen.

4. If the operation of changing hosting settings is available for your
account, then you can click the domain name of the new website to
view or change the hosting settings, as described in the section
Changing Hosting Settingsn page 77).

You can now start creating your website with Presence Builder or upload your web
content to the webspace of the new website, as described in the section Managing
Website Conterfon page 95).

Registering Domains

If your service provider offers the domain name registration service as well as web
hosting, you can initiate a domain registration directly from Panel. To register a domain
name, add it as described above and then click the link register it novbeside the new
domain name on the Websites & Domainab. This will redirect you to the provider's
online store where you can complete the registration.

After you register a domain name, it appears in the Registered domain namles on the
Websites & Domaiab. To get information about a domain name registration, for
example, the registration price and next renewal date, click the domain name in this
list.
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Removing Domains

When you delete a domain from Panel, all data related to the corresponding site are
deleted from the server. The first domain name (default domain) that was created for
your account cannot be deleted; however, it can be renamed.

U Toremove a domain:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscriptiormenu at the top of the screen.

2. Go to the Websites & Domairtab and click the name of the domain or
subdomain you want to remove.

3. Click Remove Websiter Remove Subdomain

4. Confirm removal and click OK

Note: Removing domain names from the Control Panel does not cancel the registration
of these names. If you registered these domains name, you still can use them for your
websites.

Adding Subdomains

If your hosting package includes subdomains, which are additional third-level domain

names, then you can use them to:

A Organize logically the structure of your site.

A Host additional websites or parts of a website on the same server without the need
to pay for registration of additional domain names.

An example of using subdomains:

You have a website your-product.com dedicated to promoting and selling your product.
For publishing information related to customer service and online order tracking, you
can organize the subdomain "orders" so that your users will be able to access this
information directly by visiting the Internet address "orders.your-product.com"”.

As subdomains have the same status with the additional domains, you can use the
same set of tools and services for working with subdomains. For example, SSL
protection, Presence Builder, web statistics, and so on.

U To set up a subdomain for a site division or a separate site:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscriptiormenu at the top of the screen.

2. Click the Websites & Domairab.
3. Click Add New Subdomain
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4. Specify the following:

a. In the Subdomain namieox, type the portion of address that will
be added to the domain name of your main site.

b. In the Document rodbox, type the desired location of the
directory where all files and subdirectories of this site will be
kept. You can use the default directory of the main site, called
httpdocs, or specify another directory.

5. Click OK
The new subdomain name is now shown in the list at the bottom of the screen.

You can now upload your web content to the subdomains webspace (directory on the
server), as described in the section Uploading Content over ETP

Wildcard Subdomains

If you enter the asterisk (*) symbol as a subdomain name, Panel will create a so-called
wildcard subdomain.When site visitors enter any subdomain name that is not
registered in Panel, they will be redirected to this wildcard subdomain. You can create
wildcard subdomains on any domain name level. For example, you can create the

*. mystore.example.com subdomain. Learn more about wildcard subdomains in the

section Adding Wildcard Subdomains (Lini@x) page 66).
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Adding Domain Aliases

Domain aliases allow you to point several domain names to the same website. This
can be useful, for example, for branding purposes.

U To set up a domain aian Panel:
1. Run the Add New Domain Aliagzard in the Websites & Domainsab.

2. Specify the domain for which you are creating an alias (the primary
domain) and the aliasds dowaiasthd nameset f or ¢
up the following:

A Synchronization of DNiBne with the primary domain

If this option is enabled, the DNS zone of the domain alias will be in sync with the
zone of the primary domain. Any changes made in the DNS zone of the primary
domain will be automatically applied to the DNS zone of the alias. For example, if

you create the CNAME record like blog.primary_domain.tld , the
corresponding blog.alias.tld record will be added to the zone of the alias.
Note:l f a domain aliasbs DNS zone is synced wi

modify resource records in the alias's DNS zone.

A Mail service

Panel does not allow creating mailboxes under domain aliases. Instead, the
mailboxes of the primary domain are used. If you select the Mail serviception, the
mailboxes created under the primary domain will also be available under the alias.
To enable users to read mail sent to mailboxes under the alias, Panel redirects it to
the corresponding mailboxes under the primary domain.

For example:

You have an email address mail@domain.tid . Then you set up an alias for
domain.tld , for example, alias.tld . If you select the Mail serviception, all mail
sent to mail@alias.tld will be available at mail@domain.tld . Otherwise, the
mailbox mail@domain.tld will not receive mail sent to mail@alias.tld

A Web service

If thisoptioni s turned on, the website will open in
you clear the Web serviceheck box, the alias will be used for mail only provided that
Mail services selected.

A Redirect with the HTTP 301 code

By default, Panel uses web server internal redirection for aliases. In this case, the
alias appears to be a separate website for visitors and for web search engines. This
causes the problem because search engines index the content of the alias
separately, so your primary domain loses search engine rankings.

To avoid this, you can use redirection with the HTTP 301 code (Moved
permanently) by selecting Redirect with the HTTP 301 cddehis case, only the
primary domain will rank in search engines. Learn more at
http://support.google.com/webmasters/bin/answer.py?hl=en&answer=93633
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A

Java web applications

If you use hosting services based on a Linux platform, and you have Java
applications installed on your site that you want to make accessible through the
domain alias, select the Java web applicatioraption.

Adding Wildcard Subdomains (Linux)

Use wildcard subdomains to redirect visitors from non-existent subdomains to one of
your websites, commonly, to your main website. The typical use cases of this feature
are:

A

A

Improve website organization and run marketing campaigns.

For example, you do not have the vps-limited-offer subdomain but wish to forward
users from limited-vps-offer.example.com to example.com.

Help users reach your website even if they mistyped a subdomain name.

It is a widespread mistake to mistype a website name if it has the leading www
prefix (for example, typing ww.example.com).

Finally, some website applications (WordPress) use wildcard subdomains to create
dynamic subdomains for convenience and better user experience.

Note: Traffic to existent subdomains will not be affected in any way if you add a
wildcard subdomain.

How to Add Wildcard Subdomains

You can add one wildcard subdomain per each of domain names under a subscription.
For this, go to the Websites & Domaiab and add a new subdomain which name is "*"
to one of your domain names. Example: *.example.com. If you wish this subdomain to
have a custom set of scripts or website content, specify a custom document root for
this subdomain.

Limitations of Wildcard Subdomains

Wildcard subdomains act like typical subdomains with the following exceptions:

A

A
A

Linux-only feature. Currently, wildcard subdomains are supported only on Panel for
Linux.

Renaming is not available. It is not possible to rename such subdomains.

No DNS zone. This type of subdomains does not have own zone record in the
Panel's DNS server. Instead, they have the A record that points to the IP address
associated with a corresponding domain name.

Installation of APS apps is not allowed. Panel users are unable to install APS apps
to wildcard subdomains.

No Presence Builder sites. Panel users are unable to edit and publish sites to these
subdomains.
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Adding a Domain Forwarder

i

To ceate a domain forwarder in Panel:

Start creating a new domain in Websites & DomainrsAdd New Domaend specify the
following:

A

i

In the Domain nambox, type the domain name that you have registered with your
service provider or a domain name registration company and from which you want
to redirect visitors.

Under DNS server configuratiogelect the option Use our DNS settings
Under Hosting typeselect the Forwardingption.

In the Destination addredsox, type the URL address to which you want to redirect
visitors.

Under Forwarding typeselect standard or frame forwarding. To learn more about
forwarding types, see Forwarding(on page 81)

To make an existing domain a domain forwarder:

On the Websites & Domainab, click Hosting Seings beside the name of the domain you
want to make a forwarder, and click the Changdink next to the Hosting typdield and
specify the following:

A
A

A

Under Hosting typeselect the Forwardingpption.

In the Destination addredsox, type the URL address to which you want to redirect
visitors.

Under Forwarding typeselect standard or frame forwarding. To learn more about
forwarding types, see Forwarding(on page 81)
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(Advanced) Configuring DNS for a Domain

The Domain Name System (DNS) is a hierarchical naming system that translates
understandable domain names into the numerical identifiers (IP addresses) associated
with web hosts. Such translation is called resolving. When you add a domain name
(using Websites & DomainrsAdd New Domainyou should choose the role of Panel in
resolving your resources: It can directly process all translation requests, be a backup
server, or pass the translation requests to a remote server. This role can be changed
for existing domain names (Websites & Doains> domain name > DNS SettingsWe
discuss details about each of the roles and provide instructions how to assign them
next in this section.

Note: If your Panel does not use its own DNS service and does not allow configuring
DNS settings on a remote DNS server, you can only view the information about your
registered domain name. The link DNS Settingis Websites & Domaimgll be replaced
with Whois Information

DNS Name Resolving

DNS is based on a hierarchical tree structure called the domain namespace. This
global namespace contains all possible domain names and is divided into logical parts
- domain zones (see the picture below). A domain zone is a part of the namespace that
contains the addresses of particular domains. Addresses are stored in a file on a
separate name server with authority for that zone. For example, when a browser tries
to access www.example.com , it gets the site's IP address from a server with authority
for the example.com zone. For more information about how DNS works, refer to the
respective documentation. You can find it in numerous sources on the Internet, for
example, Microsoft TechNet.

7 Domain hamespace

Root zone

example.com

www.example.com blog.example.com
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When you purchase a domain, a registrar gives you access to the settings for the DNS
zone responsible for your domain and its subdomains. You can either allow the

registrar to manage the zone, or delegate the zone to Panel. The latter option gives

you the ability to manage a zone directly from your customer account. For information
about how to delegate your zone to the Panel, refer to the section Panel as a Master DNS
Server(on page 70).

If you are an advanced user and already have a DNS server that you want to give
authority for your zone, you can set up Panel to be a slave (also called secondary)

DNS server. In this case, Panel just stores a copy of your zone and you do not have

the option to manage it from the Control Panel. The Panel DNS server will be used only
if your primary name server becomes inaccessible or inoperable. For information about
how to make Panel act as a secondary DNS server, refer to the section Panel as a Slave
DNS Serveon page 74).

If you decide not to use Panel as a DNS server, all zone management should be
performed on a domain registrar's site. Some registrars provide support for remote
DNS zone management. If your hosting provider uses this feature, you will still be able
to modify the DNS zone from the Control Panel regardless of where your authoritative
name server is located. For information about how to switch off the Panel's DNS server
and manage your zone remotely, refer to the section Registrar's DNS Settings in Pgoel
page 74).

Next in this section:

Panel S @ MASIEI DINS SO VT ....eue ettt eaaens 70
Panel @S @ SIAVE DINS SBIVET ..o e aaens 74
Registrar's DNS Settings in Panel ..o 74
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Panel as a Master DNS Server

For each new domain name, the Panel automatically creates a DNS zone in
accordance with the settings configured by your service provider. The domain hames
should work fine with the automatic configuration, however, if you need to perform
custom madifications in the domain hame zone, you can do that through your Panel.

U To view the resource records in a DNS zone of a domain:

1. Go to the Websites & Domainab and click the domain name whose DNS
settings you want to view.

2. Click DNS Settings

U To add a new resource recorth® zone:

1. Go to the Websites & Domainab and click the domain name whose DNS
settings you want to manage..

2. Click DNS Settings
3. Click Add Record

4. Select a resource record type, and specify the appropriate data:

A

For an NS record, which specifies the domain name of a name server that is
responsible for a DNS zone of a domain, you need to specify the domain name
(or a subdomain), and then the corresponding name server's domain name. If
you are defining an NS record for your main domain, then you should leave the
domain name field empty. If you are defining a name server for a subdomain,
then type the subdomain into the domain naméeld. After that, type the
appropriate name server's domain name into the name servelield. For example:
nsl.mynameserver.com.

For A and AAAA records, which associate IP addresses with domain names,
you need to specify the domain name and IP address. If you are simply defining
a record for your main domain, then you should leave the domain naméeld
empty. If you are defining a record for a name server, then type nsl or ns2 into
the domain naméeld. Then specify the appropriate IP address with which to
associate the domain name.

For a CNAME record, which specifies which subdomains (or domain aliases that
look like subdomains, for example, www) should be associated in the Domain
Name System with the main domain address, you need to type the subdomain
name or www alias, and then, the main domain name.

For an MX record, which specifies the host name of the preferred mail server for
the given domain, you need to specify the mail domain (or subdomain), the
domain name of the mail exchange server responsible for receiving e-mail, and
the server's priority. For the main domain, you would simply leave the available
field blank. Then type the domain name of your mail server. If you are running a
remote mail server named 'mail.myhostname.com’, then simply type
'mail.myhostname.com' into the Mail exchange servield. After that, specify its
priority: O is the highest and 50 is the lowest.
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4.

A For a PTR record, which is required for reverse DNS lookup (an IP address is
translated to domain name), you need to enter the IP address/mask, and then
type the appropriate domain name for this IP address to be translated to.

A For a TXT record, which is used for specifying arbitrary human-readable text,
you can type an arbitrary text string, or an SPF record.

A For an SRV record, which is used for specifying location of services other than
mail, you will need to enter the service name, protocol name, port number, and
target host. You can also specify the priority of the target host, and relative
weight (for records with the same priority) in the appropriate fields.

4. Click OK and then click Update

To modify the properties of a resource record:

Go to the Websites & Domainsb and click the domain name whose DNS
settings you want to manage.

Click DNS Settings

Click the hyperlink in the Hostcolumn corresponding to the resource
record you want to modify.

Modify the record as required, click OK and then click Update

In addition to the resource records described above, there is also a Start of Authority
record. This record indicates that this DNS name server is responsible for the domain's
DNS zone. It also contains settings that affect propagation of information about the
DNS zone in the Domain Name System.

To modify the entries in the Start of Authority (SOA) record for a domain:

Go to the Websites & Domairtab and click the domain name whose DNS
settings you want to manage.

Click DNS Settings
Click SOA Rcord

Specify the required values:

A Refresh intervalThis is how often the secondary name servers check with the
master name server to see if any changes have been made to the domain's
zone file. The Panel sets the default value of three hours.

A Retry inteval This is the time a secondary server waits before retrying a failed
zone transfer. This time is typically less than the refresh interval. The Panel sets
the default value of one hour.

A Expire intervalThis is the time before a secondary server stops responding to
gueries, after a lapsed refresh interval where the zone was not refreshed or
updated. The Panel sets the default value of one week.

A Minimum TT.LThis is the time a secondary server should cache a negative
response. The Panel sets the default value of three hours.

A Default TTLThis is the amount of time that other DNS servers should store the
record in a cache. The Panel sets the default value of one day.
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5. Click OK and then click Update

Usage of serial number format recommended by IETF and RIPE is mandatory for many
domains registered in some high-level DNS zones, mostly European ones. If your
domain is registered in one of these zones and your registrar refuses your SOA serial
number, using serial number format recommended by IETF and RIPE should resolve
this issue.

The Panel-managed servers use UNIX timestamp syntax for configuring DNS zones.
UNIX timestamp is the number of seconds since January 1, 1970 (Unix Epoch). The
32-bit timestamp will overflow by July 8, 2038.

RIPE recommends using YYYYMMDDNN format, where YYYY is year (four digits), MM
is month (two digits), DD is day of month (two digits) and NN is version per day (two
digits). The YYYYMMDDNN format will not overflow until the year 4294.

U To change the Start of Authority (SOA) semabauformat to
YYYYMMDDNN for a domain:

1. Go to the Websites & Domainab and click the domain name whose DNS
settings you want to manage.

2. Click DNS Settings
3. Click SOA Record

4. Select the Use serial number format recommended by IETF andHeiédbox.

Note: See the sample of SOA serial number generated with the selected format. If
the resulting number is less than the current zone number, the modification may
cause temporary malfunction of DNS for this domain. Zone updates may be
invisible to the Internet users for some time.

5. Click OK and then click Update

U To remove a resource record from the zone:

1. Go to the Websites & Domainab and click the domain name whose DNS
settings you want to manage.

Click DNS Settings
Select a checkbox corresponding to the record you want to remove.

Click Remove

o &~ DN

Confirm removal, click OK and then click Update
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To restore the original zone configuration in accordance with the default DNS
template settings used on the server:

1.

5.

Go to the Websites & Domairtab and click the domain name whose DNS
settings you want to manage.

Click DNS Settings
Click Restore Defaults

In the IP addressnenu, select the IP address to be used for restoring the
zone.

Specify whether a www alias is required for the domain.

Select the Confirm the restation of the DNS zonbheckbox, and click OK.

To restore the default Start of Authority (SOA) serial number format (UNIX
timestamp) for a domain:

Go to the Websites & Domairtab and click the domain name whose DNS
settings you want to manage.

Click DNSSettings
Click SOA Record

Clear the Use serial number format recommended by IETF and RIPE
checkbox.

Note: See the sample of SOA serial number generated with the selected format. If
the resulting number is less than the current zone number, the modification may
cause temporary malfunction of DNS for this domain. Zone updates may be
invisible to the Internet users for some time.

Click OK and then click Update

By default, transfer of DNS zones is allowed only for the name servers designated by
NS records contained within each zone. If you are using a Windows-based account,
then you can change zone transfer settings.

If your domain name registrar requires that you allow transfer for all zones
you serve:

. Go to the Websites & Domairtab and click the domain name whose DNS

settings you want to manage.
Click DNS Settings

Click Zone TransfersA screen will show all hosts to which DNS zone
transfers for all zones are allowed.

Specify the registrar's IP or network address and click Add Network
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Panel as a Sla¥@NS Server

If you host websites on your account and have a standalone DNS server acting as a
primary (master) name server for your sites, you may want to set up the Panel's DNS
server to function as a secondary (slave) name server.

U To make the Panel's DdE3ver act as a secondary hame server:

1. Go to the Websites & Domainab and click the domain name whose DNS
settings you want to manage.

Click DNS Settings

Click Switch DNS Service Mode

Click Add Record

Specify the IP address of the primary (master) DNS server.
Click OK and then click Update

N o g A~ DN

Repeat steps from 2 to 6 for each website that needs to have a
secondary name server on your server.

U To make the Panel's DNS server act as a primary back:

1. Go to the Websites & Domainab and click the domain name whose DNS
settings you want to manage.

2. Click DNS Settings

3. Click Switch DNS Service Mode
The original resource records for the zone will be restored.

Registrar's DNS Settings in Panel

If you have external primary and secondary name servers that are authoritative for
some of your websites, switch off the Panel's DNS service for each of these sites.

U To switch off the Panel's DNS service for a site served by external name
servers:

1. Go to the Websites & Domairtab and click the domain name whose DNS
settings you want to manage.

2. Click DNS Settings
3. Click Switch Off the DNS Service
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Turning the DNS service off for the zone will refresh the screen, so that only a list of
name servers remains. Note that the listed name server records have no effect on
the system. They are only presented on the screen as clickable links to give you a
chance to validate the configuration of the zone maintained on the external
authoritative name servers.

If you want to validate the configuration of a zone maintained on
authoritative name servers, do the following:

a. Add to the list the entries pointing to the appropriate name
servers that are authoritative for the zone: Click Add Record
specify a name server, click OK and then click Update

b. Repeat the step a for each name server you would like to test.
The records will appear in the list.

c. Click the records that you have just created.

The Panel will retrieve the zone file from remote name servers and will check the
resource records to make sure that domain's resources are properly resolved. The
results will be interpreted and displayed on the screen.

If your Control Panel is integrated with a billing system, then the following operations
on domains might be available from the Panel:

A

> >y > >

Setting a password for access to domain management panel at a registrar's site.
Locking and unlocking domain name for transferring to another provider.
Changing domain registrant and other contact information.

Changing DNS settings for domain zones served by a domain registrar.

Configure automatic renewal of the domain account at the domain name
registration company.

To set a new password for access to your domain management control
panel at a registrar's site:

Go to the Accounttab.

Locate the domain name for which you want to change settings, and
click the link Show Domain Infeext to it.

Click Change Domain Password.

Type a new password and click OK

To lock or unlock domain name for transferring to another provider:
Go to the Accounttab.

Locate the domain name for which you want to change settings, and
click the link Show Domain Infeext to it.

Click Change Registrar Lock Setting

To allow domain name transfer, clear the Lockcheckbox and click OK
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To change domain owner's contact, technical, administrative, or billing
information:

. Go to the Accounttab.

. Locate the domain name for which you want to change settings, and

click the link Show Domain Infeext to it.

3. Click Edit Contact Info

. Make the necessary changes and click OK

To change DNS settings for a domain:

1. Go to the Accounttab.

. Locate the domain name for which you want to change settings, and

click the link Show Domain Infeext to it.

. Click EditDNS Settings

. Specify the domain name servers that serve the DNS zone for your

website and IP address of the server where the website is hosted.

. If the DNS zone of your website is served by your domain name

registrar, then you can also specify other resource records that affect
how your website's services are accessible over the Internet.

. To save your changes, click OK

To configure automatic renewal of theao name:

. Go to the Accounttab.

. Locate the domain name for which you want to change settings, and

click the link Show Domain Infeext to it.

. Click Automatic Domain Renewal

. To allow auto renewal of the domain registration, select the Turn on auto

renewhcheckbox and click OK
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Hosting Settings

The websiteds hosti ng sWebdtds & Donaissl oftheav ai | abl e
Control Panel. All per-website hosting settings form the following groups:

A General.
Hosting type, security, scripting and statistics settings. See General Setting®n page
78).

A PHP.
PHP scripting language settings. See PHP Settingéon page 84).

A Web Server.
Web server settings (Apache (with nginx) or IIS). Web server type depends on
Panel version: Apache with nginx is used on Panel for Linux, and IIS on Panel for
Windows. See Apache Web Server Settings (on @pend IS Web Server Settings
page 92) correspondingly.
Note that in the 1IS web server settings you can configure basic website security
settings, such as anonymous access, ssl usage, and directory browsing.

On Windows, you can also set up custom ASP.NET settings in Websites & Domains
select a domain > ASP.NET SettingBor details, see ASP.NET Settings (WindoYes)
page 88).

Next in this section:

GENEIAl SEHINGS ...oeiiiiiii i e e e e e e e e e e e e e e e eaeaans 78
ViYL= S Yol ] 1 o IS =] 1] o L 83
WED SEIVEN SEEHNGS ..o 90



78 Websites and Daims

General Settings

To view a website's general hosting settings, click Hosting Settingbeside its name on
the Websites & Domainab. The general website hosting settings are divided into
groups:

Basic Settings

A

A

Domain namerhe domain name that you register with a domain registrar and will
use for this website.

Hosting typeThe hosting type (Website hosting-orwardingand No hostiny defines
the website behavior. By default, all webistes belong to the Website hostintype as
they are physically hosted on the server.

To change the hosting type, use the Changdink. To learn more about hosting types,
see Hosting Typegon page 79).

To suspend the website with all mailboxes and mailing lists hosted under the
website's domain name use the Suspendption.

Note: Other basic settings depend on the selected hosting type. See Hosting Types
(on page 79).

Website statusThe website status defines the site's accessibility in browsers and
available hosting services. Apart from working as usual, the site can be suspended
so it will not open in browsers, and even more, the hosting features of the site (such
as the mail service and DNS service) can be disabled. You should change the
status if you want the site to be temporarily unavailable, for example, for
maintenance purposes. See Website Statugn page 82).

Document rooDisplayed for domains with the Websitehosting type. See Website
Hosting(on page 80).

Preferred domaimisplayed for domains with the Websitehosting type. See Website
Hosting(on page 80).

Security Settings

A Enable SSL suppoBecure Sockets Layer encryption is generally used for
protecting transfer of sensitive data during online transactions on e-commerce
websites that run on dedicated IP addresses. SSL certificates that participate in
the encryption process are usually applied to a single domain name on a single
IP address, therefore, each site that needs SSL protection must be hosted on a
dedicated IP address. An exception to this is subdomains, which you can
protect with a wildcard certificate. Installing an SSL certificate on a web server
that hosts several websites with different domain names on a single IP address
is technically possible, however, it is not recommended: the encryption will be
provided, but users will get warning messages on attempt to connect to the
secure site. To allow SSL encryption for the website, select the Enable SSL
supportcheckbox.
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Web Scripting and Statistics

A Scripting languageSpecify programming and scripting languages you want the
website to support. For PHP, you can also select the custom PHP version and
handler type. More PHP settings are available on the PHPtab. To learn more
about PHP handlers and PHP configuration, see PHP Settingéon page 84).

A Microsoft FrontPage settinddicrosoft FrontPage is a popular website authoring
tool. To enable content creation and publishing through Microsoft FrontPage,
select the options Microsoft FrontPage suppavticrosoft FrontPage over SSL support
and Remote FrontPage authoring allowed

A Web statisticsSelect the web statistics software that you want to use for viewing
graphical reports and charts on website visitors. Also, select the corresponding
checkbox if you want to be able to access the statistical reports by visiting the
password-protected directory http://your - website/plesk -
stat/webstat

A Custom error document#/hen visitors coming to a site request pages that the
web server cannot find, the web server generates and displays a standard
HTML page with an error message. If you want to create your own error pages
and use them on the web server, select the Custom error documts checkbox.

A Additional write and modify permissig¢agailable only for Windows hosting). This
option is required if web applications on the site will be using a file-based
database (like Jet) located in the root of the httpdocs  directory. Note that
selecting this option will seriously compromise the website security.

Next in this section:
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Hosting Types

The hosting type defines the website's behavior. Panel supports three types of hosting:
Website hosting-orwardingand No hosting

Next in this section:
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Website Hosting

The Websitenosting means that a website is physically located on the server.

For the website hosting type you can specify:

A Document roofThe location of the directory where all files and subdirectories of the
site will be kept. You can use the default directory httpdocs  or specify another
directory.

A Preferred domaiypically, any website is available on two URLs: with the www
prefix (like in www.example.com ) and without it (like in example.com ). We
recommend that you always redirect visitors to one of these URLSs (typically to the
non-www version). For example, after you set the Preferred domain to the non-www
version (example.com ), site visitors will be redirected to this URL even if they
specify www.example.com in their browsers.

Panel uses the search engine friendly HTTP 301 code for such a redirection. This
allows preserving search engine rankings of your site (preferred domain). If you turn
off the redirection by choosing None search engines will treat both URL versions
(www and non-www) as URLSs of different sites. As a result, rankings will be split
between these URLSs.
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Forwarding

You can make one or more registered domain hames to point to the same physical
website, by using the domain name forwarding. This allows automatic redirection of
visitors from the URL they specify in a browser to a site with a different URL. For
example, visitors of the site www.example.com can be redirected to
www.somedomain.tld . There are two types of forwarding in Panel: the standard and
frame forwarding.

Standard Forwarding

With the Standard forwardingisers who have been redirected to another URL can see
the destination URL in the browser address bar.

Depending on how long you intend to use the redirection, you can select the type of

redirection i Moved permanently (code 301) or Moved temporarily (code 302). These

are HTTP response codes which Panel sends to browsers to perform the redirection.

From visitorsdé point of view, the response co
be simply redirected to the destination URL. For search engines, the code defines how

they should treat the redirected site and affects search engine rankings.

A Moved permanently (code 301)
Use this redirection type if you want to keep search engine rankings of your site
after moving it permanently to another address.
For example, if examplel.com has been moved permanently to the domain
example 2.com , the rankings will not be split between examplel.com and
example2.com i search engine crawlers will treat them as a single website.

A Moved temporarily (code 302)

Use this redirection type when the destination domain is used temporarily, for
example, when you are testing a new version of your site with real visitors while
keeping the old version intact. If you set this redirection for a newly created
destination domain, this domain will not be indexed by search engines.

Frame Forwarding

With the Frameorwarding when visitors are redirected to another site, the address bar
of their browsers continues to show the source URL. Thus, visitors remain unaware of
the redirection. This is called frame forwarding as the index page of the source site
contains a frame with the destination site.

Domains Without Web Hosting

You can switch off web service and use only email services under that domain
(Websites & Domaiab > domain name > the Changdink > the No web hostingption).
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Website Status

The website status defines whether a website is available over the Internet and what
hosting services are provided for it. The hosting provider may need to change the
status of a site if the client does not pay for the services. Site owners can change the
status of their sites if they want the sites to be temporarily unavailable.

Panel supports three website statuses: SuspendedDisabledand Active

Suspended Sites

If you want to shut down a site for maintenance and let your visitors know that it is
temporarily unavailable, you can suspend the website so that it will not open in
browsers (Websites & Domainsdomain name > the Suspendink). Visitors will be
redirected with the search engine friendly 503 HTTP code (Service Unavailable) to the
"503 Service Unavailable" error page. The site's search engine rankings will not be
affected, and the hosting services such as mail will still be available and manageable
by means of Panel.

You can customize the error page using the link Edit maintenance error paigeControl
Panel> Websites & Domainsdomain name.

Note: The link Edit maintenance error pagalisplayed only if your hosting plan provides
the option to customize web server error documents (the Custom error documenitsOnin
the domain settings in Websites & Domairsdomain name > Edit)

Disabled Sites

If you stop supporting a website, you can disable it using Websites & Domairsdomain
name > the Disabldink. Visitors will see the web server's default page set by the
hosting provider, and the site's search engine rankings will drop.

Disabled websites stop being hosted on the server: They are excluded from the web
server configuration. However, the physical directories and files of disabled sites can
be accessed by FTP clients and File Manager. The hosting services such as mail will
be unavailable.

Note: In Panel versions earlier than 11.5 this status was called Suspended

Active sites

To bring the website back online, use Websites & Domaimrsdomain name > the Activate
link. The website will start working as usual.
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Web Scripting Settings

For each website in your subscription you can specify which of the following
programming and scripting languages should be supported by the web server: Active
Server Pages (ASP), Microsoft ASP.NET, Server Side Includes (SSI), PHP hypertext
preprocessor (PHP), Common Gateway Interface (CGl), Fast Common Gateway
Interface (FastCGl), Perl and Python. Since Panel 10.4, you are able to configure PHP
settings individually for each website (or subdomain) in your subscription. This is
possible only if your subscription has the corresponding permissions. To get the details
about custom PHP configuration, refer to the section PHP Settings

Next in this section:
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PHP Settings

PHP is one of the most popular scripting languages for creating dynamic web pages.
The majority of today's websites and web applications are based on PHP scripts. This
is why site administrators should clearly understand how they can control the execution
of PHP scripts.

How PHP scripts are executed for a certain website is fully defined by two aspects:
PHP handler and PHP settings for the site. You can set up these parameters for a
certain website in the Control Panel as described below.

PHP Handler

When a visitor accesses a site based on PHP scripts, a web server interprets site
scripts to generate a page that will be shown to the visitor. PHP handler calls PHP
libraries needed for this interpretation. You can choose from a number of PHP
handlers: ISAPI (Windows), Apache module (Linux), FastCGI, CGI, or PHP-FPM
(Linux). The decision on what PHP handler to choose should depend on a number of
factors like security considerations, script execution speed, and memory consumption.

U To choose a PHP handler for your website:
1. Go to Websites & Domains

2. Click Hosting Settingsear the domain name of a website for which you
want to choose the PHP handler.

3. Choose one of the following PHP handlers as the value of the Run PHP
as parameter (beside the PHP supporbption):

Run PHP as | Performance Memory | Security
Usage
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Apache

module(Linux

only)

High.

Runs as a part of
the Apache web
server.

Low

This handler (also known as mod_php)
is the least secure option as all PHP
scripts are executed on behalf of the
apache user. This means that all files
created by PHP scripts of any plan
subscriber have the same owner
(apache ) and the same permission
set. Thus, a user has a theoretical
possibility to affect files of another user
or some important system files.

Note: You can evade some
security issues by turning the PHP
safe_maode option on. It disables a
number of PHP functions that bring
potential security risk. Note that this
may lead to inoperability of some
web apps. The safe_mode option is
considered to be obsolete and is
deprecated in PHP 5.3.

ISAPI
extension
(Windows
only, not
supported
since PHP
5.3)

High.

Runs as a part of
the IIS web server.

Low

The ISAPI extension can provide site
isolation in case a dedicated IIS
application pool is switched on for
subscriptions. Site isolation means that
sites of different customers run their
scripts independently. Thus, an error in
one PHP script does not affect the
work of other scripts. In addition, PHP
scripts run on behalf of a system user
associated with a hosting account.

Note: The ISAPI extension handler
is not supported since PHP 5.3.

Cail
application

Low.

Creates a new
process for each
request and closes it
once the request is
processed.

Low

The CGI handler provides PHP script
execution on behalf of a system user
associated with a hosting account. On
Linux, this behavior is possible only
when the sSUEXEC module of the
Apache web server is on (default
option). Otherwise, all PHP scripts are
executed on behalf of the apache
user.

We recommend that you use the CGI
handler only as a fall-back.

FastCGl
application

High (close to
Apache module and
ISAPI extension).

Keeps the
processes running
to handle further
incoming requests.

High

The FastCGI handler runs PHP scripts
on behalf of a system user associated
with a hosting account.
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PHPRFPM High Low The PHP-FPM is an advanced version
P of FastCGI which offers significant
?If)iﬁt():(acglr?lg) benefits for highly loaded web

applications.

The PHP-FPM handler is available
only if it was installed by hosting
provider and if the option Process PHP
bynginik n t he website
turned on (Websites & Domainsselect
a domain > Web Servetab).

Note: Switching PHP from Apache modulte FastCGl applicatianay break functionality
of existing PHP scripts. Switching to PHRFPMby selecting Process PHP by ngiimxthe
websitebs web server settings may do t he same

PHP Version

Panel supports different versions of PHP. For each handler, one or more PHP versions
can be available. The list of available versions is defined by your hosting provider and
available to you in the same location where you select the PHP handler: Websites &
Domaingab > <domain_name> Edit

Note: Always use PHP 5.x except the cases when you need PHP 4.x to host some old
PHP apps.

PHP Settings

PHP behavior is defined by a number of configuration settings. These settings specify
various script execution aspects, like performance (for example, the amount of memory
a script can use), security (for example, access to file system and services), and so on.
You may adjust these settings for a number of reasons:

A Preventing a memory leak or server hang-up by poorly written scripts.
A Protecting data from malicious scripts.
A Meeting the requirements of a certain web app.

A Testing own scripts and other.

PHP settings are located in the Control Panel, Websites & Domainsselect a website >
PHP Settingg~or convenience, all PHP settings are divided into two groups:

A Performance settings
These settings define how scripts work with system resources. For example: Use
the memory_limit  parameter to limit the amount of memory for a script to prevent
a memory leak. In addition, you can prevent scripts from tying up the server by
limiting the maximum time scripts are allowed to run using max_execution_time

A Common settings
This group contains other commonly used PHP settings. Generally, these are:
Security settings (for example, the PHP safe mode toggle or the permission to
register global variables), error reporting settings (for example, the directive to log
errors), and others.



Websites and Domains 87

You can set the value of each parameter in PHP Settingsither by selecting a value from
a preset, typing a custom value, or leaving the Defaultvalue. In the latter case, Panel
uses the values defined by the server-wide php.ini file. For information about certain
PHP settings, refer to the respective documentation. For example,
http://php.net/manual/en/ini.list.php.

It is possible to use three placeholders in parameter values:

A {DOCROOT}or the document root directory of a domain that gets custom PHP
configuration.
A {WEBSPACEROOTpr the root directory of a subscription (webspace).

A {TMP} for the directory which stores temporary files.

Note: Default values of PHP settings in Panel differ from the ones suggested by the
official PHP documentation at http://php.net/manual/en/ini.list.php.

Note: Custom PHP configuration of a website acts as a preset for all subdomains of
this site. You can perform further per-subdomain PHP configuration in the same way as
for the websites.
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ASP.NET Settings (Windows)

i

1.

To configure ASP.NET Settings for a site:

If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription
menu at the top of the screen, select the required webspace.

Go to the Websites & Domainab and click your website's domain name.
Click ASP.NET Settings

Set up the strings that determine database connection data for
ASP.NET applications that use databases. This option is available only
for ASP.NET 2.0.x.

When you open the ASP.NET configuration screen for the first time, sample
connection parameters with common constructions are displayed. You can
delete them and specify your own strings.

A To add a string, enter the required data into the Nameand Connection Parameters
input fields and click @ next to them.
A To remove a string, click (=] next to it.

Set up custom error messages that will be returned by ASP.NET
applications in the Custom Error Settingeeld:

A To set the custom error messages mode, select an appropriate option from the
Custom error mod@aenu:

A On- custom error messages are enabled.

A Off- custom error messages are disabled and detailed errors are to be
shown.

A RemoteOnly custom error messages are displayed only to remote clients,
and ASP.NET errors are shown to the local host users.

A To add a new custom error message (which will be applied unless the Offmode
was selected), enter the values in the Status Codand Redirect URfields, and
click &.

A Status Codeefines the HTTP status code resulting in redirection to the error
page.

A Redirect URHefines the web address of the error page presenting
information about the error to the client.

Due to possible conflicts, you cannot add a new custom error message with an
error code that already exists, but you can redefine the URL for the existing
code.

A To remove a custom error message from the list, click @ next to it.
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6. Configure compilation settings in the Compilation and Debuggifigld:

A To determine the programming language to be used as default in dynamic
compilation files, choose an entry from Default web page langudi.

A To enable compiling retail binaries, leave the Switch on deuggingcheckbox
empty.

A To enable compiling debug binaries, select the Switch on debuggincheckbox. In
this case, the source code fragments containing error will be shown in a
diagnostic page message.

Note. When running applications in debug mode, a memory and/or performance
overhead occurs. It is recommended to use debugging when testing an application
and to disable it before deploying the application into production scenario.

7. Configure encoding settings for ASP.NET applications in the Globalization
Setings section:

A To set an adopted encoding of all incoming requests, enter an encoding value
into the Request encodinfield (default is utf-8).

A To set an adopted encoding of all responses, enter an encoding value into the
Response encodirfgeld (default is utf-8).

A To set an encoding which must be used by default for parsing of .aspx , .asmx ,
and .asax files, enter an encoding value into the File encodingield (default is
Windows-1252).

A To set a culture which must be used by default for processing incoming web
requests, select an appropriate item from the Culturelist.

A To set a culture which must be used by default when processing searches for a
locale-dependent resource, select an appropriate item from the Ul Culturdist.

8. Set a code access security trust level for ASP.NET applications in the
Code Access Securitield.

CAS trust level is a security zone to which applications execution is assigned,
defining what server resources the applications will have access to.

Important: When an assembly is assigned a trust level that is too low, it does not
function correctly. For more information on the permissions levels see
http://msdn.microsoft.com/library/en-
us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429 010.

9. Enable the usage of the auxiliary scripts in the Script Library Settingseld.
Specifying the script library settings is necessary if the validation web
controls are used on your web site. This option is available only for
ASP.NET 1.1.x.

A If you need to use auxiliary scripts (specifically, scripts implementing objects for
validating input data), provide the settings for .NET framework script library. To
do so, enter the path beginning with the domain root directory preceded by the
forward slash into the Path to Microsoft script librdigld, or click the folder icon
next to the Path to Microsoft script librdiigld and browse for the required location.

A Toinitiate the auto-installation of files containing the scripts to the specified
location, select the Installcheckbox. If the files already exist there, they will be
rewritten.
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10.Set client session parameters in the Session Settingeld:

A To set up the default authentication mode for applications, select an appropriate
item from the Authentication modeést. Windowsauthentication mode should be
selected if any form of IIS authentication is used.

A To set up time that a session can remain idle, type the number of minutes into
the Session timeouiox.

11.Click OKto apply all changes.

Web Server Settings

Web server type depends on Panel version: Apache (with nginx) is used on Panel for
Linux, and IIS on Panel for Windows. Depending on your Panel version, refer to Apache
Web Server Settingsn page 90) or [IS Web Server Settin@s page 92).

Next in this section:
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Apache Web Server Settings

Panel uses the Apache web server (http://en.wikipedia.org/wiki/Apache HTTP_Server)

to deliver the pages of your website to clients (such as browsers through which visitors

access your website). By default, to achieve better performance, Apache is

supplemented with another web server - nginx. For details about how Apache is

integrated with nginx in Panel, see Apache withngink n t he Admi ni strator6s

Default web server settings are specified by the server administrator (hosting provider).
For example, these settings can determine how web servers process different types of
files, how they use SSL, where they store log files, and so on.

However, you (as a website owner) can set up custom web server settings for your
website. For example, add a new type of the index file, restrict access to the site, and
S0 on.

Note: You can adjust web server settings for your websites only if your hosting
subscription provides the corresponding permission.

Next in this section:

Adjusting Apache Web Server SettingS ..o 91
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Adjusting Apache Web Server Settings

All customizable web server settings are located on the Websites & Domains
<domain_name>Web Server Settingmge. Custom settings work only for the selected
website. The settings are divided into two groups:

A Common Apache settings

These settings are typically changed by site owners, who may want to add a new
type of index files (Index filey or a MIME type for files with a certain extension (MIME
typeg, to restrict access to the site (Deny access to the sit®r specify Apache
handlers for a certain file type (Handlerk

A nginx settings

These settings define how the processing of web requests is divided between the
Apache and nginx web servers to achieve better performance for a specific site.

Important: nginx settings are for advanced users only. To learn more about nginx
settings, see Adjusting nginx Settings for Virtlidstsi n t he Admi ni strator 6

A Smart static files processing

Caution: Turn off this option only to troubleshoot nginx related issues.

Turning this option off will limit the role of nginx: It will only pass requests and
responses without modification. Except for troubleshooting the nginx related
issues, we recommend that you leave this option turned on.

A Serve static files directly by nginx

For sites with a lot of static content (like image or video files) and high load,
better performance can be achieved by delegating serving static files to nginx.
Apache will not take any part in processing the requests for the files with the
specified extensions.

For example, to exclude Apache from delivering jpg and gif files, you should turn
on the option Serve sitic files directly by ngirand specify file extensions like this

gif jpg
or
gifljpg
Caution: Because requests for static files never reach Apache, they do not

pass through Apache handlers. This means, for example, that rewrite rules
or .htaccess directives will not be applied.

A Process PHP by nginx

When the Process PHP by ngioption is on, Apache does not take any part in
processing the requests for PHP files. All requests for PHP files are processed
by nginx using the PHP-FPM handler. The handlers used by Apache are not
available on nginx. The PHP-FPM is an advanced version of FastCGI which
offers significant benefits for highly loaded web applications. To learn more
about PHP-FPM, see http://php-fpm.org/about/.

Caution: Because requests for PHP files do not reach Apache they do not pass
through its handlers (CGl, FastCGl, or an Apache module), so some web
apps may not work as expected.
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Note that subdomains have their own web server settings, therefore, when you change
web server settings for a site that has subdomains, the subdomains will not receive
these changes.

If you do not find the necessary setting, contact your server administrator (hosting
provider), who can set up more custom settings for websites.

The Default Value of Server Settings

You can set the value of each parameter either by typing a custom value, or leaving the
Defaultvalue. In the latter case, Panel uses the values from the default web server
configuration defined by the server administrator (hosting provider).

Your values override the default ones. The only exception is the Deny access to the
site setting - IP addresses from the default configuration, as well as the IP addresses
specified by you, will all be applied to your website. In case of a conflict (for example,
when you allow the IP address that is denied in the default configuration), Apache uses
your settings.

IS Web Server Settings

Panel uses the IIS web server

(http://en.wikipedia.org/wiki/Internet Information _Services) to deliver the pages of your
website to clients (such as browsers through which visitors access your website). The
behavior of 1IS is defined by variety of settings.

Default web server settings are specified by the server administrator (hosting provider).
For example, these settings can determine how IIS process different types of files, how
it uses SSL, and so on.

However, you (as a website owner) can set up custom web server settings for your
website. For example, add a new type of the index file, restrict access to the site, and
S0 on.

Note: You can adjust web server settings for your websites only if your hosting
subscription provides the corresponding permission.

Next in this section

Adjusting IS Web Server Settings. ... 93
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Adjusting IS Web Server Settings

All customizable web server settings are located in Websites & Domainsselect a
website > Web Server SettingSustom settings work only for the selected website. The
settings are divided into groups:

Common Settings

These settings are typically changed by site owners, who may want to:

A Allow site visitors to view the |listing of f
in their browsers (Directory browsirjg The directory listing will be displayed if there
are no matches for default index pages in th

A Add a new type of default index pages (Default documenits
A Add a new MIME type for files with a certain extension (MIME typés

Directory Security Settings

These settings allow site owners to:

A Restrict access to the site by username and password i only system users will be
able to access the site (Anonymous acce}sDenying anonymous access may be
useful if your site is not intended for any visitor, for example, it is a web application
for internal use. Note that FTP users and additional FTP users created in Panel will
have access to such a site if they were gran

A Force all clients (such as browsers or FTP clients) to use the secure HTTPS
protocol to access their site (Require SSLYou need this option, for example, if the
site contains and transmits personal information.

Access Restriction Settings

These settings allow site owners to restrict access to the site by IP address of the
visitor (Deny access to the sitey denting and allowing access from certain IP
addresses.

Note: Subdomains have their own web server settings, therefore, when you change
web server settings for a site that has subdomains, the subdomains will not receive
these changes.

If you do not find the necessary setting, contact your server administrator (hosting
provider), who can set up more custom settings for websites.
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The Default Value of Servengetti

You can set the value of each parameter either by typing a custom value, or leaving the
Defaultvalue. In the latter case, Panel uses the values from the default web server
configuration defined by the server administrator (hosting provider).

Your values override the default ones. The only exception is the Deny access to the site
setting - IP addresses from the default configuration, as well as the IP addresses
specified by you, will all be applied to your website. In case of a conflict (for example,
when you allow the IP address that is denied in the default configuration), 1IS uses your

settings.
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Website Content

To create your website and fill it with the content you need (text, images, videos, and
so on), use one of the methods provided by the Panel:

A Using website creation and management tools. If you do not have a website yet,
consider setting one up by yourself with a tool for creating, editing, and publishing
websites. You can do this even if you do not possess the necessary web
programming and design skills. The best tools of this sort are the following:

A Presence Builder - a website editor integrated with the Control Panel.

A Third-party Content Management Systems (CMS) - web applications for creating
and editing websites.

A Uploading existing websites to your hosting account using one the following
methods:

A FTP client program. You can obtain a free FTP client from the Internet, or, if you
are using Windows, use Windows Explorer. This enables you to access your
directory on the hosting server and manage your files. If you collaborate with
other people when managing your website (such as programmers or designers),
you can provide them with access to your directory using FTP to let them edit
the website by themselves.

A File Manager. A tool for uploading and managing website files and directories
through the Panel web interface.

Note:if you have a website created in Microsoft FrontPage editor, refer to the section
Working with Microsoft Frontpage Websites (Windowggage 131) for details on
managing this site in Panel.

Below you will find detailed descriptions of the ways to manage your content.

Presence Builder

Presence Builder is a great tool that enables users with no knowledge of HTML markup
or graphic design skills to create professional-looking sites. Just pick a suitable page
design and content template, add your text to the pages, and publish the site.

You can create and publish websites using Presence Builder if your hosting
subscription provides this option. If it does not, or if you have already created and
published the allowed number of sites, you still can create a new website with
Presence Builder and edit it. However, to publish this website, you will need to upgrade
your hosting plan.

To start creating a website using Presence Builder or edit an existing Presence Builder
site, go the Websites & Domainab, click you domain name, and click Launch Presence
Builder Find more information on creating and editing websites in Presence Builder in
the chapter Building Webggs with Parallels Presence Builder
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ThirdParty Content Management Systems

To create and maintain a website, you can use third-party Content Management
Systems (CMS) - web applications that let you easily edit a website's structure and
content with a graphical user interface. Examples of such systems are Drupal and
Joomla.

CMS are usually server applications, so to start using one of them you should install it
on your hosting account. Hence, if you plan to use a CMS, ensure that your hosting
subscription allows such applications to be installed.

U To create a website using a CMS:
1. Go to the Applicationgab.

2. Find the CMS you need in the list of available applications, and install it
as described in the section Employing Website Applications (on pHof.

3. Create and edit your website in the CMS. For information on how to
create websites with your CMS, refer to the relevant documentation.

Uploading Using FTP

If you already have all your website files and directories, consider uploading them to
your hosting account using FTP. This is the quickest way for simple uploading of files
when you do not need to edit or manage them on the server.

U To upload files using FTP:

1. Connect to your site's domain name with an FTP client program using
your FTP access credentials. Learn how to configure these credentials
in the section Adding FTP Accoun{sn page 209).

2. Copy the website files and directories to your directory on the server.
File Manager

Another way to publish a website created outside the Panel is File Manager - a tool that
provides a set of file management functions through the web interface. File Manager is
located on the Filestab of the Control Panel.

To upload a website from your computer to Panel server with File Manager, open the
Filestab of the Control Panel and drag the website folder to the central area of this tab.
If your website is compressed to a ZIP file, you can upload this file to the server and
then extract it by clicking Extract Filesn the Moremenu.
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If you want to edit pages of your website, you can do it in File Manager. It provides an
HTML editor that allows visual editing of HTML pages (without needing to manually
type HTML tags). To edit a file in the HTML editor, place the mouse pointer over the

file, click the link '# to open the file's context menu, and select Edit in HTML Editor

You can also edit files in File Manager's text editor if you like. To open a file in the text
editor, open the file's context menu and select the Edit in Text Editor

If you have files or web pages that you want to make inaccessible on the Internet,
change these files' access permissions in File Manager. To edit access permissions for

a file or a directory, click the corresponding link in the Permissiongolumn. To learn how
to review and edit the permissions, refer to the sections Setting File and Directory Access
Permissiongon page 98).

Next in this section:

Setting File and Directory Access PermisSions...........c.uueeeiiieeiiiieiiiiiiinieeeeeeeenens 98
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Setting File and Directory Access Permissions

U To review or change the permissions set for files and directories on Linux
systems:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscriptiormenu at the top of the screen.

2. Go to the Filestab.

The permissions set for files and directories are shown in the Permissiongolumn.
They are represented as three sets of symbols, for example, 'rwx rwx r--". The first
set tells what the owner of the file or directory can do with it; the second tells what
the user group, the file or directory belongs to, can do with the file or directory; the
third set indicates what other users (the rest of the world, that is, Internet users
visiting a site) can do with the file or directory. R means the permission to read the
file or directory, W means the permission to write to the file or directory, and X
means the permission to execute the file or look inside the directory.

3. Locate the file or directory for which you want to modify permissions
and click a hyperlink in the Permissiongolumn.

4. Modify the permissions as desired and click OK

U To set access permisss for a file or directory on Windows systems:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription
menu at the top of the screen, select the required webspace.

2. Go to the Filestab.

3. Locate the file or directory for which you want to set access
permissions, and click the corresponding icon @,

4. Do the following:

A To make the file or folder inherit permissions from a parent folder (if it does not),
select the checkbox Allow inheritable permissions from the parent to propagate to this
object and all child objects. Include these with entries explicitly defined here

A To make the files and folders, which are contained in this folder, inherit the
folder permissions you define, select the checkbox Replace permission entries on
all child objects with entries shown here that apply to child objects

A To change or remove permissions from a group or a user, click the required
name in the Group or user namdist. If the group or user is not listed in the Group
or user namesst, select the required user or group name from the menu located

above the list and click &: the user/group appears in the list. Select it.
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A

To allow or deny permissions to a selected group/user, select the Allowor Deny
checkboxes corresponding to permissions listed under Permissions foxuser/group
namez>If the checkboxes in the Allowor Denycolumns are shown in grey, it
means that the corresponding permissions are inherited from a parent folder.

To deny the permissions, which are inherited from a parent object as allowed,
select the required checkboxes under Deny This will override inherited
permissions for this file/folder.

To allow the permissions, which are inherited from a parent object as denied,

clear the Allow inheritable permissions from the parent to propagate to this object and all
child objects. Include these with entries explicitlyetefierecheckbox: this removes

the inherited permissions. Then select the required checkboxes under Allowand

Deny

To remove access permissions from a group or user, select the required name
in the Group or user namdist and click the icon @ nextto it.

5. If you need advanced fine-tuning of permissions, click the Advanced
button, and do the following:

A

A

To create a permission entry for a group or user, select the required name from
the Group or usemamedlist and click ‘o,

To set or change file/folder permissions for a group or user, select the required
name from the Group or user naméist, select the required Allowand Deny
checkboxes corresponding to permissions listed under Permissions foxuser/group
name>

To remove a permission entry for a group or user, select the required name from
the Group or user namdist and click @.

To make child objects of a folder inherit its permissions defined under
Permissions foxuser/group nameselect the Replace permission entries on all child
objects with entries shown here that apply to child olgkeetkbox, and select
checkboxes in the Apply tolist which correspond to the objects that must inherit
the permissions.

6. Click OK
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(Advanced) Restricting Access to Content

If you have directories in a site that only authorized users should see, restrict access to
these directories with password protection.

o~ DN

To protect a directory in your site with a password and to specify
authorized users:
If you are subscribed to several hosting packages and have access to

several webspaces associated with your account, in the Subscription
menu at the top of the screen, select the required webspace.

Go to the Websites & Domairtab and click the site's domain name.
Click Passworeprotected Directories
Click Add Protected Directory

In the Directory naméox, specify the path to the directory that you want
to protect with a password.

This can be any directory existing in the site, for example: /private . If the
directory that you would like to protect has not yet been created, specify the path
and the directory name i the Panel will create it for you.

If you are using a Linux-based account, you can also protect your CGlI
scripts stored in the cgi - bin directory. To do this, leave '/' in the
Directory nambox and select the cgibin checkbox.

. In the Title of the protected arbax, type a resource description or a

welcoming message that your users will see when they visit the
protected area.

. Click OK The directory you specified will be protected.

. To add authorized users, click Add New User

10.Specify the username and password that will be used for accessing the

protected area. The password should be from 5 to 14 symbols in length.
Click OK

To add an authorized user of a protected directory:

If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Suoscription
menu at the top of the screen, select the required webspace.

Go to the Websites & Domairtab and click the site's domain name.
Click Passworeprotected Directories

Click on the name of the directory you need.



Websites and Domains 101

. Click the Add New Usacon.

. Specify the username and password that will be used for accessing the
protected area. The password should be from 5 to 14 symbols in length.

. Click OK

To change password for an authorized user of a protected directory:

. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription
menu at the top of the screen, select the required webspace.

. Go to the Websites & Domainab and click the site's domain name.

. Click Passworeprotectedirectories

. Click on the name of the directory you need. A list of authorized users
will open.

.Click on the userdés name.

. Specify the new password and re-type it for confirmation.

. Click OK

To revoke a permission to access the protected directory fr@m a us

. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription
menu at the top of the screen, select the required webspace.

. Go to the Websites & Domairtab and click the site's domain name.

. Click Passworeprotected Directories

. Click on the name of the directory you need. A list of authorized users
will open.

.Sel ect a checkbox corresponding to the

. Click Remove Confirm the operation and click OK

To remove passwab protection and make the resource available to the
public:

. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription
menu at the top of the screen, select the required webspace.

. Go to the Websites & Domairtab and click the site's domain name.

. Click Passworeprotected Directories

. Select a checkbox corresponding to the name of the directory, from
which you want to remove protection.



102 Websites and Domains

5. Click Remove Protectiohe protection will be removed and the contents
of the directory will be accessible to the public without restrictions.

Previewing Websites

After you purchase a domain, its registration can require some time. The reason for the
delay is that name servers update their zone information periodically. Thus, until all
name servers have received information about your zone, you will not be able to
access your site by its domain name. Nevertheless, you can always access your site
during domain name propagation using the Previev button on the Websites & Domains
tab.

During domain name propagation other people can access your site too. For this
purpose, Panel registers your website as a subdomain of one of the provider's sites.
For example, if your website is my-domain.tld and a provider has configured the
preview service on provider-domain.tld, you can access your site on my-
domain.tld.192-0-2-12.provider-domain.tld. Here 192-0-2-12 is the site's IP address
where dots are replaced with dashes.

Notes:

The contents of password-protected directories might be inaccessible in the Preview
mode.

If you do not have the site preview button on the Websites & Domaipsge, contact your
hosting provider.
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Web Applications

You can significantly increase your website functionality by using different web apps.
Apps installed on a website can perform a number of tasks. If you are an individual,
you can, for example, present yourself with a blog or organize an online storage of your
media files. Companies can move their business online using the e-commerce or CRM
web apps. All these apps are available for installation from the Applicationgab of the
Control Panel.

The list of available apps is governed by your hosting plan. For example, it might
include only free apps or no apps at all. For more information on available apps,
contact your hosting provider.

App Types

There are two types of web apps:

A Apps installed directly on your website (for example, the WordPress blogging
platform or the Joomla! content management system).

A Apps installed on external servers and provided by third-parties.

Regardless of the installation type, apps can be either free or commercial. Commercial
apps require you to obtain a license key to start working with them. You can recognize
commercial apps in the catalog on the Applicationtab by the button Buy now(instead of
Installfor free apps). If you decide to use commercial apps, read the Managing
Commercial App Licensémn page 108) section to learn more about acquiring and
managing app licenses.

App Installation and Maintenance

The process of installation is fully automated and does not require any specific skills.
To learn how to install web apps from the Control Panel, refer to the section Installing
Apps(on page 105).

Further app management is also facilitated as you can update or remove apps directly
in Panel. Moreover, you can access some functions that apps reveal to the Control
Panel (without the need to log in to an app). For example, you can add SugarCRM user
account right from your Control Panel. Such app functionality is a service provided by
the app.

After you install an app, grant other auxiliary user accounts access to it if you want
them to be able to use the app. To get started with managing apps, see the section
Managing App&n page 106).
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App Databases

If an app requires a database, Panel creates it automatically during installation of the
app. To create a database, Panel uses app database settings, which you can change
in the Main configuratiosection (Show All Settingknk) when installing an app:

A A database name and a database server where the app will store the database.

A Database user credentials, which Panel will use to access the app database. It may
be convenient to employ a single database user with access to all databases. In
this case, you can create a universal user account and specify it when installing
apps. To learn more, refer to the section Managing Database User Accoljotspage
235).

Note that if you exceed the maximum number of databases allowed for your
subscription, a new app does not create a new database. Instead, it adds tables to one
of the existing databases, and adds prefixes to table names. Prefixes make it easier to
distinguish tables of different apps from each other. For example, the Wordpress app
wi |l | awpesstoherfefi x to the names of its tables.

Access to Apps

By default, after you install an app, it is available only for users with the Ownerrole. You
can make your apps available to certain auxiliary users by adjusting their permissions.
For details on setting up access to apps for auxiliary users, refer to the section Granting
Auxiliary Users Access to Apfm page 106).

Apps and Auxiliaised Accounts

Some apps let you create and manage user accounts directly in Panel. For example,
the SugarCRM app allows you to add SugarCRM users without logging in to the app.
All apps with such "account services" can associate their accounts with users of a
Panel subscription (auxiliary users). To perform such an association, you should grant
the auxiliary users access to that account service (in the same way as you grant
access to apps). For details on account association, refer to the section Linking App
and Auxiliary (on pad®7jUser Accounts

Next in this section:
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Installing Apps

Depending on your needs and expertise level, you can choose one of the following
ways to install an app:

A

Quick. This is the easiest way to install an app. If you choose this way, Panel will
perform a typical installation of the latest app version of the selected app, Panel will
use the default values for the app settings. For example, your Panel access
credentials will be used as the app administrator's credentials.

Note: Some apps require you to fill in certain settings even if you select the quick
installation.

Custom. This way allows you to customize app installation settings such as
administrator credentials and location, installation path, and other. Particularly, you
should use custom installation if you want to switch off automatic upgrades of the

app.

To install an app:
Go to the Applicationgab and find the app you need.

Click either the Installbutton for the quick installation or the Install
(Custom)or the custom installation.

(Optional) Turn off automatic upgrades of the app.

If you do not want the app to be updated automatically, deselect the option
Automatically update this app when updates are avaitathle installation settings page.

(Optional) Select the app version.

Sometimes, you may need to install a specific version of an app. For example, if
you plan to use app extensions that are incompatible with the latest app version. In
this case, click the app name > Select another versida select the version you need.
Then install the app.

Note: For commercial apps, you should obtain a license key by clicking Buy nowbefore
starting the installation. To learn more about using commercial apps refer to the section
Managing Commercial App Licen@aspage 108).
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Managing Apps

Generally, all apps allow the configuration of their main parameters directly in the
Control Panel. You can access app settings by selecting the app from the list in
Applications> Manage My Applicatiarsfter you select an app, you can configure the
following:

A General settings.
These are basic settings (for example, the app administrator password) that can be
changed with Change Settings

A Service settings.
If an app provides a part of its functionality to Panel by means of services, you have
the option to configure them. For example, the SugarCRM app allows the creation
of user accounts and provides this ability as a service in the Control Panel. After
you select this service in Provided serviceyou can view all app user accounts and
create new ones.
For some apps, you can associate the app accounts with auxiliary user accounts.
Learn more about account association in the section Linking App and Auxiliary (on
pagelOjUser Accounts

Granting Auxiliary Users@ess to Apps

By default, after you install an app, only users with the Ownerrole can access it. To
allow other subscription users to access the app:

A Grant permission to access the app to a certain user group in Users> User Roles
A Be sure to add users of your choice to the group.

Once you allow users to access the app, a link to the app appears on their Websites &
Domaingpage under the name of the corresponding website. Note that you can control
app access only for user groups, so you should either modify the permissions of an
existing group or create a new one, and then assign users to it.

By default, the app administrator is a subscription user with the Ownerrole. As well as
accessing the apps from the Websites & Domaipsge, this user can also install and
manage apps within a subscription. For these purposes, their interface has the
additional Applicationdab. You can provide the same administrative privileges to other
subscription users by granting the Install and manage applicatiggegsmission to their role
in Users > User Roleshis gives users full administrative access to all apps within a
subscription. As well as the administrator, the users with this permission can install,
configure, update, and remove apps through the Applicationdab in their Control Panel.
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Linking Apps and Auxiliary User Accounts

Some apps let you create and manage user accounts without logging in to the app. If
an app provides such an account service, you can link users of a Panel subscription
with accounts in the app. To perform such an association:

1. Organize the users into a certain group (Users > User Roles
2. Grant one of these group permissions:

A Public access.
If granted, all users in the group will have access to the app through the link on
the Websites & Domaipsge.

A Personal access.
If granted, the app will automatically create accounts for all users in the group.
After that, the users' Websites & Domaimpage will contain an additional link that
allows logging in to a personal account in the app. Note that if you deny the
Personal accesgermission, the app will automatically remove all accounts
associated with this group.
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Updating Apps
Automatic Updates

By default, Panel installs the latest available app versions and updates apps
immediately once the newer versions are available. However, updating an app can
significantly change its functionality: For example, plug-ins or extensions developed for
a particular app version may be incompatible with newer versions. Therefore, you
might want to turn off automatic updates for a certain app.

To turn automatic updates on or off:
Go to Applications> Manage My Applicatioasd click the app's name.

Click Change Settings

w N e

Select or deselect the option Automatically update this app when updates are
available

Manual Updates

If you prohibit automatic updates for an app, Panel will inform you about the availability
of newer versions by adding the link Update availablender the app name in Applications
> Manage My ApplicatiorGlick this link to review the changes available in the new
version and decide whether to update the app or continue with the current version.

Managing Commercial App Licenses

If you decide to buy an application license in the Control Panel and click the
corresponding button on the Applicationgab, you will be forwarded to Storefront, the
online store where you complete your order. Actually it is not only a store, it also
includes its own web interface to help you perform various operations with the licenses
you own. For example, from this web interface you can renew a license, cancel it,
change your payment methods and so on. This section explains how to carry out these
operations.

Storefront Basics

When you order a first license in Storefront, it creates an account for you. This account
contains your personal and financial information; if you log in to Storefront under this
account, you will be able to do various operations with your licenses.

Each time you successfully check out in Storefront, a purchase order is generated. It is
a document that lists the cart items you ordered. Storefront assigns different statuses
to orders. These statuses explain the current state of your purchase - whether it is
unpaid, canceled, or successfully delivered.
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Storefront and Panel share the service plans business model. In Storefront, each
application is presented by a separate service plan, and when you order an application
license you subscribe to one of the service plans. In other words, each license you
purchase is shown as a subscription in the web interface. For instance, if you would
like to view a license price, terms, or an expiration date, you should open the
corresponding subscription.

How to Get a License File or Key

After you order a license and pay for it, Storefront sends you an e-mail with your
license file or key. We recommend that you keep the information in a safe place
because there is no way to request it again or view it from the web interface. If you did
not receive the e-mail with a license file or key, contact us at
https://support.parallels.com/.

Available Operations

The operations you can carry out in Storefront fall into three groups:

A Operations with your user account. These operations include viewing and modifying
your personal information and preferences and changing the password to your user
account.

A Operations with payments and payment methods. This group comprises operations
with your credit cards, payments, and orders.

A Operations with subscriptions. Use them to acquire new licenses, obtain
information about your existing licenses, and check the subscription renewal
method for a particular subscription.

Learn more about these operations in the subsections of this section.

Next in this section:
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User Account

You can do the following operations with your user account.

View and Change i¥Aacount Information

The system uses your account information to add your personal and financial details into
invoices. If you see that you need to update your details, open the My Contact Infsubmenu
on the Navigation menu and select Account Info

Viewand Change Your Personal Information

Your personal information mostly duplicates the account information. It does not appear in
financial documents, but some services use this information as technical contact details. For
example, it is possible to order a domain name through Storefront, and if you do so,
Storefront will send your personal information (as the technical contact) to a domain name
registrar.

To view user personal information, open the My Contact Info Personal Infenenu on the left
panel. Here you can also edit your personal information and change password to your
Storefront account.

Configure-mail notifications

E-mail notifications are sent on different events to your account contact e-mail address. They
fall into a number of categories. For example, subscription renewal and expiration, your
credit card(s) expiration, etc. You can select messages format for every group of messages
and decide whether to send certain messages or not. To configure messages types to
receive, open My Contact Inf> Notification Methods
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Payments and Payment Methods

This section describes operations with payments and credit cards available to you in
Storefront.

Registering a Credit Card

Before a credit card becomes available for making online payments, it is necessary to
register it in Storefront. To register a credit card, open Billing Manager My Financial Infe
Payment Methodand click the appropriate button.

Configuring Automatic Payments

You can assign one of the registered credit cards to be used for paying orders automatically.
In this case, you will not need to pay each order manually. If you assign a payment method
to be used for automatic payments, the previous default one is unselected automatically.
Thus, only one payment method can be used for automated payments.

To turn on automatic payments from a card, go to Billing Manager My Financial Infe Payment
Methodsselect the card by clicking on its IDor Type and, finally, enable automatic payments
on the card properties screen.

Making a Paymnte

To add new payment, open the Billing Manager New Paymeiink on the dashboard. The
adding new payment wizard starts. The list of pending documents appears on the screen. If
there are no pending documents, click Cancelo finish the wizard. Otherwise, walk through
the wizard by providing the payment settings.

Viewing Open Orders

Your open orders are available in the Billing Manager My Financial Infe Open Orders
submenu.
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Subscriptions

Storefront offers you a powerful and comprehensive mechanism of subscriptions (licenses)
management, allowing you to perform the following operations.

Buying a Subscription

If you want to purchase one more app license or another service offered by Storefront, there
is no need for you to go to the Control Panel. The Storefront web interface provides all
facilities for making the purchase. To start the subscription ordering wizard, open Billing
ManagepP Subscription Managemeand click Buy New Subscription

Renewing a Subscription Manually

If you did not configure the auto renewal feature, your subscription will expire unless you do
not renew it manually. The auto renewal setup instructions are given later in this section. To
renew a subscription manually, open Billing Manager Subscription ManagemenRenew
Subscripion and follow the wizard steps.

Renewing Subscriptions Automatically

Configuring a subscription for auto renewal helps renewing your subscriptions in time. To
allow the auto renewal, open Billing Manager Subscription ManagemenRenew Subscription
click a subscription for which you want to turn the option on, and click Turn On AutoRenew
Option Clear the option to cancel the auto renewal.

Canceling a Subscription

A subscription cancelation results in termination of the subscription services and money
refund. To cancel a subscription, open Billing Manager Subscription ManagemenRenew
Subscriptionclick a subscription you want to cancel, and start the cancelation wizard by

clicking Cancel Subscription

(Advanced) Website Security

Next in this sectrm
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Securing Connections with SSL Certificates

If your website transfers private data, for example, visitors' credit card numbers, we
recommend that you use the SSL secure channel for this website. To set up such a channel,
you should purchase an SSL certificate for your website.

SSL certificates are used not only for establishing secure communication channels on the
Internet but also for verifying a website's identity as well. When users visit your secure online
store, they are notified that your website is really what it claims to be and that all sensitive
data, such as credit card numbers, will be transferred over a secure channel.

SSL certificates are issued by specific organizations - SSL certificate providers. However,
some hosting providers allow customers to purchase SSL certificates directly from Panel.

Purchaing SSL Certificates

Depending on your hosting provider, you can have the following ways of purchasing SSL
certificates:

A Order an SSL certificate from Panel. This way is available to you if your provider
configures the corresponding Panel settings. The links for purchasing SSL certificates
from Panel may let your purchase certificates either from your provider in their online
store or from Parallels in the MyPlesk outlet. To learn how to order an SSL certificate
through Panel, see the section Purchasing SSCertificates through Parieh page 114).

A Order an SSL certificate from the SSL certificate provider you like. In this case, you
should create a certificate signing request (CSR) for your website in Panel and submit it
to an SSL certificate provider. To learn how to create such request and purchase a
certificate with it, refer to the section Generating Certificate Signing Requéstspage 115).

Securing Websites

After you obtain a certificate for your website, you should secure the connection to the
website with the certificate. The section Securing Websitg®n page 116) explains how to do
this.

Securing Websites with Shared SSL Certificates

On Windows systems, you may be able to secure your websites without purchasing your
own SSL certificates. This feature is available to you if your hosting provider offers shared
SSL certificates. The section Using Shared SSL Certificates (Wind¢evspage 117) explains
how to secure a website with a shared SSL certificate.

Next in this section:
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Purchasing SSL Certificates Through Panel

The links for purchasing SSL certificates in Panel let you purchase either certificates from
your provider if they offer their own certificates, or certificates from Parallels in the MyPlesk
outlet. These links may also be unavailable to you if your provider decides so.

U To purchase an SSL certificate throlaghel:
1. Open the corresponding subscription in the Control Panel

2. Go to the Websites & Domairasd select the website you want to protect with
an SSL certificate.

3. Click Secure Your Sites
4. Click Add SSL Certificate

5. Specify the following certificate parameters:

A Certificate name. This will help you identify this certificate in the repository.

A Encryption level. Choose the encryption level of your SSL certificate. We recommend
that you choose a value more than 1024 bit.

A Your location and organization name. The values you enter should not exceed the
length of 64 symbols.

A The domain name for which you want to purchase an SSL certificate. This should be a
fully qualified domain name. Example: your-domain.com.

A The website administrator's e-mail address.

6. Make sure that all the provided information is correct and accurate, as it will
be used to generate your private key.

7. Click Buy SSL Certificate

8. Complete all steps of an SSL certificate purchase in the online store and you
will receive your SSL certificate by e-mail.
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Generating Certificate Signing Requests

If your hosting provider does not allow purchasing SSL certificates through Panel, you can
create a certificate signing request and submit it to an SSL certificate provider. The provider
will generate an SSL certificate for your website basing on this request.

U To generate a certificate signing request:
1. Open the corresponding subscription on the Control Panel

2. Go to the Websites & Domairmsd select the website you want to protect with
an SSL certificate.

3. Click SecureYour Sites
4. Click Add SSL Certificate

5. Specify the following certificate parameters:
A Certificate name. This will help you identify this certificate in the repository.

A Encryption level. Choose the encryption level of your SSL certificate. We recommend
that you choose a value more than 1024 bit.

A Your location and organization name. The values you enter should not exceed the
length of 64 symbols.

A The domain name for which you want to purchase an SSL certificate. This should be a
fully qualified domain name. Example: your-domain.com.

A The website administrator's e-mail address.

6. Make sure that all the provided information is correct and accurate, as it will
be used to generate your private key.

7. Click RequestPanel will generate your private key and certificate signing
request and add them to your certificates repository (Websites & Domains
Secure Your Sitgs

8. In the list of certificates, click the name of the certificate you need.

9. Locate the CSR section the page, and copy the text that starts with the line
-—BEGIN CERTIFICATE REQUESNd ends with the line ----END CERTIFICATE
REQUEST---to the clipboard.

10.Visit the website of the certification authority from which you want to
purchase an SSL certificate, and follow the links on their site to start a
certificate ordering procedure. When you are prompted to specify CSR text,
paste the data from the clipboard into the online form and click Continue The
certification authority will create an SSL certificate in accordance with the
information you supplied.
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Securing Websites

After you receive an SSL certificate for your website, secure the website with this certificate.

U To secure a website with an SSL certificate:

1. Log in to the Control Panel and select the subscription that contains the
website you want to secure in the Subscriptionamenu at the top of the screen.

2. Go to the Websites & Domairssd select the website you want to protect with
an SSL certificate.

3. Click Secure Your Sites

Upload the SSL certificate: Click Browsein the middle of the screen and navigate to the
location of the saved certificate. Select it, and then click Send File

This will upload and install the certificate against the corresponding private key.

1. To install the certificate on a site, return to the Websites & Domainiab, and
click the domain name of the website that you want to secure.

2. To switch on SSL protection, select the Enable SSL supparheckbox.

3. From the SSL certificatenenu, select your SSL certificate and click OK
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Using Shared SSL Certificates (Windows)

If your hosting service provider offers shared SSL for securing access to sites, then you can
switch on SSL encryption without purchasing your own SSL certificate.

U To secure connections to a site by using an SSL certificate shared by your
provider:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairmsd select the website you want to protect with
an SSL certificate.

Click Shared SSL
Select the domain name of the site that you want to secure.
Select the Switch on shared SSiheckbox.

AL

Specify the virtual directory name in the corresponding input field. The virtual
directory with the supplied name will be created under the domain whose
SSL certificate is shared (called master SSL domain). This directory will be
used for accessing your site through SSL.

For example, let us suppose that you have a domain named mydomain.com, the master
SSL domain is defined as master_ssl_domain.com, and the virtual directory name you
supplied is my_virtual_dir . In this case, to access your site through SSL, you need to
use the following address: https://master_ssl_domain.com/my_virtual_dir.

Note: You cannot use your domain name (for example, mydomain.com) to access your
site via SSL if you are using shared SSL.

7. Select the directory where protected content is located under your website.
The documents within the specified directory will be accessible only through
SSL.

8. To make your domain accessible via SSL only, select the checkbox Make this
website accessible only through secure connections

9. Click OK
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Protecting Sites from Hotlinking (Windows)

Hotlinking (also called file leeching, remote linking, direct linking, bandwidth stealing or
bandwidth banditism) is a term used for describing a situation when a web page of one
domain owner is directly linking to images (or other multimedia files) on the web pages of
another domain owner, usually using an <IMG> tag. If your domains are hotlinked, you may
face the problem of excessive bandwidth usage.

U To protect a website from hotlinking:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairiab and click the website's domain name.
Click Hotlink Protectian

Click Switch Orto enable the protection from hotlinking.

o &~ W N

Specify the extensions of files that you want to protect from hotlinking (for
example, jpg, bmp, and so on) in the Protected files extensiohield. When
listing several file extensions, separate them with white spaces.

6. If you want to allow direct linking to your files from certain sites, type the
website addresses into the Addresses of friendly websitBeld, and click Add

7. Click OK
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(Advanced) Extended Website Management

Panel provides a number of operations on websites and domains for advanced users:
Working with third-party applications and services, fine tuning of some system services, and
much more. This section contains the detailed instructions on all these operations.

Next in this section:

Working With @ Staging Site.........cccuuiiiiiiii e 120
Setting Up MODIIE SITES .......uuiiiiiiiiiiiiiii e 122
Setting Up CUStOM Error PAQES ...........uuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieieesneesnenennnnes 123
USING GOOQIE SEIVICES ... oo ettt e e e e et e e e e eaeaees 125
Hosting Personal Web Pages Under Your DOMainS........ccoooeeevvvveevveeiinieeenneennnns 128
Limiting Bandwidth and Number of Connections to Websites...............ccvuvvennee 130
Working with Microsoft FrontPage Websites (WINAOWS) ........cccoeeeeiiiviiiiicnnnennn. 131
Using Virtual Directories (WINAOWS) .........ccuuuiiiiiiie e eeeens 136
Setting Up IS Application Pool (WINAOWS) ............uuuumiimmmiiiiiiiiiiiiiiiiiiiiiiiiieennnnnes 149

Web Publishing with Web Deploy (WIiNdOWS) ..........ccoovviiiiiiiiiiiiiiiiiiiiiiiiiieeeeeee 151
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Working with a Staging Site

If you have a production website and are planning major site changes, consider setting up a
staging site & a separate location on the server where you can conveniently update and test
a copy of the site before putting it into production.

We recommend that you work with a staging site in the following way:

1. Decide where you want to host the development copy and prepare the development
environment. You can choose to host it in the same webspace, in a separate webspace
on the same server, or upload it to an FTP account on another server.

If you choose the same webspace, then you first need to set up a new website by adding
a domain or a subdomain.

2. (Optional step.) If you set up your development environment under your account in the
Panel and your production site has APS applications installed via the Panel (at the
Applicationdab), install the desired site applications in your development environment in
the same subdirectory as you have on your production site. This step is optional;
however, it will help you avoid changing manually database connection settings in the
application scripts.

Make a copy of the website and place it in the staging environment.

Make copies of the databases used by the site and deploy them in the staging
environment.

5. Change database connection settings in the scripts to point at the databases in the
staging environment.

6. (Optional step.) Complete APS applications setup. Go to the Applicationgab for your
development site, locate the application in the list of installed applications, open its
Settingsscreen and re-save the parameters. With this operation, the APS scripts should
stop pointing at the production database and reconnect the application to the database
copy. This step is needed if your production site has APS apps installed via the Panel
and you performed Step 2 of the current instruction.

7. Make the required changes to the site copy in the staging environment, and test them to
make sure everything works as intended.

8. Publish the updated site. This is done by pointing the document root of the production
site to the staging site location.

U To set up a site for staging purposes:
1. Go to the Websites & Domairtab.
2. Click either Add New Domaimr Add New Subdomain
We recommend that you use a subdomain for staging purposes.

3. Proceed as described in Adding Domaingon page 61) or Adding Subdomain®n
page 63).

If you do not want your staging site to be accessible to the Internet users, do not register the
newly added domain or subdomain name with a domain name registrar, or use an
.htaccess file (on Linux hosting) to restrict access to it.
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5.

To make a copy of website files:

Go to the Websites & Domairtab and click the name of the website you want
to copy.

Click Website Copying

To copy website files to the document root of an existing site:
a. Select the option Website in the Panel

b. Select the destination site from the Site namemenu.

c. Specify what to do with the files that might already be present in the
destination directory.

To copy website files to an FTP account on this or another server:

a. Select the option FTP storage

b. Specify the server's host name and credentials for connecting to the
FTP account.

c. In the FTP connection methdield, leave the Active modeption selected.
If the Panel fails to connect to the external FTP account, select the
Passive modeption here.

Click OK

If the site uses scripts that work with a database, copy the database to the staging
environment:

A

A
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If the database is hosted on the same server managed by Panel 10, use the procedure
below to copy it.

If the database is hosted on a server which is not managed by Panel 10, use the
mysqldump utility to export the database, move the resulting data dump file to the

staging environment and deploy it there. Modify the site's scripts in the staging
environment so that they connect to the copied database.

To make a copy of a database from the ffaaredged server:
Go to the Websites & Domairtab > Databases
Click Copyin the databases list for the database you want to copy.

Specify the following:

A Destination database serv¥pu can select the same Panel-managed database server,
or a database server located elsewhere. For an external database server, specify the
host name or IP address, and access credentials: the username and password of a
database management system user authorized to create new databases and
database tables.

A Destination databas¥ou can choose to create a new database or copy the data to an
existing database.

A Create a full copy.eave this option selected to copy the database structure and all
data.
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4. Click OK
The copy of the database will be deployed on the destination server.

5. Modify the site's scripts in the staging environment so that they connect to
the copied database.

When the site copy in the staging environment is updated and ready to go live, publish it as
described in the following steps.

U To publish the updated site to the production environment:
1. Go to the Websites & Domairtab.

2. In the list of domain names, locate the address of your production site and
click it.

3. In the Document rodbox, specify the document root directory of the staging
site.

4. Click OK

This will make the updated site copy in the staging site location accessible to visitors of your
production site address.

Setting Up Mobile Sites

Your service plan may include the option to create website copies optimized for viewing on
mobile devices. The copies are hosted with external UNITY Mobile online service.

Important : In Panel 10.4, if a customer ordered the Unity Express offering from the
Applications tab, the system could confuse the offering with Unity One. If you faced this
problem, we recommend that you remove the site created with Unity One and create the
new one in order to get Unity Express.

U To create a copy of your website optimized for viewing on mobile devices, or
set up a new mobile website:

Go to Websites & Domairtab and click the site's domain name.
Click Mobile Websites
Click the corresponding Create Mobile Sitank.

W Dp e

Specify an address for the mobile site.

If your site is accessible, for example, by domain name example.com , you can type a
prefix like mobile , and then the optimized copy of your website will be accessible by the
address mobile.example.com

5. Click OK
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6. Click Edit Ste ContentA UNITY Mobile site opens in a new browser window or
tab, and you are logged on under your account.

7. In the Import from the web sectisnh o wi ng your main websiteods

click the button

8. Complete the website import wizard by following instructions presented on
the screen.

After the mobile site is created, you can add a link to it to your main site.

You can now perform the following operations on the mobile site using links in Control Panel:

A Open site editor.
A Remove mobile site.

Setting Up Custom Error Pages

When visitors coming to a site request pages that the web server cannot find, the web server
generates and displays a standard HTML page with an error message. You may want to
create your own error pages and use them for your sites or individual virtual directories. The
following error messages are the ones customized most often:

A 400 Bad File Request. Usually means the syntax used in the URL is incorrect (for
example, uppercase letter should be lowercase letter; wrong punctuation marks).

A 401 Unauthorized. Server is looking for some encryption key from the client and is not
getting it. Also, wrong password may have been entered.

A 403 Forbidden/Access denied. Similar to 401; a special permission is needed to access
the site i a password or username, if it is a registration issue.

A 404 Not Found. Server cannot find the requested file. File has either been moved or
deleted, or the wrong URL or document name was entered. This is the most common
error.

A 500 Internal Server Error. Could not retrieve the HTML document because of server
configuration problems.

A 503 Service Temporarily Unavailable. The site is temporarily unavailable due to
maintenance.

Next in this section:

Setting Up Custom Error Pages on WIiNndows Servers .........cccccccveeeeeeeeeveeevnvnnnnn. 124
Setting Up Custom Error Pages on LiNUX SErVers......cccccceevveeevvvicei e 125
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Setting Up Custom Error Pages on Windows Servers

U To configure theeb server to show custom error pages for a site or a
directory within a site:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Switch on support for custom error documents.

a. Go to the Websites & Domairtab and click the Hosting Settingbutton
beside domain name you need.

b. Select the Custom error documenthieckbox.
c. Click OK

3. Go to the Websites & Domainab.

4. Click the domain name you need.

5. Click Virtual Directorieto see the list of error documents for the root web
directory. Error documents located here are used for all web pages of the
selected site. If you want to customize error pages for a specific virtual
directory, navigate to that directory.

6. Click Error Documentsab and click the required error document in the list.

A To use the default document provided by IS for this error page, select Defaultin the
Typemenu.

A To use a custom HTML document already located in the error_docs  directory in the
virtual host directory of the domain, select Filein the Typemenu and specify the file
name in the Locationfield.

A To use a custom HTML document located in a directory other than error_docs on
a domain, select URLin the Typemenu and enter the path to your document in the
Locationfield. The path should be relative to the virtual host root (that is,
<vhosts> \ <domain> \ httpdocs ).

For example, you have created a file forbidden_403_1.html and saved it in the
my_errors directory located in the httpdocs . To use this file as an error document,
you need to type the following path into the Locationfield:
/my_errors/forbidden_403_1.html

Note: You can use a connection over FTP or File Manager in the Panel to upload your
custom error document to the server. By default, all error documents are stored in the
Ivhosts/your - domain.com/error_docs/ directory (located in C:\ InetPub by
default).

7. Once the web server is restarted, it will start using your error documents.
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SettingUp Custom Error Pages on Linux Servers

U To configure the web server to show custom error pages for a site:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Switch on support for custom error documents.

a. Go to the Websites & Domairtab and click the Hosting Settingbutton
beside domain name you need.

b. Select the Custom error documentheckbox.
c. Click OK

3. Connect to your FTP account, and go to the error_docs directory.

4. Edit or replace the respective files. Be sure to preserve the correct file
names:

400 Bad File Request - bad_request.html

401 Unauthorized - unauthorized.html

403 Forbidden/Access denied - forbidden.html

404 Not Found - not_found.html

405 Method Not Allowed - method_not_allowed.html

406 Not Acceptable - not_acceptable.html

407 Proxy Authentication Required - proxy_authentication_required.html

412 Precondition Failed - precondition_failed.html

414 Request-URI Too Long - request-uri_too_long.html

415 Unsupported Media Type - unsupported_media_type.html

500 Internal Server Error - internal_server_error.html

501 Not Implemented - not_implemented.html

502 Bad Gateway - bad_gateway.html

> >y > B>y > >y > D> P>y D> D>y D> D> D

503 Service Temporarily Unavailable - maintenance.html

The web server will start using your error documents in a few hours, after it is restarted.

Using Google Services

Using links in the Panel, you can generate code for inserting a custom Google search engine
into your site, submit your website to Google through Webmaster Tools area, enroll in the
AdSense program, embed YouTube videos, Google Translate service, or other Google
products into your site.
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Google Custom Search is a search engine provided by Google. It adds search functions to
your site and allows you to apply your website's look and feel to the search results page. It
can be used for free on websites of individuals and non-profit organizations. Websites related
to for-profit businesses can either use a Custom Search Engine that will show
advertisements from Google, or purchase a subscription to Google Site Search service,
which starts from $100 per year. To learn more about Google Site Search and current prices,
visit http://www.google.com/sitesearch.

Google Webmaster Tools allow webmasters to submit a website to Google and view search
statistics. To learn more about Webmaster Tools, visit
http://www.google.com/support/webmasters/?hl=en.

Google AdSense allows webmasters to earn money for displaying targeted Google ads on
their websites. To learn more about AdSense, visit
https://www.google.com/adsense/login/en/.

Google Web Elements allows webmasters to easily add their favorite Google products to
websites. Embed content, such as news, maps, YouTube videos, and social conversations
from Google Friend Connect to Web pages with simple cut-n-paste. To learn more about
Google Web Elements, visit http://www.google.com/webelements/.

Before you start using Google services, you need to confirm acceptance of Google Terms of
Services, and then confirm ownership for your sites.

U To confirm acceptance of Google terms of service and then confirm ownership
of your sites:

1. Go to the Websites & Domairniab, and click the Google Services for Websitas.

2. Click the appropriate links in the Panel to open and read the Terms of
Service documents.

3. To confirm that you accept the Terms of Service, select the checkbox and
click Confirm

Now you can do the following:

A Submit your site to Google and improve site visibility in search results by clicking Google
Webmasterdols

A Add search functions to a site by clicking Add New Custom Search Engine
A Enroll in the AdSense program by clicking Google AdSense
A Embed Google products into your site by clicking Google Web Elements.

U To submit a site to Google:
1. Go to the Websites &omaingab and click the site's domain name.
2. Click the Google Services for Websitesk.


http://www.google.com/sitesearch
http://www.google.com/support/webmasters/?hl=en
https://www.google.com/adsense/login/en/
http://www.google.com/webelements/
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Click Google Webmaster Tools
The Google Webmaster Tools area opens in a new browser window or tab.
Create a Sitemap and submit it to Google by following instructions at

http://www.google.com/support/webmasters/bin/answer.py?hl=en&answer=1
56184.

To add a custom search engine to a site:

Go to the Websites & Domairiab and click the site's domain name.
Click the Google Services for Websites.

Click Custom Site Search

Click Add New Custom Search Engine

Type a search engine name and select the website you need.

Select the checkbox to confirm your acceptance of Terms of Service, and
click OK

The record corresponding to the new search engine is added to the Panel.

. Click the corresponding Get Coddink, copy the generated code to the

clipboard and paste it into the source code of your website pages.

The other links in the list of Custom Search Engines will help you perform the following
operations:

A

> > > > >

N

Make MoneyConnect your Custom Search Engine to a Google AdSense account. You
make money when users click on an ad they see in your search results. If you have more
than one Custom Search engine, all of your search engines will automatically be
associated with the same AdSense account.

ManageManage your Custom Search Engines.

Look and FeeAdjust the appearance of search box and search results page.
UpgradeUpgrade a Custom Search Engine to ads-free Google Site Search.
Statistics Review site search reports.

Delete Delete a Custom Search Engine.

To participate in the Google AdSense program:

Go to the Websites & Domainiab and click the site's domain name.
Click the Google Seiwes for Websiteknk.

Click Google AdSense

Click Google AdSensaccount.

Fill in all the required fields to create a new AdSense account, or select an
existing account, and click OK

A confirmation e-mail with further instructions will be sent to your e-mail address.


http://www.google.com/support/webmasters/bin/answer.py?hl=en&answer=156184
http://www.google.com/support/webmasters/bin/answer.py?hl=en&answer=156184
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Hosting Personal Web Pages Under Your Domains

You can host on your web server personal web pages for users who do not need their own
domain names. These pages usually have web addresses like http://your-
domain.com/~username.

U To accommodatepersonal web page under your domain and set up an FTP
account for publishing:

1. If you are subscribed to several hosting packages and have access to

several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairtab and click the domain name under which you
want to create a personal web page.

3. Click Web Users
4. Click Settings

5. If you want to allow execution of scripts embedded in personal web pages,
select the Allow web users to use scriptheckbox.

6. Click OK

The settings you have defined at the step 4 are common for all personal web pages you
might host on your account. Therefore, you will not need to perform the steps from 3to 5
next time you set up a new web user account.

7. Click Add New Web User

8. Specify a username and a password that will be used for accessing the
webspace through FTP and publishing the web pages.
You can use only lower-case alphanumeric, hyphen and underscore symbols in the
username. The username should begin with an alphabet character. It cannot contain

white spaces. The password cannot contain quotation marks, white space, username,
and should be between 5 and 14 characters in length.

9. If you want to limit the amount of disk space that can be occupied by the web
page content, type the desired value in megabytes into the Hard disk quota
box.

When the specified limit is exceeded, the web page owner will not be able to add files to
his or her webspace.

10.Specify the programming languages that should be supported for the web
page.
For example, if the web page is written in PHP, select the PHP supportheckbox.
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11.1f you use a Windows-based hosting account and this personal web page's
applications need to use a file-based database (like Jet) located in the root
of httpdocs  directory, select the Additional write/modify permissioogtion. Note
that selecting this option might seriously compromise the website security.

12.Click OK

Now you can tell your user the FTP account credentials, so that he or she can publish their
web page.

U To change FTP password for a web page owner:

=

Go to the Websites & Domairtab and click the name of the domain that
contains the personal page.

Click Web Users

Click the user name you need.

Type the new password into the New paswordand Confirm passwortioxes.
Click OK

o A~ WD

To allocate more disk space to the web page owner:

=

Go to the Websites & Domairtab and click the name of the domain that
contains the personal page.

Click Web Users

Click the user name you need.

Type the amount of disk space in megabytes into the Hard disk quotaox.
Click OK

o &~ DN

To remove a web page owner6s account

1. Go to the Websites & Domainab and click the name of the domain that
contains the personal page.

2. Click Web Users

3. Select a checkbox corresponding to the user account you want to remove
and click Remove

4. Confirm removal and click OK
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Limiting Bandwidth and Number of Connections to
Websites

To avoid excessive usage of bandwidth, and protect your site from Denial Of Service attacks,
you can limit bandwidth usage for a site and number of simultaneous connections.

U To limit bandwidth usage and number of connections to a site:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairtab and click the site's domain name.
Click Bandwidth Limiting
Select the Switch on bandwidth limitirpeckbox.

o &~ DN

In the Maxinum bandwidth usage (KBI#)x, specify the maximum speed,
measured in kilobytes per second, that a website can share among all its
connections.

6. Select the Switch on connections limitingpeckbox.

7. In the Connections limited toox, specify the maximum number of simultaneous
connections to the site.

8. Click OK
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Working with Microsoft FrontPage Websites (Windows)

Microsoft FrontPage deals with two kinds of websites: disk-based and server-based. In short,
a disk-based site is a FrontPage website you create on your local hard disk and then later
publish to the server. A server-based site is one you create and work with directly on the
server, without the extra step of publishing. This section provides you with instructions on
publishing only disk-based websites.

You can publish disk-based websites either through FTP or HTTP. If your hosting server is
running FrontPage Server Extensions, you would publish your site over HTTP. For example:
http://lyour-domain.com/MyWebSite. If your hosting server supports FTP, you would publish
to an FTP location. For example: ftp://ftp.your-domain.com/myFolder.

After publishing, you can manage your site through FrontPage Server Extensions.

U To access FrontPage Server Extensions management interface:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Click the Websites & Domairtab and click the name of the website you want to
manage in Frontpage.

3. Click FrontPage.

4. Do either of the following:

A To manage a site over HTTP connection, click Frontpage Webadmin

A To manage a site over a secure SSL connection, if SSL support is enabled for the
site, click Frontpage SSL Webadmin

5. Typeyour FrontPage admi ni stratords userna@e and

For instructions on using FrontPage server extensions, see online help (Frontpage Webadmnsn
Help or visit Microsoft website.

The following FrontPage settings are changeable through the Panel:

A The use of Microsoft FrontPage IIS Index Server for building the full-text index of your
website.

A SMTP mail server and sender's e-mail address. These options are applicable if you
use FrontPage forms that submit information from your site by e-mail. By default,
SMTP server specified in the domain’'s DNS zone is used for sending mail. If no
SMTP server is specified in the zone, then FrontPage uses the mail service running
on the server where the domain (site) is hosted.
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U To change any of these settings:

1. Click the Websites & Domairtab and click the name of the website you want to
manage in Frontpage.

2. Go to FrontPage> Settings.
3. Make the required changes and click OK

Next in this section:

Publishing FrontPage WeDSItES...........ccoiiiiiiiiiiicc e 133
Adding FrontPage ACCOUNLS .......ccoiiiiiiiiii i e e 135
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Publishing FrontPage Websites

To publish files through FTP:
Open your FrontPage program.

Open a FrontPage website: open Filemenu and select the Open Sitetem.

w N e

Go to Remote Web siteiew: click the Web Sitd¢ab, and then the Remote Web Site
button at the bottom of the window.

4. Set up your Remote Web Site Properties:
A Click the Remote Web Site Propertiegton in the upper-right corner of the window.
A Select FTPas the remote Web server.

A In the Remote Web site locatibax, type your host name (for example, ftp://ftp.your-
domain.com)

A Inthe FTP directorpox, type your FTP directory if your hosting company provided one.
Leave it blank if they did not specify one.

A Select the Use Passive FTéheck box if your computer or network is protected by a
firewall.

5. Click OKto connect to the remote site.
The Remote Web site view will show files that you have in your local and remote sites.

6. Click the Publish Web sitbutton in the lower-right corner of the window.

U To publish files through HTTP on a server that supports FrontPage Server
Extensions:

1. Open your FrontPage program.
2. Open a FrontPage website: open Filemenu and select the Open Sitetem.

3. Go to Remote Web siteew: click the Web Sitdab, and then the Remote Web Site
button at the bottom of the window.

4. Click the Remote Web Site Propertimgton in the upper-right corner of the
window.

5. On the Remote Web Sitab, under Remote Web server tymick FrontPage or
SharePoint Seices.

6. In the Remote Web site locatibox, type the Internet address, including the
protocol, of the remote website that you want to publish folders and files to,
for example, http://www.your-domain.com, or click Browseto locate the site.
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7. Do any of the following:

A To use Secure Sockets Layer (SSL) for establishing a secure communications
channel to prevent the interception of critical information, click Encryption connection
required (SSLJo use SSL connections on your web server, the server must be
configured with a security certificate from a recognized certificate authority. If the
server does not support SSL, clear this check box. Otherwise, you will not be able to
publish folders and files to the remote website.

A To remove specific types of code from web pages as they are being published, on the
Optimize HTMiab, select the options you want.

A To change the default options for publishing, on the Publishingtab, select the options
you want.

8. Click OKto connect to the remote site.
The Remote Web sitgew will show files that you have in your local and remote sites.

9. Click the Publish Web sitbutton in the lower-right corner of the window.
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Adding FrontPage Accounts

If you are using Microsoft FrontPage for collaborating on website content with other users,
then you need to create additional Microsoft FrontPage accounts.

U To create an additional Microsoft FrontPage account:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscrption menu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairiab and click the domain name of the website for
which you create the account.

3. Click FrontPage.
4. Click Add New FrontPage Accaunt
5. Specify the following:

A Username and password for the account.

A Limit on disk space. If you wish to limit the amount of disk space that can be used by
this account, clear the Unlimitedcheck box and type the desired value in megabytes
into the Hard disk quothox.

When the specified limit is exceeded, the user will not be able to upload more files to
the webspace.

6. Click OK

U To change settings for an additional Microsoft FrontPage account:

1. Go to the Websites & Domainab and click the domain name of the website
that contains the account.

2. Click FrontPage
3. Click the required account name in the list.

4. Adjust the settings as necessary and click OKto save changes.

U To remove an additional Microsoft FrontPage account:

=

Go to the Websites & Domairtab and click the domain name of the website
that contains the account.

Click FrontPage
Select the checkbox corresponding to the account you want to remove.

Click Remove

ok~ WD

Confirm the removal and click OK
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Using Virtual Directories (Windows)

A virtual directory is a link to an existing physical directory that is present on the server's hard
disk. Virtual directories can have a number of specific settings like custom ASP.NET
configuration, access permissions, and protection with a password.

Because any virtual directory can have its own settings, including customized ASP.NET
configuration, virtual directories are very useful in setting up your web applications, especially
those written in ASP.NET. For example, if you have three web applications that use
ASP.NET version 1.1, and you need to install one web application that uses ASP.NET
version 2.0, you can create a virtual directory for the ASP.NET 2.0 application, configure
ASP.NET settings for this directory so as to enable support for version 2.0, and then
successfully install the required application.

Virtual directories can also be used as aliases. For example, you have a web application
installed on your domain "example.com” in the physical directory
"Imy_data/web_apps/forum” . To access this web application, users need to type
"example.com/my_data/ web_apps/forum" , which is hard to remember and too long to
type. You can create virtual directory called forum in the root of your virtual host, and link
this virtual directory to "/my_data/web_apps/forum" , SO the users who want to access
the web application will need to type "example.com/forum" , which is much shorter and
easier to remember.

Next in this section:

Creating Virtual DIFECIOMIES.......uuuuuiiiiiiiiiiiiiiiieiiiiii e eeseeeenenee 137
Configuring ASP.NET for Virtual DIreCtories..........ccvveeeieeeeiiieeeiicee e, 139
Configuring PHP for Virtual Dir€CtOrES.......ceiii i 141
Setting Up Access to Virtual DIr€CIONES .........uuuuuuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieiiiiiieinees 142
Changing Virtual DireCtory SEttiNgS..........uuuuuuruuummmmiiiiiiiiiiiiiiiiiiiiiiiineieeeeeeeeeaeenee 145

Adding and RemoVving MIME TYPES ..uuiiiiieiiiieiiee et 147
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Creating Virtual Directories

U To create a virtual directory within a website:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairtab and click the website's domain name.
Click Virtual Directoriesyou are in your web site root now.

Navigate to the directory in which you want to create a new virtual directory.

ok~ DN

Click Create Virtual Directory

Note: To create a physical directory instead of virtual directory, click Create Directoyy
specify the name of the directory and click OK

6. Specify the required parameters:
A Name- specify the virtual directory name.
A Path- specify the virtual directory path:

A Select the Create physical directory with the same name as virtual digkeokjpox to
automatically create a physical directory with the same name as the virtual
directory you are creating.

A Clear the Create physical directory with the same name as virtual dicketokjpox and
specify the path in the field to select a physical directory that already exists.

A Script source accessselect this checkbox to allow users to access source code if
either Read or Write permissions are set. Source code includes scripts in ASP
applications.

A Read permissionselect this checkbox to allow users to read files or directories and
their associated properties.

A Write permissionselect this checkbox to allow users to upload files and their
associated properties to the virtual directory or to change content in a write-enabled
file. Write access is allowed only if browser supports the PUT feature of the HTTP 1.1
protocol.

A Directory browsingselect this checkbox to allow users to see a hypertext listing of the
files and subdirectories in the virtual directory.

A Log visits- select this checkbox if you want to store the information about visits of the
virtual directory.

A Create applicationselect this checkbox to make the directory an IIS application. The
directory becomes logically independent from the rest of the website.

A Execute permissionsselect the appropriate program execution level allowed for the
virtual directory.

A None- allow access only to static files such as HTML or image files.
A Scripts only allow running scripts only, not executables.

A Scripts and Executablesemove all restrictions so that all file types can be
executed.
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A ASP Settings set specific settings for ASP-based web applications.

A If you are using ASP-based applications that cannot operate correctly under data
transfer restrictions currently set by 11S, clear the Defined by parent directory
checkbox corresponding to the field you want to change and type in the required
number.

A If you want to enable debugging of ASP applications on the server side, clear the
corresponding Defined by parent directarigeckbox and select the Enable ASP server
side script debggingcheckbox.

A If you want to enable debugging of ASP applications on the client side, clear the
corresponding Defined by parent directarigeckbox and select the Enable ASP client
side script debuggingheckbox.

Note that if you are trying to change ASP Settings for the root virtual directory, the
default checkbox names will be Defined by lIistead of Defined by parent directory

. Click OK

To remove a virtual directory from a website:

If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairtab and click the website's domain name.
Click Virtual Directories

Select the checkbox corresponding to the directory you want to remove.
Click Remove

Confirm the removal and click OK
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Configuring ASP.NET for Virtual Directories

i
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To configure ASP.NET settings for a virtual directory within a website:

If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairtab and click the website's domain name.
Click Virtual Directories

Browse to the required directory and click a link with its name.

Click ASP.NET Settings

Set up the strings that determine database connection data for ASP.NET
applications that use databases. This option is available only for ASP.NET
2.0.x.

When you open the ASP.NET configuration page for the first time, sample connection
parameters with common constructions are displayed. You can delete them and
specify your own strings.

A To add a string, enter the required data into the Nameand Connection Parametergput
fields and click @ next to them.

A To remove a string, click @ next to it.

Set up custom error messages that will be returned by ASP.NET
applications:

A To set the custom error messages mode, select an appropriate option from the Custom
error modemenu:

A On- custom error messages are enabled.
A Off- custom error messages are disabled and detailed errors are to be shown.

A RemoteOnly custom error messages are displayed only to remote clients, and
ASP.NET errors are shown to the local host.

A To add a new custom error message (which will be applied unless the Off mode was
selected), enter the values in the Status Codend Redirect URfields, and click @.

A Status Codeefines the HTTP status code resulting in redirection to the error page.

A Redirect URHefines the web address of the error page presenting information
about the error to the client.

Due to possible conflicts, you cannot add a new custom error message with an error
code that already exists, but you can redefine the URL for the existing code.

A To remove a custom error message from the list, click '@ next to it.
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8. Configure compilation settings in the Compilation and Debuggifigld:

A To determine the programming language to be used as default in dynamic compilation
files, choose an entry from the Default web page languagenu.

A To enable compiling of retail binaries, leave the Switch on debuggingheckbox empty.

A To enable compiling of debug binaries, select the Switch ordebuggingcheckbox. In this
case, the source code fragments containing error will be shown in a diagnostic
message.

Note: When running applications in debug mode, a memory and performance overhead
occurs. We recommended that you use debugging when testing an application, and
disable it before deploying the application into production scenario.

9. Configure encoding settings for ASP.NET applications in the Globalization
Settingssection:

A To set an adopted encoding of all incoming requests, enter an encoding value into the
Request encodinfield (default is utf-8).

A To set an adopted encoding of all responses, enter an encoding value into the
Response encodirfgeld (default is utf-8).

A To set an encoding which must be used by default for parsing of .aspx , .asmx , and
.asax files, enter an encoding value into the File encodingdield (default is Windows-
1252).

A To set a culture which must be used by default for processing incoming web requests,
select an appropriate item from the Culturelist.

A To set a culture which must be used by default when processing searches for a
locale-dependent resource, select an appropriate item from the Ul Culturdist.

10.Set a code access security trust level for ASP.NET applications in the Code
Access Securitfield.

CAS trust level is a security zone to which applications execution is assigned, defining
what server resources the applications will have access to.

Important: When an assembly is assigned a trust level that is too low, it does not
function correctly. For more information on the permission levels, see
http://msdn.microsoft.com/library/en-
us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429 010.

11.1f you are using ASP.NET 1.1.x, then you can enable the usage of the
auxiliary scripts in the Script Library Settingseld. Specifying the script library
settings is necessary if the validation web controls are used on your web
site.

A If you need to use auxiliary scripts (specifically, scripts implementing objects for
validating input data), provide the settings for .NET framework script library. To do so,
enter the path beginning with the domain root directory preceded by the forward slash
into the Path to Microsoft script librdiigld, or click the folder icon next to the Path to
Microsoft script librarfreld and browse for the required location.

A Toinitiate installation of files containing the scripts to the specified location, select the
Installcheckbox. If the files already exist there, they will be rewritten.


http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
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12.Set client session parameters in the Session Settingeld:

A To set up the default authentication mode for applications, select an appropriate item
from the Authentication modeést. Windowsauthentication mode should be selected if
any form of 1S authentication is used.

A To set up the allowed session idle time, enter appropriate number minutes into the
Session timeodteld.

13.Click OKto apply all changes.

Configuring PHP for Virtual Directories

To be able to use web applications that require PHP4 or PHP5, you can select the required
PHP version for individual virtual directories.

U To select PHP version for a virtual directory within a website:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairiab and click the website's domain name.
Click Virtual Directories
Browse to the required directory and click a link with its name.

In the Toolsgroup, click PHP Settings

AL

Select the required version of PHP and click OK
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Setting Up Access to Virtual Directories

U To set access permissions for a virtual directory within a website:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscripton menu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairtab and click the website's domain name.
3. Click Virtual Directories

4. To set access permissions for the current virtual directory, in the Toolsgroup,
click Directory Access Permission you want to set permissions for a
subdirectory located within the current directory, click the corresponding icon

8,

5. Do the following:

A To make the file/folder inherit permissions from a parent folder (if it does not), select
the checkbox Allow inheritable permissions from the parent to propagate to this object and all
child objects. Include these with entries explicitly defined here

A To make the files and folders, which are contained in this folder, inherit the folder
permissions you define, select the checkbox Replace permission entries on all child objects
with entries shown here that apply to child objects

A To change or remove permissions from a group or a user, click the required name in
the Group or user namdist. If the group or user is not listed in the Group or user names
list, select the required user or group name from the menu located above the list and

click &: the user/group appears in the list. Select it.

To allow or deny permissions to a selected group/user, select the Allowor Deny
checkboxes corresponding to permissions listed under Permissions foxuser/group
name=>If the checkboxes in Allowor Denycolumns are shown in grey, it means that the
corresponding permissions are inherited from a parent folder.

A To deny the permissions, which are inherited from a parent object as allowed, select
the required checkboxes under Deny This will override inherited permissions for this
file/folder.

A To allow the permissions, which are inherited from a parent object as denied, clear the
Allow inheritable permissions from the parent to propagate to this object and all child objects.
Include these with entries dgjtly defined hereheckbox: this removes the inherited
permissions. Then select the required checkboxes under Allowand Deny

A To remove access permissions from a group or user, select the required name in the
Group or user namdist and click the icon @ next to it.
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If you need advanced fine-tuning of permissions, click the Advancedutton,
and do the following:

A To create a permission entry for a group or user, select the required name from the
Group or user namdist and click ‘@,

A To set or change file/folder permissions for a group or user, select the required name
from the Group or user namdist, select the required Allowand Denycheckboxes
corresponding to permissions listed under Permissions foxuser/group name>

A To remove a permission entry for a group or user, select the required name from the
Group or user namdist and click @.

A To make child objects of a folder inherit its permissions defined under Permissions for
<user/group nameselect the Replace permission entries on all child objects with entries
shown here that apply to child objetiieckbox, and select checkboxes in the Apply tolist
which correspond to the objects that must inherit the permissions.

Click OK

To restrict access to files and directories located within a virtual directory:

If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairtab and click the website's domain name.
Click Virtual Directories

Navigate to the directory you want to protect and click the Protectiontab.
Click Protect

To specify users who will be able to access the directory, click Add User
specify username and password, and click OK

If you want to specify a title for the protected area that will be shown to users
when they attempt to access the directory, click Settings specify a title, and
click OK

To revoke a permission to access a directory from a user:
Go to the Websites & Domairtab and click the website's domain name.
Go to the Virtual Directories Protectiontab.

Select the checkbox corresponding to the user's name and click Remove
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U To remove protection from a directory and allow the general public to see the
directory contents without restrictions:

Go to the Websites & Domairtab and click the website's domain name.
Go to the Virtual Directories Protectiontab.

Click Remove Protection

W Dnh e

Click OKto confirm removal.
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Changing Virtual Directory Settings

U To change settings of a virtual directory within a website:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairtab and click the website's domain name.

3. Click Virtual Diretories

4. Browse to the directory whose preferences you want to change, and click the
corresponding icon %, or click Directory Propertieshen inside the required
directory.

5. Change the settings as required:

A
A
A

Name- specify virtual directory name.
Path- specify the path to the physical directory to which the virtual directory is linked.

Script source accessselect this checkbox to allow users to access source code if
either Read or Write permissions are set. Source code includes scripts in ASP
applications.

Read permissionselect this checkbox to allow users to read files or directories and
their associated properties.

Write permissionselect this checkbox to allow users to upload files and their
associated properties to the virtual directory or to change content in a write-enabled
file. Write access is allowed only if browser supports the PUT feature of the HTTP 1.1
protocol.

Directory browsingselect this checkbox to allow users to see a hypertext listing of the
files and subdirectories in the virtual directory.

Log visits- select this checkbox if you want to store the information about visits to the
virtual directory.

Create applicationselect this checkbox to make the web directory an IIS application.
The directory becomes logically independent from the rest of the website.

Execute permissionsselect the appropriate program execution level allowed for the
virtual directory.

A None- allow access only to static files such as HTML or image files.
A Scripts only allow running scripts only, not executables.

A Scripts and Executablesemove all restrictions so that all file types can be
executed.

Allow to use parent pathselect this checkbox to allow using double period in the path
name when referring to a folder above the current directory. This enables users to
move up the folder tree without knowing the folder name or the whereabouts in the
hierarchy. If the option is selected, parent path directories should not have the Execute
permissiorcheckbox selected in their properties, so that applications do not have the
ability of unauthorized running of programs in the parent paths.
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Allow application execution in MTA (rlifdaded apartment) modselect this checkbox to
allow the application execution in multi-threaded apartment (MTA) mode. Otherwise,
the application will run in a single-threaded apartment (STA) mode. Using STA, each
application pool is executed in a dedicated process. With MTA, several concurrent
application pools are executed in one thread which can increase performance in some
cases.

Use default documeniselect this checkbox to allow the use of default documents for
the current directory. The default document is sent when users access the directory
on the web without a specific file name (for example, using http://www.example.com
as opposed to http:/mwww.example.com/index.html). If this checkbox is cleared and
the Directory browsingheckbox is selected, the web server returns a folder listing. If
this checkbox is cleared and the Directory browsingheckbox is cleared as well, the
web server returns an "Access Forbidden" error message.

Default documents search ordepecifies the order in which 1S searches for the default
document, sending user the first available file it finds. If no match is found, IIS
behaves as in the cases when the default content page is disabled.

Allow anonymous accesselect this checkbox if you want to make the directory public
so that the Internet users could access it without authentication.

Require SSL select this checkbox to enable access to the folder only via SSL-
encrypted connections.

ASP Settings set specific settings for ASP-based web applications.

A If you are using ASP-based applications that cannot operate correctly under data
transfer restrictions set by 1IS, clear the Defined by parent directaryeckbox
corresponding to the field you want to change and type in the required number.

A If you want to enable debugging of ASP applications on the server side, clear the
corresponding Defned by parent directocheckbox and select the Enable ASP server
side script debuggingheckbox.

A If you want to enable debugging of ASP applications on the client side, clear the
corresponding Defined by parent directarigeckbox and select the Enable AB client
side script debuggingheckbox.

Note that if you are trying to change ASP Settings for the root directory, the default
checkbox names will be Defined by lIfhistead of Defined by parent directory

6. Click OKto save changes.
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Adding and RemovingE Types

Multipurpose Internet Mail Exchange (MIME) types instruct a web browser or mail application
how to handle files received from a server. For example, when a web browser requests an
item on a server, it also requests the MIME type of the object. Some MIME types, like
graphics, can be displayed inside the browser. Others, such as word processing documents,
require an external application to be displayed.

When a web server delivers a web page to a client web browser, it also sends the MIME type
of the data it is sending. If there is an attached or embedded file in a specific format, 1IS also
tells the client application the MIME type of the embedded or attached file. The client
application then knows how to process or display the data being received from IIS.

IIS can only operate files of registered MIME types. These types could be defined both on
the global IIS level and on the website or virtual directory level. Globally-defined MIME types
are inherited by all websites and virtual directories while ones defined on the website main or
virtual directory level are used only for the area where they are defined. Otherwise, if the web
server receives request for a file with unregistered MIME type, it returns the 404.3 (Not
Found) error.

U To add a new MIME éyfor a virtual directory within a website:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairiab and click the website's domain name.
3. Click Virtual Directories

4. Navigate to the required virtual directory and click the corresponding link
with its name.

5. Click the MIME Typetab.
6. Click Add MIME Type
7. Specify the following:

A Type the file name extension in the Extensiorfield. File name extension should begin
with a dot (.), or a wildcard (*) to serve all files regardless of file name extension.

A Specify the file content type in the Contentffield.

A You can either select the appropriate value from the list or define a new content type.
To do this, select Customand enter the content type in the input box provided.

8. Click OKto finish the creation.

U To edit a MIME type for a virtual directory within a website:

1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

2. Go to the Websites & Domairiab and click the website's domain name.
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Click VirtualDirectories

Navigate to the required virtual directory and click the corresponding link
with its name.

Select the MIME Typetab.
Select the required MIME type in the list.

A Type the file name extension in the Extensiorfield. File name extension should begin
with a dot (.), or a wildcard (*) to serve all files regardless of file name extension.

A Specify the file content type in the Contenffield.

A You can either select the appropriate value from the list or define a new content type.
To do this, select Cusbmand enter the content type in the input box provided.

Click OKto save changes.

To remove a MIME type for a virtual directory within a website:

If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairtab and click the website's domain name.
Click Virtual Directories

Navigate to the required virtual directory and click the corresponding link
with its name.

Select the MIME Typetab.
Select the checkbox corresponding to the MIME type you want to remove.
Click Remove

Confirm removal and click OK



Websites and Domains 149

Setting Up IS Application Pool (Windows)

IIS Application Pool contains all web applications installed on your sites. If your service
provider allocated a dedicated IIS application pool for your sites, then you can have a level of
isolation between web applications used by your sites and web applications used by other
hosting users who host their websites on the same server. Because each application pool
runs independently, errors in one application pool will not affect the applications running in
other application pools.

Once you switch on the application pool, all web applications on your websites will be using

it.

1.
2.

To switch on dedicated I1IS application pool for your websites:

If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscriptiormenu at
the top of the screen, select the required webspace.

Go to the Websites & Domairiab > Dedicated IIS Application Pool for Your Websites
Click Switch On

To limit the amount of CPU resources that this application pool can use,
select the Switch on CPU monitoringeckbox and type a number in percents
into the Maximum CPU use (%9ox.

Click OK

To stop all applications running in the application pool:
Go to the Websites & Domairiab > Dedicated IIS Application Pool for Your Websites
Click Stop

To start all applications the application pool:
Go to the Websites & Domairtab > Dedicated IIS Application Pool for Your Websites
Click Start

If you run applications that are known to have memory leaks or become unstable after
working for a long time, then you might need to restart them from time to time.

i

1.
2.

To restart all applications running in the application pool:
Go to the Websites & Domairtab > Dedicated IIS Application Pool for Your Websites
Click Recycle
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U To switch off the dedicated IS application pool for yositeseb
1. Go to the Websites & Domairiab > Dedicated IIS Application Pool for Your Websites
2. Click Switch Off
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Web Publishing with Web Deploy (Windows)

Di

Web Deploy (Web Deployment Tool) is a Microsoft tool that significantly simplifies the

migration, management, and deployment of your websites and web applications. More

precisely, you can write a code in your local environment, for example, inVi s u a | Studi oE
(IDE) or We b Ma t (ddvetoEment tool), and then periodically publish the updates to your

production server by means of Web Deploy.

fferences Between Vi sual Studi oE

If you are looking for an environment that allows you to seamlessly publish code updates to

your account, it is |ikely you will choose betwe

A Visual StudioE is a classic integrated develop
applications and sites of any scale. It has a variety of plugins that extend its basic
functionality. However, to run and dshbudg vyour

perform extra configuration (such as preparing a database and adjusting environment
settings). Thus, this tool is more suitable for advanced users.

A Wi th WebMat r i x E -inysetof agplacatien teanpldtes andl éven working
applications (WordPress, Joomla) right out of the box. If you wish to instantly add an app
to your customer account or run it, you just need to select the app from the list and
WebMatri xE will transparently configure it for
subscribet o a hosting plan for your project without
this tool is suitable even for novice users, and encourages fast development by providing
ready-to-run applications and templates. The details on how to install and use
We b Ma t aré axaifable at http://www.microsoft.com/web/webmaitrix/.

It is up to you to decide which is better for your project.

How to Configure Web Publishing 1in

To set up web publishing in your environment, you should open the publishing settings and
specify the IP address of your customer account and the username and password you use to
log in to the Control Panel.

Il n WebMatri xE, the publ HesnbiPublgh e dar providpshesar e f ound
settings either manually or as an XML file that Panel automatically generates. To download

the file for a certain website, click on a corresponding Downloadink in Websites & Domains
<domain_name>Web Deploy Publishing SegénThe settings are only available if Web Deploy

is installed on the Panel server and is running. If you do not see these settings, contact your

hosting provider.

Forstep-by-st ep i nstructions on how to set up web publ
http://www.microsoft.com/web/post/how-to-publish-a-web-application-using-webmatrix.

To | earn more about publication settings in Visu
http://msdn.microsoft.com/en-us/library/7z83t16a.aspx.



http://www.microsoft.com/web/webmatrix/
http://www.microsoft.com/web/post/how-to-publish-a-web-application-using-webmatrix
http://msdn.microsoft.com/en-us/library/7z83t16a.aspx
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Note: You can decide whether to transfer updates securely to your customer account by
selecting the corresponding option in the publication settings. If your hosting provider does
not have a valid SSL certificate, you will receive an error message on attempting publication.
To resolve the problem, contact your hosting provider for assistance or avoid using the
secure connection.

Securing Wieshniy®ettimgs xX E Pub

An XML file which keeps WebMatri xE publishing se
customer's account. Administrators have the option to configure Panel so that it excludes

these passwords from the XML files. If the administrators wish to improve the security of the

system and prevent stealing the passwords, they can specify to exclude the password from

the XML file. The customers then wil!/ have to en
The option is available on the Tools & Settings Server Settingpage.



CHAPTER 5

Creating Websites with Parallels
Presence Builder

Parallels Presence Builder (also referred to as editor) is a visual editor that lets small
business owners and individuals create their websites quickly and easily. With
Presence Builder, you do not have to write code or configure servers to start a blog,
open an online store, or set up any other form of website. You just add the content
blocks that comprise your site (text, image gallery, online store) by dragging them to

pages, fill these blocks with your content, a

Start Creating a Website

When you start working on your website, you do not have to write text, search for the
images, and adjust the site look. Just choose a topic that best suits your website, and
Presence Builder will generate a site template that already contains a set of pages,
pictures, and text relevant to the selected topic. Each time Presence Builder generates
a website, it uses a random set of element designs, so you can be sure that your
website design is never repeated.

Once you have selected the topic, you will be prompted to enter some additional
information that Presence Builder will add to the website's pages, for example, your
phone number, which will appear on the Contact Us page.

For more details on how to start creating your website, see the section Creating a
Websitgon page 157).

Import Websites Created in SiteBuilder 4.5

If you already have a website created with SiteBuilder 4.5 and hosted elsewhere, you

can import your website to your new customer account. Learn how to move your
SiteBuilder 4.5 website to Presence Builder in the section Importing Sites from SiteBuilder
4.5(on page 158).

Fill the Site with Content

As soon as Presence Builder creates your website, you can fill it with your content.
Your main editing tool is the Presence Builder's main menu. You can do the following
by using the menu:

A Change the structure of your site: Add or remove pages.

A Edit the website design: Change colors and layout.

A Fill the site with your content: Remove unused predefined content and add your
own elements:
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Text

Images and image galleries
Videos

Scripts

Blogs

Search boxes

LD > > > > >

A Other elements

A Let your visitors share the information in your website in social media such as
Facebook or Twitter: Add the corresponding buttons to the pages of your site.

To learn more about actions available to you in the editor, refer to the section Getting
Familiar Witkthe Presence Builder Edifon page 155).

Find instructions on managing website look and content in the section Editing a Website
(on page 160).

Make the Site Available on the Internet

After you finish editing the website, make it available on the Internet. To let people see
your site at your domain name, publish the website by clicking the corresponding

button in the main menu. When you click this link, Presence Builder generates the

static pages and scripts that comprise your website and places them in the appropriate
locations on the server so that people see them when they enter your domain name in
their browsers. Learn more about publishing websites in the section Publishing a Website
to the Interneton page 201).

You can also attract more visitors to your sites by placing a site copy on Facebook - a

popular social network. Refer to the section Publishing a Website Copy to Facel{ook
page 202) for detailed instructions on how to do this.

In this chapter:

Getting Familiar With Presence BUilder.................uuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieenees 155
Creating @ WEDSITE ... ...uuiiiiiiiiiiiiieeee ettt bbb nnnenne 157
Importing Sites from SiteBuilder 4.5 ... 158
Editing WEDSITES ..ot 160
Saving and Loading Copies of 8 WEDSIte .............uuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiines 199
Publishing a Website to the Internet.............eiiiiiiiiicc e, 201
Publishing a Website Copy to Facebook ..., 202

Viewing Site Visits Statistics, Comments, and New Orders on the Dashboard .. 204
Deleting WEDSITES ......ccoiiiiiiiiiiieeeeeee e 206
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Getting Familiar With Presence Builder

The interface of the Presence Builder editor has two main parts: your website and the main
menu.

A website consists of a number of elements, or modules. Each module can be edited
separately. Here we will familiarize you with the basic principles of website module editing.
These are similar for all modules.

When adding a module to a page, you can choose whether it should be shown only on the
current page (page-specific module) or on all pages of the site (site-wide module). The only
exceptions are the Search AdvertisemeniSite LogpNavigationand Breadcrumbsnodules:
when you add them, they are placed on all pages of the website.

To place a module only on the current page, select the module under the Modulegab, and
drag it to any of the areas marked with the text ONLY ON THIS PAGHCch areas are located
within the main content block and near the top of each sidebar.

To place a module on all pages of the website, select the module under the Modulegab, and
drag it to any of the areas marked with the text ON ALL PAGESuch areas are located above
and below the main content block, in sidebars, header, and footer.

To locate or edit a website module, hover the mouse pointer over the part of the website you
want to change. A dotted frame will appear around the module. A control panel prompting
you to move, edit, or remove the module will appear next to the dotted frame.

The dotted frame around page-specific modules is green, but around site-wide modules it is
blue.

The editor's main menu offers website editing options grouped under five tabs:

A ModulesHere you can choose necessary modules and drag them to any place on the
page to fill your website with content.

A Design Here you can select the layout and general color scheme for your website,
change colors of different elements, and select fonts and border style.

A PagesHere you can add and delete pages, rename them, edit page meta information
such as descriptions and keywords for use by search engines, or mark a page as hidden
so that your visitors cannot access it from the site menu.

A DocumentsHere you can upload documents, images, and other files in various formats to
your hosting account. You can then easily insert links to these documents into your
website pages. Or, you can just keep the files on the hosting account for your own needs.

A Settings Here you can edit your website name, description and keywords for search
engines, upload a site icon (favicon), optimize the ranking of your website in search
engine results, connect your site to Google Analytics, and add a copy of your site to a
Facebook page.
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From the main menu, you can also do the following:

A Access the Dashboardo perform the following operations:
A View statistics on website visits. The statistics are provided by Google Analytics.

A View new comments left by site visitors on your website pages. The commenting
functionality is provided by Disqus.

A View new orders from customers visiting your online stores. The online store
functionality is provided by Ecwid.
A Save and load copies of your website by using the Saveand Reverioptions.

A Access Presence Builder Getting Startéko tutorial, view U s e r & sor sendiuslyeur
feedback. To do this, select the corresponding option from the Helpmenu.

A Publish your website by using the Publishbutton.

Discard any changes made to a site and start creating the site anew by selecting More>
Start OverThis does not delete your already published site copy.

A Delete a current website draft from the editor by selecting More> Remove SitéThis does
not delete your already published site copy.

>

You can drag the main menu to any place on the page for your convenience, or minimize it.

You can also access all options of the main menu in the context menu at any place on the
page. To open the context menu, click the right mouse button.
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Creating a Website

To minimize your efforts when creating a website, Presence Builder offers you a set of
predefined website topics. When you start creating a website, choose a topic that is most
appropriate for you, and Presence Builder will generate a website with the content relevant to
this topic. For example, it will include a price list template for a retail store or an image gallery
for an artist's site. If you cannot find a suitable topic, you can contact your service provider to
ask them to create the corresponding template and add it to the list of available topics.

When you start creating a website, Presence Builder also prompts you to provide information
about yourself or your company. Presence Builder will automatically add this information to
certain pages as appropriate, for example, to the About Us and Contact Us pages.

Note: Presence Builder will not store or use the information you provide anywhere except for
your website pages. You can change or remove this information later.

To start creating a website in Presence Builder:

Go to the Websites & Domairtab and click the desired domain name.
Click Launch Presence Builder

Select a website topic.

Type the website name and select website language.

Provide the information to pre-fill your website.

S =

Click Create Site
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Importing Sites from SiteBuilder 4.5

If you have a site created with SiteBuilder 4.5, you can import it to Presence Builder.

Note: The import of sites from earlier versions of SiteBuilder or other content management
systems is not supported.

If your site was created with an earlier version of SiteBuilder (4.4 or earlier), and you would
like to transfer your site, you can do the following:

A Contact your hosting provider and ask them to upgrade your account to the latest version
of Presence Builder.
A Transfer your site manually by copying and pasting the content.

During site import, most parts of the site structure and content can be transferred
successfully. However, we cannot guarantee that all content will be transferred.

In most cases, the following elements are imported successfully:

A Site map.

A Static pages, including links and images in text modules. Note that text blocks exceeding
30 kilobytes may be cut; therefore, some parts of the text may be missing.

Banner (if it is not a custom image).
Slogan, site title.

Logo (if it is not a custom image).
Footer text.

Meta info (keywords, description).

> > > > >

The other modules can be imported only as text widgets with static content, links and
images. Buttons will not work. The image gallery structure can be imported without images.

U To import a site from SiteBuilder 4.5:

1. Open the Presence Builder editor, and on the topic selection screen, click
Import Site from SiteBuilder.4.5

2. Type the Internet address (domain name) of the site that you want to import.
For example: http://example.com

3. Select the checkbox to confirm that you are aware of possible import issues,
and click Import Site
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4. After the site is imported, review and edit it as required (on page 160). You
can compare the imported site version with your original site and add the
missing information manually.

5. When finished with editing, publish the site to your customer account (on
page 201).

If you are publishing your new site to the same webspace on which your site created with
SiteBuilder 4.5 was hosted, the old site will be overwritten.
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Editing Websites

In Presence Builder, you can change almost any element of your website. Most of the
elements are changed in place - you open a page where the element is used, edit it and see
the result right away. Site-wide elements, such as Searchblock and Advertisemenblock are
changed in one place but the changes are applied to each page of your website.

Note: If you are using Internet Explorer, we strongly recommend that you avoid using
browser zoom to change the size of text displayed in your browser window. Please note that
websites in Presence Builder will perform and look best at normal zoom (100%).

Next in this section:

Structure: Pages and NaVIgation ................uuueeuurmimiiiiiiiiiiiiiiieeiiieeeieeeeeeeeeneeeaee 160
Design: Design Templates, Layout, Styles, Color Scheme, and Header............ 163
Content: Text, Tables, Images, Video, Forms, and ScriptS..........cccceeevvvvvivinnnnn. 171
Settings and TooIs for WebmaSters...........coviii i 194

Structure: Pages and Nawiga

This section describes how to add pages to a site, set their location in the site structure, and
add navigation links.

Next in this section:

Adding and Removing Pages ........ccooviiiiiiiiiiiii 161
Adding and Removing Navigation LinKs ...........cccceoiiiiiiiiiiiiiee e, 162
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Adding and Removing Pages

Your site can have two levels of nested pages. The total number of pages you can create
depends on your hosting plan. The editor will let you know when you have reached the
allotted number of pages: an icon with the dollar sign ($) will be shown over the Add page
button.

U To add a new page to your website:

1. Go to the Pagestab.

2. Click Add pageThe new page appears highlighted in green.

3. Position the new page by dragging it to the right place or by clicking the
arrows.

4. Specify the page title.

5. Give a concise description of the page content that will be displayed on
search engine results pages and the keywords by which the page will be
found by search engines.

Note: Page namand Page link namare required fields. Descriptiorand Keywordsare
optional fields. If you specify keywords for a page, they should be separated by commas
without white spaces.

6. If you want to make the page invisible to your website visitors, select the
Hidden pagecheckbox.

7. If you want to restrict access to the page with password authentication,
select the Protected pageheckbox and specify a username and a password.

8. Click OKto save changes.

To change the location or properties of a page:
Go to the Pagestab.

Select the page you want to edit.

w N e

Change the page position by dragging it to the right place or by clicking the
arrows.

B

Edit the page title.

5. Edit or remove the concise description of the page content that will be
displayed on search engine results pages and the keywords by which the
page will be found by search engines.

Note: Page namand Page link namare required fields. Descriptiorand Keywordsare
optional fields. If you specify keywords for a page, they should be separated by commas
without white spaces.

6. If you want to make the page invisible to your website visitors, select the
Hidden pageheckbox.
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7. If you want to restrict access to the page with password authentication,
select the Protected pageheckbox and specify a username and a password.

8. Click OKto save changes.

To delete a page from your website:
Go to the Pagestab.
Select the page you want to delete.

Click Delete page

BwN R oo

Click OKto save changes.

Adding and Removing Navigation Links

By default, a horizontal navigation bar with links to site pages is inserted below or above the
header of your site. It is automatically updated every time you add, change, move, or remove
pages from the site.

If you use sidebars on the site, then the horizontal bar under the header includes only links to
the first level pages, and the sidebars show the links of the second and third levels.

You can move navigation blocks by dragging them to other areas of the site.

For each navigation block, you can specify what levels of pages should be included in the
menu, change menu alignment (for example, show it in the middle of the page instead of the
default alignment to the left), and change the color, style, and size of the font used for the
links. To change any of these settings, place the mouse pointer over a navigation block and
click Edit

If you occasionally remove a navigation block, you can re-insert it. To do this, go to the
Modulegab, select Navigationand drag the block to the area on the page where you want to
add it. The navigation block will be inserted into all pages of the website.

For the convenience of your site visitors, you might also want to add breadcrumb navigation
blocks. Breadcrumb navigation is a chain of links that represents the user's path from the
site's main page to a current page. To add a breadcrumb navigation block, go to the Modules
tab, select Breadcrumbsand drag the module to the area on the page where you want to add
it. The navigation block will be inserted into all pages of the website.
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Design: Design Templates, Layout, St{Jeler Scheme,
and Header

This section describes how to change the layout, color scheme, and header elements of the
site.

Next in this section:

Selecting a Website Design Template ... 164
Changing Your Website LayOUL...........ccuuuuiiiiiieiiieeiiieie et 166
Selecting Website Colors, Background Images, Fonts, and Styles for Borders and Corners 168

Changing the Website Header Elements.............cccoiiiiiiiiiiiiiiiiiiiiiiienes 170
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Selecting a Website Design Template

When a new website is generated, the editor applies a random design template to the site. A
design template is a combination of website elements (banner, footer, sidebars), page layout
settings, and colors.

The editor provides a selection of 24 design templates, 16 of which are randomly generated,
and 8, created by graphic designers especially for Presence Builder.

You can review the list of design templates and select the design you like the most, or you
can individually adjust the layout and colors of website elements, as described further in this
document.

You can also prepare your own design templates and save them to ZIP archives, upload
them to the editor, and apply to websites.

Seleting and Applying a Design Template

Note: When you apply a design template, all site-wide elements and modules are overwritten
along with the content they might contain.

U To select a design template and apply it to a site:

Go to the Designtab > Templatesselect the template you want, and click OK

Randomly generated designs are listed in the Generatedection, and the templates prepared
by designers, in the Specialsection.

Preparing a Custom Design Template

The following site elements and settings can be saved in a design template:

A The website layout: the location and size of the header, footer, content areas, and
sidebars.

The banner image.

All site-wide modules.

The color scheme or individually selected colors.

The fonts.

The information about the borders and shapes of the page elements' corners.

> >y > > >
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U To create a custom design template:

1. Adjust the layout and design, as described in Changing Your Website Lay(om
page 166) and Selecting Website Colors, Fonts, and Styles for BanlgiSornergon
page 168).

2. Add the necessary site-wide modules and a banner, as described in the
chapter Content: Text, Tables, Images, Video, Forms, and Scripts (on page
171), and in the section Changing the Website Header Elements (on page
170).

3. Save the design template: Go to the Designtab, and click Export Design

Importing and Applying a Custom Design Template

Note: When you import and apply a design template, all site-wide elements and modules
contained on the site are overwritten along with the content they might contain.

U To upload and apply a design template:
1. Go to the Designtab, and click Import Design

2. Select the ZIP archive containing the design template.
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Changing Your WebsiLayout

The layout of your site can consist of the following elements:

A HeaderThis is the topmost area where a banner image and a company logo are usually
placed. You can do the following to the header:

A Move the banner image and logo from the header area to any place on the page.
A Reduce the header height to 25 pixels by removing all elements from it.

A Change the header width from the default size to 100 percent, so that it is expanded
to fit the page width.

A Content arearhis is the main part of a webpage where most of the content is placed. You
can do the following to the content area:

A Adjust the height of the content area.

A Divide the content area into several columns. You can do this by dragging new
modules to the left or right edge of the content area and inserting them.

A Change location of the columns in the content area by moving the content to the left
or to the right.

A SidebarsThese are vertical columns that can be used for placing all kinds of modules,
site-wide and page-specific. You can do the following to sidebars:

A Add one sidebar and place it to the left or to the right of the content area.

A Add two sidebars. They will be placed to the left and to the right of the content area.
A Adjust the height and width of the sidebars.
A

Move the sidebars to the top of the page and place them to the left or to the right of
the header area.

A Switch places of the sidebars.

A Footer This is the lowest area where the company name, contact information, or a
copyright notice are usually placed. You can do the following to the footer:

A Reduce the footer height to 25 pixels by removing all elements from it.

A Change the footer width from the default size to 100 percent, so that it is expanded to
fit the page width.

A Advertisement block below the fooRepending on your hosting plan, an additional text
block containing some advertisement from your hosting provider might appear below the
website footer. If that advertisement block appears on your site, you might want to
upgrade to another hosting plan to remove it.

To change #hlayout of your site:
Go to the Designtab > Layouttab.

Select the number of sidebars: Under Sidebarsselect Ng One or Twa
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Select the locations of sidebars:

A To move a sidebar to another side of your website, or to switch places of sidebars (if
you have two sidebars on your site), click Switch sidebars

A To move the sidebars to the top of the page, click them in the layout model.
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4. Set the size of page elements:

A

To set the total width of the website pages, under Website widthselect either of the
following:

A Fixed layoutyour website will be of a specific size regardless of the size of the
browser window viewing the page. In this case, specify your website width in
pixels.

A Liquid layoutbased on percentages of the current browser window's size. In this
case, specify your website width as a percentage of the browser window's size.

To change the width of the header, footer, and the main content area to fit the page
width, click the corresponding elements in the layout model.

Under Minimal column heightixels specify the height of the main content area and
each sidebar, if you have chosen to use them.

This value shows the height of your website elements without content. When you add
content to the main content area and to the sidebars, they will stretch in height to fit
the content.

To ensure that the sidebars and the content area are vertically aligned, select the
checkbox Stretch the sidebars and the content area down to the footer

If you use one or two sidebars, under Sidebar width in pixelspecify the width of each
sidebar. The size of the main content area will be determined automatically.

Under Margin sizes in pixelspecify the size of vertical and horizontal margins. A
margin is the space between the edges of neighboring elements.

5. Click OKto save changes.
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Selecting Website Colors, Background Images, Fonts, and Styles for
Borders and Corners

The general color scheme, or styleset, of your website comprises four colors. Each color is
used for several website elements at once. You can adjust colors of individual elements on
the Designtab > Colorstab.

U To select the general color scheme for your website:

1. Go to the Designtab > Schemeab.

2. Select the color scheme, or styleset, of your website in the menu.
You will see the four colors used in the color scheme of your website.

3. To adjust one of the colors of your website color scheme, click the respective
color field and change the hexadecimal color code value or select a color
with the color picker.

Note: These changes will override any previous changes of individual elements' colors
made on the Colorstab.

4. Click OKto save changes.

To set colors or background images for individual website elements:
Go to the Designtab > Colorstab.
Select the website element in the Page areanenu.

Click the arrow in the Color or imagenenu.

Aw NP oo

Do any of the following:

A To fill with a solid color, leave the Solid coloroption selected, and select a color with
the color picker.

A Tofill with a gradient, select the Gradienbption, and then select a pattern from the
library.
A To fill with a background image, select the Imageoption, select a pattern from the

library or click Uploadto upload your own image. Specify where it should be placed
and whether it should be tiled.

5. For an element with text, adjust font colors by clicking the respective color
field and editing the hexadecimal color code value or by selecting a color
with the color picker.

Note: Modifying the styleset on the Schemdab will override the changes made on the
Colortab.

6. Click OKto save changes.
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To select foits for headings and body text of your website:
Go to the Designtab > Fontstab.
For each font type, select the font face and size in the menus.

For headings, select the font decoration. You can use bold (the Bicon) and
italics (the I icon).

Note: The settings made here define only general rules for your website fonts. You can
always adjust fonts of individual elements in place.

Click OKto save changes.

To select the shape of corners (square or rounded) for website elements:
Go to the Designtab > Cornes tab.
In the Page areanenu, select the element whose corners you want to change.

Do any of the following:
A To make rounded corners, select the corresponding checkboxes.

A To make square corners, clear the corresponding checkboxes.

. Click OKto save changes.

To select borders for website elements:
Go to the Designtab > Borderstab.

Select the border type for elements inside your website from the Internal
containers bordemenu.

Select the elements that will have the border.

Note: You can select only one internal border type for all elements on your website, but
you can select whether this border will be used for certain elements.

Select the external border for your website from the External site bordenenu.

Click OKto save changes.
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Changing the Website&tler Elements

The site header consists of the following elements:
A Banner You can do the following to the banner:
A Upload your own banner image or a Flash file in SWF format.
A Select and apply a banner from the Presence Builder library.
A Remove the banner and use a background filled with a color or images.
A

Remove the banner and all other elements from the header area to reduce its height
to 25 pixels.

A Move the banner to the content area and insert it into a specific page or into all pages
of the website.

Note: You can use only one banner per site. If you choose to insert it into a specific
page, you will not be able to add it to other pages of the website. For this reason,
we recommend that you place it into the site-wide areas.

A Logo imageYou can do the following to the logo:
A Upload your own logo image or a Flash file in SWF format.

A Move the logo from the header area to other parts of webpages, such as sidebars and
content area.

A Insert any number of logo images into the site-wide areas.

A Resize the logo by specifying the desired dimensions in pixels, or by dragging the
sides and corners of the image with a mouse pointer.

A Remove the logo.

A Site nameThis usually contains a company name or a brief site description like, for
example, "John Doe's Recipes".

A Site sbgan This usually includes a description of your site or a company slogan.

U To change the banner image or other elements of the header (logo, site name,
or slogan):

1. Click the banner image.
2. Select the option Use an imageand then click the image in the Image listmenu.

3. Do any of the following:

A To use an image from the library, select it. To find relevant images, type a keyword
into the input box.

A To use your own image or a Flash file in the SWF format, click Upload and select the
file that you want to use. Images should be in the GIF, JPEG, and PNG formats,
preferably not wider than 900 pixels.

4. If you want to scale a banner to fit the header area, select the Fit image size
checkbox.

5. Under Show banner elementselect the checkboxes corresponding to the
elements that you want to show in the header.
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6. If you want to remove a logo image or upload your own logo, click the logo
image.

7. If you want to change the site name or slogan, click the corresponding fields
on the header and change them as you want.

To make it easier to see the site name or slogan, select the Outlinecheckbox. This adds a
black or white outline around text, one pixel in width. If the font color in site title or slogan
is black, then the outline is white, and vice versa.

Note that you can freely move the blocks with website name, description, and logo within
the header area.

If you occasionally remove the banner, you can re-insert it.

U To remove the banner:

Click the banner, select.the option Do not use an imagand specify the height of the header
block in pixels. Click OK

U To insert a banner:

Go to the Modulegab, select Bannerand drag the module to any of the site-wide areas on the
page where you want to add it.

U Toinsert a logo:

Go to the Modulegab, select Site Logpand drag the module to any of the site-wide areas on
the page where you want to add it. You can upload a new logo image or a Flash file in the
SWF format, and align it to the left, center, or right.

You can also resize the logo image by specifying the desired dimensions in pixels, or by
dragging the sides and corners of the image with a mouse pointer.

Note: When you resize the image with a mouse pointer, the option to keep the original aspect
ratiois switched off automatically.
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Content: Text, Tables, Images, Video, Fanth§cripts

This section describes how to fill your site with content and enhance it with useful functions
provided by the editor's modules.

When adding a module to a page, you can choose whether it should be shown only on the
current page (page-specific module) or on all pages of the site (site-wide module). The only
exceptions are the Search AdvertisemeniSite LogpNavigationand Breadcrumbsnodules:
when you add them, they are placed on all pages of the website.

A To place a module only on the current page, select the module under the Modulegab,
and drag it to any of the areas marked with the text ONLY ON THIS PAGHch areas are
located within the main content block and near the top of each sidebar.

To divide the content area into columns and insert a module into one of them, drag the
module to the left or right edge of the content area and then insert it. Note that sidebar
areas cannot be divided into columns.

A To place a module on all pages of the website, select the module under the Modulegab,
and drag it to any of the areas marked with the text ON ALL PAGESuch areas are
located above and below the main content block, in sidebars, header, and footer.

The number of modules that you can add to a website depends on your hosting plan. The
editor will let you know when you have used the allotted number of modules: icons with the
dollar sign ($) will be shown over the module icons in the editor's toolbar.
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